Exploring Access
Creating Tables
Working with Tables
Editing Tables
Finding and Filtering Data
Printing Data
Creating Relationships
Using Simple Queries
Modifying Query Results
Analyzing Tables
Creating Basic Forms
Creating Basic Reports
ABOUT ONDEMAND SOFTWARE

The OnDemand Software Division of Global Knowledge is the worldwide leader of software solutions that enable rapid adoption, broad acceptance and increased accuracy in the use of enterprise applications related to enterprise resource planning, supply chain management, procurement, e-commerce and customer relationship management.

The flagship product, OnDemand Personal Navigator™, provides one synchronized documentation, training and performance support platform. Founded in 1986, the OnDemand Software Division has over 850 Global 2000 customers in 12 countries. The OnDemand Software Division of Global Knowledge, a Welsh, Carson, Anderson and Stowe portfolio company, is headquartered in King of Prussia, Pennsylvania, with offices located worldwide. Additional information can be found at http://www.ondemandgk.com.

COPYRIGHT

Copyright © Global Knowledge Software LLC. 2008. All rights reserved. Information in this document is subject to change without notice and does not represent a commitment on the part of Global Knowledge.

No part of this publication, including interior design, cover design, icons or content may be reproduced by any means, be it transmitted, transcribed, photocopied, stored in a retrieval system, or translated into any language in any form, without the prior written permission of Global Knowledge Network, Inc.

Products mentioned herein, including SAP R/3, PeopleSoft, Siebel Systems, Microsoft Windows, Microsoft Office, Microsoft FrontPage, Microsoft Outlook, Macromedia Flash, Adobe Acrobat, and JavaScript are trademarks or registered trademarks of their respective owners.

OnDemand Personal Navigator and Courseware Express are trademarks of Global Knowledge Software LLC. CustomDOC and Knowledge Pathways are registered trademark of Global Knowledge Software LLC. Global Knowledge and the Global Knowledge logo are trademarks of Global Knowledge, Inc.

DISCLAIMER

Global Knowledge has taken every effort to ensure the accuracy of this manual. If you should discover any discrepancies, please notify us immediately.

Global Knowledge Software LLC.
OnDemand Software Division
475 Allendale Road
King of Prussia, PA 19406
(610) 337-8878
www.ondemandgk.com
# Microsoft Office Access 2007 - Level 1

## Lesson 1 - Exploring Access

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Working with Access</td>
<td>2</td>
</tr>
<tr>
<td>Starting Access</td>
<td>3</td>
</tr>
<tr>
<td>Using the Interface</td>
<td>4</td>
</tr>
<tr>
<td>Using the Office Button</td>
<td>5</td>
</tr>
<tr>
<td>Opening an Existing Database</td>
<td>7</td>
</tr>
<tr>
<td>Using the Ribbon</td>
<td>9</td>
</tr>
<tr>
<td>Using the Contextual Tabs</td>
<td>10</td>
</tr>
<tr>
<td>Using the Quick Access Toolbar</td>
<td>11</td>
</tr>
<tr>
<td>Using the Mini Toolbar</td>
<td>11</td>
</tr>
<tr>
<td>Using Database Objects</td>
<td>13</td>
</tr>
<tr>
<td>Using the Navigation Pane</td>
<td>13</td>
</tr>
<tr>
<td>Opening a Database Object</td>
<td>15</td>
</tr>
<tr>
<td>Using Tabbed Documents</td>
<td>16</td>
</tr>
<tr>
<td>Closing a Tabbed Document</td>
<td>18</td>
</tr>
<tr>
<td>Closing All Tabbed Documents</td>
<td>19</td>
</tr>
<tr>
<td>Using the Status Bar</td>
<td>19</td>
</tr>
<tr>
<td>Using the Options Dialog Box</td>
<td>20</td>
</tr>
<tr>
<td>Closing a Database</td>
<td>22</td>
</tr>
<tr>
<td>Exiting Access</td>
<td>23</td>
</tr>
<tr>
<td>Exercise</td>
<td>25</td>
</tr>
<tr>
<td>Exploring Access</td>
<td>25</td>
</tr>
</tbody>
</table>

## Lesson 2 - Creating Tables

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using Database Templates</td>
<td>28</td>
</tr>
<tr>
<td>Creating a New Database</td>
<td>30</td>
</tr>
<tr>
<td>Designing Tables</td>
<td>32</td>
</tr>
<tr>
<td>Creating a Table in Datasheet View</td>
<td>33</td>
</tr>
</tbody>
</table>
Creating a Table in Design View ........................................... 34
Adding Field Names ............................................................... 35
Assigning Data Types ........................................................... 37
Saving a New Table ............................................................... 39
Adding a Field Description ...................................................... 41
Setting a Primary Key ............................................................ 42
Using Multi-valued Fields ......................................................... 43
Exercise .................................................................................. 47
Creating Tables ........................................................................ 47

LESSON 3 - WORKING WITH TABLES ....................................... 49
Using Datasheet View ............................................................. 50
Navigating Fields in Tables ....................................................... 50
Using Field Templates ............................................................ 51
Adding Records ........................................................................ 52
Moving through Records ......................................................... 54
Selecting Records ..................................................................... 56
Editing Records ......................................................................... 57
Saving Records .......................................................................... 59
Deleting Records ....................................................................... 59
Displaying a Totals Row in a Table ........................................... 61
Exercise .................................................................................. 63
Working with Tables ................................................................. 63

LESSON 4 - EDITING TABLES ..................................................... 65
Changing the Row Height ......................................................... 66
Changing the Column Width ..................................................... 67
Changing a Font Attribute ....................................................... 68
Changing a Cell Effect ............................................................. 69
Using Alternate Background Colors ........................................ 71
Selecting a Column ................................................................. 72
Moving a Column ................................................................. 73
Hiding a Column ................................................................. 75
Unhiding a Column .............................................................. 76
Freezing a Column ............................................................... 77
Exercise .................................................................................. 79
LESSON 5 - FINDING AND FILTERING DATA ........................................ 81
Sorting Records ............................................................................... 82
Finding Specific Records ................................................................. 83
Finding Records using Wildcards .................................................... 85
Using Replace .................................................................................. 88
Using Filter By Selection ................................................................. 90
Applying/Removing a Filter ............................................................. 92
Using Filter Excluding Selection ..................................................... 93
Using the Search Box ..................................................................... 94
Using Quick Filter ......................................................................... 95
Using AutoFilter ............................................................................ 97
Exercise ......................................................................................... 100
Finding and Filtering Data ............................................................... 100

LESSON 6 - PRINTING DATA .............................................................. 101
Printing Table Data ........................................................................ 102
Changing the Page Setup ................................................................. 103
Using Print Preview ........................................................................ 105
Printing Selected Records ............................................................... 108
Exercise ......................................................................................... 110
Printing Data .................................................................................. 110

LESSON 7 - CREATING RELATIONSHIPS .......................................... 111
Using Related Tables ...................................................................... 112
Creating a Relationship between Tables ......................................... 113
Setting Referential Integrity ............................................................ 116
Viewing Subdatasheets .................................................................. 118
Deleting a Join Line ........................................................................ 120
Exercise ......................................................................................... 122
Creating Relationships .................................................................. 122

LESSON 8 - USING SIMPLE QUERIES ............................................. 123
Using Queries and Recordsets ......................................................... 124
Using the Simple Query Wizard ...................................................... 124
Creating a Query in Design View .................................................... 127
Opening a Query.................................................................129
Adding a Table to a Query ..................................................130
Joining Tables in a Query.....................................................132
Running a Query.....................................................................134
Exercise ..................................................................................136
Using Simple Queries.............................................................136

LESSON 9 - MODIFYING QUERY RESULTS..............................137
Sorting a Query........................................................................138
Adding Criteria to a Query......................................................140
Hiding a Field in a Query.........................................................142
Displaying a Totals Row in a Query ........................................143
Adding a Record using a Query...............................................144
Printing a Query........................................................................146
Exercise ....................................................................................148
Modifying Query Results........................................................148

LESSON 10 - ANALYZING TABLES ...........................................149
Analyzing a Table.......................................................................150
Using Relationships in Splits....................................................150
Using the Table Analyzer Wizard ............................................150
Using the Performance Analyzer..............................................154
Exercise ....................................................................................157
Analyzing Tables........................................................................157

LESSON 11 - CREATING BASIC FORMS .................................159
Using Forms .............................................................................160
Using the Form Button............................................................160
Adding a Record using a Form................................................161
Using the Calendar for Date Picking........................................163
Using the Form Wizard............................................................165
Viewing Records in a Form......................................................168
Printing Records in a Form......................................................169
Basing a Form on a Query.......................................................171
Exercise ....................................................................................174
Creating Basic Forms..............................................................174
LESSON 12 - CREATING BASIC REPORTS ................................................................. 177

Using Reports ................................................................................................. 178
Using the Report Button ................................................................................ 178
Using Print Preview - Reports ........................................................................ 179
Printing Pages of a Report ............................................................................. 182
Using the Report Wizard ................................................................................ 184
Changing Views in a Report ............................................................................ 189
Grouping and Summarizing Report Data ....................................................... 190
Basing a Report on a Query ............................................................................ 194
Exercise .......................................................................................................... 198
    Creating Basic Reports .............................................................................. 198

INDEX ................................................................................................................. 199
LESSON 1 - EXPLORING ACCESS

In this lesson, you will learn how to:

- Work with Access
- Start Access
- Use the Interface
- Use the Office button
- Open an existing database
- Use the Ribbon
- Use the Contextual tabs
- Use the Quick Access Toolbar
- Use the Mini Toolbar
- Use database objects
- Use the Navigation pane
- Open a database object
- Use tabbed documents
- Close a tabbed document
- Close all tabbed documents
- Use the Status Bar
- Use the Options dialog box
- Close a database
- Exit Access
WORKING WITH ACCESS

Discussion

A database is any collection of information organized into a group. The information should be organized in a way that allows for easy retrieval. For example, a telephone book is a non-computerized database of information. It is organized in alphabetical order and includes information such as names, addresses, and telephone numbers. Other examples of non-computerized databases include address books and inventory lists.

Electronic databases can be maintained on a computer. Computerized databases allow you to manipulate large amounts of data quickly and easily. They simplify tasks such as searching for specific data, organizing and sorting data, and making corrections or changes to data.

In Microsoft Access 2007, the database information is stored in data tables. Every data table has a structure that provides for the collection, organization, storage, and retrieval of data. These tables of information are contained in a database file. Each database file can have numerous data tables.

A data table consists of fields and records. Fields are categories of information. For example, in an address table, you may maintain names, addresses, cities, states, and zip codes. Each of these categories is a field in the address database.

The set of fields containing the data for a single entry is called a record. For example, Charles Hardy, 1234 Main St., Bridgeville, NY, 11012 is a record in the address data table. Each piece of information in the record is stored in a field and is referred to as a field value. NY is the field value for the State field in this particular record. An address table would most likely consist of a number of records, and the data values for each record would be stored in the appropriate fields.

Access is a relational database application. A relational database contains a large amount of data that is split into numerous tables; each table should include only the information pertinent to one subject, such as Customer, Orders, or Items. As a result, each table is smaller; more manageable; and, in turn, more efficient. These tables can then be joined together to make them related. When tables are related, you can access information from any field in any related table, eliminating the need to add the same information to more than one table. In addition, you can create reports, forms, and queries from data stored in any related table.

You can get help on an Access task or feature by using the Microsoft Office Help button, where you can search both online and offline sources to provide assistance and training, and answer your questions about Office products.
STARTING ACCESS

Discussion

When Microsoft Office 2007 is installed, it creates a Microsoft Office submenu in your All Programs menu containing the shortcuts to all of your Office applications. You can open Microsoft Access 2007 by selecting it from this menu.

You can use the Start menu to start Access. Once the program starts, a brief copyright screen appears, and then the application window opens.

To display a shortcut to Access on your desktop, display the Microsoft Office submenu from the All Programs menu, right-click Microsoft Office Access 2007, point to Send To and select the Desktop (create shortcut) command.

If you are using Windows XP or Vista, you can pin a shortcut to your Start menu by displaying the Microsoft Office submenu from the All Programs menu, right-clicking Microsoft Office Access 2007, and selecting the Pin To Start menu command.

Procedures

1. Select the Start button on the taskbar.
2. Select All Programs
3. Select Microsoft Office
4. Select Microsoft Office Access 2007

Step-by-Step

**Steps** | **Practice Data**
---|---
1. Select the **Start** button on the taskbar. *The Start menu appears.* | ![Start button](image)
2. Select **All Programs**. *The All Programs submenu appears.* | ![All Programs](image)
3. Select **Microsoft Office**. *The Microsoft Office submenu appears.* | ![Microsoft Office](image)
4. Select **Microsoft Office Access 2007**. *Microsoft Access opens.* | ![Microsoft Office Access 2007](image)

---

**USING THE INTERFACE**

**Discussion**

When you open Access the name of the application appears in the title bar at the top of the window.

Access opens with the Getting Started task pane. From here you can open an existing database, or create a new database. In addition you can search for help using the **Microsoft Access Help** button.

Many of the objects in the Access window display brief descriptions called ScreenTips that pop up whenever you point to them.
Once you open a database from the Open dialog box, it will be listed in the Open Recent Database section of the Getting Started task pane. You can use **Access Options** to specify the number of recently opened databases shown.

---

**USING THE OFFICE BUTTON**

**Discussion**

The **Office** button has replaced the **File** menu used in earlier versions of Microsoft Office, and is located in the upper left corner of the application window. The Office menu has three main parts: the menu options on the left which includes basic commands such as **Open**, **Save** and **Print**; the recent documents list on the right; and **Access Options** and **Exit Access** buttons at the bottom.
You can use **Access Options** to customize or compact and repair your database.

**Procedures**


2. Select the **Office** button.

3. Select the desired options.

**Step-by-Step**

Using the Office button.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the <strong>Office</strong> button.</td>
<td>Click</td>
</tr>
<tr>
<td><em>The Office menu appears.</em></td>
<td></td>
</tr>
</tbody>
</table>
Once you have opened the **Office** menu, you can choose whether you want to open a database, or amend your Access Options. If you click away from the **Office** menu, it will disappear. To re-open, simply click the **Office** button again.

**OPENING AN EXISTING DATABASE**

**Discussion**

An Access database is a collection of information organized into a number of objects including tables, queries, forms, reports, pages, macros and modules.

When you want to work with an Access database, you must first load the database file into memory. This process enables you to open all the tables or other objects within that database.

You can view or edit an existing database by opening it from disk. You do not need to remember the file name because the Open dialog box displays a list of folders and files in the current drive and folder. You can select the desired database file from the list, or you can type the name of the database you want to open.

If the database resides in a different drive or folder, you can use the **Folders** or **Favorite Links** list to select the correct location. The folders and files residing in the selected location appear in the box to the right of the **Folders** list. If necessary, you can resize the Open dialog box.

While the **Open** button opens the selected database, the **Open** list provides additional options. For instance, if you want to protect the original version of a database from modifications, you can open a copy of a database or open the database as read-only.

The **Files of type** list in the Open dialog box enables you to open files created in other programs. For instance, you can open a file created in Excel in Access.

The **Views** button at the top of the Open dialog box allows you to change views. You can choose to have files displayed as icons or a list.

You can also open the Open dialog box by selecting the **More** link in the Getting Started task pane or by selecting the **Office** button and then the **Open** command.
Procedures

1. Click the Office button.
2. Select Open.
3. Select the Folders arrow.
4. Select the drive where the database you want to open is located.
5. Open the folder where the database you want to open is located.
6. Select the name of the database you want to open.
7. Select .
8. Select Options... if necessary.
9. Select the desired security options.
10. Select OK if necessary.

Step-by-Step

Open an existing database from a specific drive and folder location.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click the Office button.</td>
<td>Click</td>
</tr>
<tr>
<td><em>The Office Menu opens.</em></td>
<td></td>
</tr>
<tr>
<td>2. Select Open.</td>
<td>Click</td>
</tr>
<tr>
<td><em>The open dialog box opens.</em></td>
<td></td>
</tr>
<tr>
<td>3. Select the Folders list arrow.</td>
<td>Click</td>
</tr>
<tr>
<td><em>A list of available drives appears.</em></td>
<td></td>
</tr>
<tr>
<td>4. Select the drive where the database</td>
<td>Click the student data drive</td>
</tr>
<tr>
<td>you want to open is located.</td>
<td></td>
</tr>
<tr>
<td><em>A list of available folders appears.</em></td>
<td></td>
</tr>
<tr>
<td>5. Open the folder where the database</td>
<td>Double-click to open the</td>
</tr>
<tr>
<td>you want to open is located.</td>
<td>student data folder</td>
</tr>
<tr>
<td><em>The contents of the folder appear.</em></td>
<td></td>
</tr>
</tbody>
</table>
6. Select the name of the database you want to open. The file name is selected.

7. Select **Open**. The Open dialog box and Getting Started task pane close, and the Security Warning message box appears below the **Ribbon**, if necessary.

8. Select **Options**, if necessary. The Security Options dialog box opens asking if you want to open the file since it may contain unsafe code.

9. Select the desired security options. The database content is enabled or remains disabled.

10. Select **OK**, if necessary. The Security Options dialog box closes and the database opens in the application window.

---

**USING THE RIBBON**

**Discussion**

All Microsoft Office 2007 applications use a new interface element called the **Ribbon**, which appears at the top of the application window when you open a database. The **Ribbon** is the primary replacement for the menus and toolbars used in previous versions of Microsoft Office.

The **Ribbon** is made up of a series of command tabs that contain groups of related commands. In Access 2007, the main command tabs are **Home**, **Create**, **External Data** and **Database Tools**.

To hide the **Ribbon** double-click the active command tab. To show the **Ribbon** again, double click any command tab.
Procedures

1. Open the desired database.
2. Select the desired tab on the Ribbon.

Step-by-Step

Use the Ribbon

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the desired tab on the Ribbon.</td>
<td>Click Create</td>
</tr>
</tbody>
</table>

The desired tab appears.

Practice the concept: Select the External Data tab and the Database Tools tab and try to familiarize yourself with the options available.

Using the Contextual Tabs

Discussion

In addition to the standard command tabs, Access 2007 uses another user interface element called the contextual command tab. Depending on which object you are working with, one or more contextual command tabs may appear in the Ribbon, next to the standard command tabs. For instance, when a Datasheet is active the Datasheet contextual command tab becomes available.

Procedures

1. Open the desired table.
2. Select the desired contextual command tab.

Step-by-Step

Use a contextual command tab
**Steps** | **Practice Data**
---|---
1. Open the desired table from the Navigation Pane.  
   *The desired table opens and the Datasheet tab appears on the ribbon.* | Double click **Customers**, if necessary
2. Select the desired contextual command tab.  
   *The desired tab is selected.* | Click **Datasheet**

Notice that you can use the options on the **Datasheet** tab to change the object view, to create new fields, to specify data type and create relationships.

---

**USING THE QUICK ACCESS TOOLBAR**

**Discussion**

The **Quick Access Toolbar** is a single standard toolbar that appears at the top of the **Ribbon**. It offers instant, single-click access to the most commonly used commands in Access 2007: **Save**, **Undo** and **Redo**.

- To customize the **Quick Access Toolbar**, click the arrow to the right of the toolbar and select from the drop-down list to add or remove commands.

- You can also add buttons from the **Ribbon** to the **Quick Access Toolbar**. Simply right-click on the button of your choice and select **Add to Quick Access Toolbar**.

---

**USING THE MINI TOOLBAR**

**Discussion**

When you select text for formatting in a Rich Text field, the **Mini Toolbar** automatically appears above the selected text. The **Mini Toolbar** allows you to format your text. You can show or hide the **Mini Toolbar**.

- You cannot customize the **Mini Toolbar**.
Procedures

1. Open the desired table.
2. Select the desired rich text field.
3. Move the mouse pointer over the Mini Toolbar.
4. Select the desired format options.
5. Move the mouse pointer away from the Mini Toolbar.

Step-by-Step

Use the Mini Toolbar to format text.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open the desired table.</td>
<td>Double-click Customers, if necessary</td>
</tr>
<tr>
<td>The desired table opens.</td>
<td></td>
</tr>
<tr>
<td>2. Select the desired rich text field.</td>
<td>Double-click the word Sent in the first record in the Note field</td>
</tr>
<tr>
<td>The text is highlighted and the Mini Toolbar appears transparently.</td>
<td></td>
</tr>
<tr>
<td>3. Move the mouse pointer over the Mini Toolbar.</td>
<td>Move the mouse pointer over the Mini Toolbar</td>
</tr>
<tr>
<td>The Mini Toolbar is active.</td>
<td></td>
</tr>
<tr>
<td>4. Select the desired format options.</td>
<td>Click B to Bold the selected text</td>
</tr>
<tr>
<td>The format of the highlighted text changes.</td>
<td></td>
</tr>
<tr>
<td>5. Move the mouse pointer away from the Mini Toolbar.</td>
<td>Move the mouse pointer away from the Mini Toolbar</td>
</tr>
<tr>
<td>The Mini Toolbar disappears.</td>
<td></td>
</tr>
</tbody>
</table>

Practice the concept: Change the word Sent back to its original format.

Click the Close button on the Customers table window title bar to close the Customers table.
USING DATABASE OBJECTS

Discussion

An Access database file can contain objects such as tables, queries, forms, reports, macros, and modules. Database objects are created to input, edit, retrieve, display, and print data. You can include up to six different object types in an Access database. A description of each of these object types is listed in the following table:

<table>
<thead>
<tr>
<th>Object Type</th>
<th>Object Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>This object type defines the structure of an Access database. Tables display multiple records in rows and columns. Information in these records can be entered, edited, stored, and retrieved.</td>
</tr>
<tr>
<td>Query</td>
<td>A way of requesting selected information from a table. When you run a query, a selected set of records, called the recordset, appears. You can then edit or print the recordset.</td>
</tr>
<tr>
<td>Form</td>
<td>A screen display you can create to show selected fields in a record. Forms allow you to enter, view, and edit data. You can use a form as an alternative to displaying data in rows and columns.</td>
</tr>
<tr>
<td>Report</td>
<td>A design for printed data. Reports can include lists and mailing labels, as well as database reports. Reports can also perform mathematical operations and calculate summaries.</td>
</tr>
<tr>
<td>Macro</td>
<td>A stored set of Access commands that can be repeated as a unit to automate database functions.</td>
</tr>
<tr>
<td>Module</td>
<td>This object type stores Visual Basic for Applications Edition programming code that can be used to further customize and enhance database functions.</td>
</tr>
</tbody>
</table>

When you open a database, all objects in the database are grouped under one of the object types listed in the preceding table. The object types Table, Query, Form, and Report, along with their corresponding objects, appear in the Navigation Pane.

USING THE NAVIGATION Pane

Discussion

When you open a database or create a new one, the names of your objects appear in the Navigation Pane on the left side of the application window. It replaces the
database window from earlier versions of Access and can also be used instead of switchboards, the screens previously used to navigate around a database.

The Navigation Pane displays tables, queries, forms and reports in filtered lists. You can change the objects included in the list by clicking the list header and selecting the category or group of objects you want to display. A number of predefined categories are available, and it is possible to filter the groups within categories in various ways. Selecting the **Queries** object type displays all query objects in the database and selecting the **Forms** object type displays all the form objects.

You can hide the Navigation Pane by clicking the **Shutter Bar Open/Close** button on the title bar, or by pressing [F11].

You can resize the Navigation Pane by dragging the right hand side to the required size.

**Procedures**

1. Open the desired database.
2. Select the arrow in the Navigation Pane header.
3. Select the desired object type.
**Step-by-Step**

Use the Navigation Pane to select an object type.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the arrow in the Navigation Pane header. The Navigation Pane menu appears.</td>
<td>Click</td>
</tr>
<tr>
<td>2. Select the desired object type. The object type is selected, and the objects stored in it appear in the object list.</td>
<td>Click Tables</td>
</tr>
</tbody>
</table>

**Practice the Concept:** Click the **Forms** object type and the **Reports** object type to display their object lists. Then, click the **All Access Objects** in the program to redisplay all Access objects.

---

**OPENING A DATABASE OBJECT**

**Discussion**

You can open a database object to view the data stored in it. The view in which the data appears depends on the type of object you open. Tables and queries appear in **Datasheet** view. Forms appear in **Form** view. Reports display the data in **Print preview**. Macros and modules run programs attached to the object.

- You can open an object by double-clicking its name in the Navigation Pane.
- You can use the **Close** button on the applicable window title bar to close a database object (such as a table or form), a database, or Access itself.

**Procedures**

1. Open the desired database.
2. Display the desired object list.
3. Double click the name of the object you want to open.
Step-by-Step

Open a database object.

If necessary, display the Tables object list in the Navigation Pane.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the name of the object you want to open. The object appears</td>
<td>Double click Customers, if necessary</td>
</tr>
<tr>
<td>in the corresponding view, or the corresponding program runs</td>
<td></td>
</tr>
</tbody>
</table>

Click the Close button on the Customers Table window title bar to close the Customers table.

Practice the Concept: Display the Forms object list. Select the Orders Entry Form object, if necessary, and then double-click it to display the form in Form view. Close the Orders Entry Form window.

Display the Reports object list to display the Orders Report object in Print preview. Close the Orders Report window without saving changes, if prompted.

USING TABBED DOCUMENTS

Discussion

In Access 2007 you can display database objects in tabbed documents instead of overlapping windows. Using tabbed documents helps to keep open objects visible and accessible. New databases in Access 2007 display tabbed documents by default; databases created in earlier versions use overlapping windows by default. You can enable or disable tabbed documents using Access Options.

When you open an object, it appears in a single pane as a tabbed document. Opening further objects will create additional tabbed documents in the application window. To move among the objects you simply click the tabs at the top of the documents.
Tabbed documents

If you use Access Options to change the tabbed document settings, you must close and re-open the database for the new settings to take effect.

Procedures

1. Open the desired database.
2. Select the arrow in the title bar of the Navigation Pane.
3. Select All Access Objects.
4. Open the desired objects.

Step-by-Step

View tabbed documents.

If necessary, select All Access Objects in the Navigation Pane.

Steps

1. Select the first desired table. The desired table opens.

Practice Data

Double-click Customers
<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>2. Select the second desired table.</td>
<td>Double-click <strong>Items</strong></td>
</tr>
<tr>
<td><em>The second desired table opens.</em></td>
<td></td>
</tr>
<tr>
<td>3. Select the desired form.</td>
<td>Double-click <strong>Data Entry Form</strong></td>
</tr>
<tr>
<td><em>The desired form opens.</em></td>
<td></td>
</tr>
<tr>
<td>4. Select the desired report.</td>
<td>Double-click <strong>Orders Report</strong></td>
</tr>
<tr>
<td><em>The desired report opens.</em></td>
<td></td>
</tr>
</tbody>
</table>

Notice that the active object tab is orange in color and the tab title is displayed in bold type.

**CLOSING A TABBED DOCUMENT**

**Discussion**

When using tabbed documents in Access 2007, you may have a number of forms, tables, queries or reports open at any given time. Multiple objects use more system resources, so in order to be efficient, you should close any objects you are not using. When you have finished working on a particular object you can close it independently, without closing any other open objects.

**Procedures**

1. Select the desired object tab.

2. Select the **Close** button [x] on the active object tab.

**Step-by-Step**

Close a tabbed document.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the desired object tab.</td>
<td>Click the <strong>Customers</strong> tab</td>
</tr>
<tr>
<td><em>The desired object tab becomes active.</em></td>
<td></td>
</tr>
<tr>
<td>2. Select the <strong>Close</strong> button on the active object tab.</td>
<td>Click [x]</td>
</tr>
</tbody>
</table>
If prompted, close without saving changes.

CLOSING ALL TABBED DOCUMENTS

Discussion

When you have finished working with a number of tabbed documents, you can close them all at once, instead of closing each object individually.

Procedures

1. Right-click any open object tab.
2. Select the Close All button

Step-by-Step

Close all tabbed documents.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Right-click the desired object tab.</td>
<td>Right-click the Items tab</td>
</tr>
<tr>
<td>A drop-down menu appears.</td>
<td></td>
</tr>
<tr>
<td>2. Select Close All.</td>
<td>Click</td>
</tr>
<tr>
<td>All open tabbed documents close.</td>
<td></td>
</tr>
</tbody>
</table>

Notice you can right-click on any open tab to close all tabbed documents.

USING THE STATUS BAR

Discussion

As with previous versions of Access, you can display a status bar at the bottom of the application window which displays status messages and progress indicators.

In Access 2007, the status bar has two other standard functions: you can change the view of the active window using the controls on the right of the status bar, and if you
are viewing an object that supports variable zoom, a report for instance, you can zoom in and out using the slider on the right of the status bar.

You can disable the status bar using Access Options.

Procedures

1. Open the desired table.
2. Select the desired button on the status bar.

Step-by-Step

Use the Status bar.

If necessary, open the Customers table.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the desired button on the status bar. The view changes.</td>
<td>Click</td>
</tr>
<tr>
<td>2. Select the desired button on the status bar. The view changes back.</td>
<td>Click</td>
</tr>
</tbody>
</table>

Practice the concept: You can use the buttons on the status bar to view the Pivot Table View and Pivot Chart View.

USING THE OPTIONS DIALOG BOX

Discussion

There may be times when you want to make changes to the way items appear in the application window or Datasheet. For example, you may want to change the display of recently-used documents on the Getting Started task pane from four documents to more or less than that.
The Access Options dialog box allows you to make interface changes as well as many other types of changes in the way Access works. You can alter the way error and spelling checks are performed, how tables and queries appear, and how the keyboard performs to name a few. The Access Options dialog box plays an integral part in allowing you to customize Access based on your personal needs.

The Access Options dialog box

Procedures

1. Select the Office button.
2. Select the Access Options button.
3. Select the option corresponding to the features you want to change.
4. Select or deselect options as desired.
5. Select OK.

Step-by-Step

Use the Access Options dialog box.
Lesson 1 - Exploring Access

**Steps**

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
</table>
| 1. Select the **Office** button.  
*The Office menu appears.* | Click |
| 2. Select the **Access Options** button.  
*The Access Options dialog box opens.* | Click |
| 3. Select the option corresponding to the features you want to change.  
*The appropriate page appears.* | Click the **Current Database** option, if necessary |
| 4. Select or deselect options as desired.  
*The options are selected or deselected accordingly.* | Click **Display Status Bar** to deselect it |
| 5. Continue selecting or deselecting options as desired.  
*The options are selected or deselected accordingly.* | Follow the instructions shown below the table before continuing on to the next step |
| 6. Select **OK**.  
*The Options dialog box closes, and the options are enabled or disabled accordingly.* | Click **OK** |

Select the **Datasheet** option, select the **Font color** list under **Default colors** and select a dark blue color from the palette. Then, select the **Background color** list and select a light blue color from the palette. You may be prompted to close and re-open the database in order for the changes to take effect.

*Return to the table and continue on to the next step (step 6).*

Notice that the status bar no longer appears. Open the **Customers** table and notice the changes to the display. Close the **Customers** table.

**Practice the Concept:** Open the Access Options dialog box and select the **Display Status Bar** option on the **Current Database** page. Then, display the **Datasheet** page and change the default font color in the **Font color** option to **Black** and the background color in the **Background color** list to **White**. Select **OK** to close the Options dialog box.

---

**CLOSING A DATABASE**

**Discussion**

It is important to remember that you cannot have more than one database open at a time. When you have finished working on a database, you can close it using the **Office** button.
If a database object has been modified but not saved, an Access dialog box will prompt you to save the changes before closing.

**Procedures**

1. Select the **Office** button.

2. Select **Close Database**.

**Step-by-Step**

Close a database.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
</table>
| 1. Select the **Office** button.  
  *The Office menu appears.* | Click          |
| 2. Select **Close Database**.  
  *The database closes and the Getting Started task pane appears.* | Click          |

**EXITING ACCESS**

**Discussion**

When you have finished using Access, you should exit the application properly, since Access performs necessary housekeeping before it closes. If a database object has been modified, but not saved, an Access dialog box prompts you to save the changes before exiting.

You can also close an object or database by clicking the **Close** button on the applicable window title bar.
Procedures

1. Select the **Office** button

2. Select the **Exit Access** button

Step-by-Step

Exit Access.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
</table>
| 1. Select the **Office** button.  
  *The Office menu appears.* | Click.              |
| 2. Select the **Exit Access** button.  
  *Access closes.*         | Click ![Exit Access](Exit Access) |
EXERCISE

EXPLORING ACCESS

Task

Explore Access.

1. Start Access, if necessary.
2. Open Explore.accdb.
3. Add the Print Preview button to the Quick Access Toolbar.
4. Open the Navigation Pane, if necessary.
5. Select the Queries, Forms, and Reports object types to view the objects in each; then, select Access All Objects.
6. Open all the tables.
7. Use Access Options to change the Background color.
8. Resize the Navigation Pane so that it is half its original width.
10. Open the Trainer report.
11. Use the slider on the Status Bar to zoom in.
12. Close the Trainer report.
13. Use Close All to close the remaining open objects.
14. Reset your usage data, return the background color to white, and remove the Print Preview button from the Quick Access Toolbar.
15. Close the database.
LESSON 2 -
CREATING TABLES

In this lesson, you will learn how to:

- Use database templates
- Create a new database
- Design tables
- Create a table in Datasheet view
- Create a table in Design view
- Add field names
- Assign data types
- Save a new table
- Add a field description
- Set a primary key
- Use multi-valued fields
USING DATABASE TEMPLATES

Discussion

When you create a database in Access, you are creating a container for related tables, forms, queries, reports, and other database objects. You can create a new database manually or with the help of a Database Template. If you create a new database manually, you must then create your own tables, queries, and other objects. To save time, you can use a Local or Online Template.

Access 2007 offers several database templates you can use to quickly create a database. The templates include pre-formatted database objects, such as tables, forms, and reports. A variety of business and personal database templates are available on the Template Categories section on the Getting Started task pane. If you use any template, Access creates not only the database, but also the tables, queries, and other objects in it.

After you have used a database template, a link to it appears under the Open Recent Database section in the Getting Started task pane.

To find out more about a specific local template, hover the mouse pointer over its icon and a pop up window appears with further information about the database template and its common uses.
If you are connected to the Internet, you can also access Online Templates.

Procedures

1. Select Local Templates in the Getting Started task Pane.
2. Select the desired database template.
3. Type the desired file name.
4. Select the Save in folder icon.
5. Select where you want to store the file.
6. Select OK.
7. Select Create.
8. Open the Navigation Pane

Step-by-Step

Use a template to create a new database.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the Local Templates option in the Getting Started task Pane. The Local Templates task pane appears.</td>
<td>Click Local Templates</td>
</tr>
<tr>
<td>2. Select the desired database template. The database template is selected the template appears in the right-hand pane.</td>
<td>Click Contacts</td>
</tr>
<tr>
<td>3. Type the desired file name. The text appears in the File name box.</td>
<td>Type Contacts, if necessary</td>
</tr>
<tr>
<td>4. Select the Save in folder icon. A list of available drives appears.</td>
<td>Click 📁</td>
</tr>
</tbody>
</table>
Lesson 2 - Creating Tables

<table>
<thead>
<tr>
<th><strong>Steps</strong></th>
<th><strong>Practice Data</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>5. Select the drive where you want to store the file.</td>
<td>Click the student data drive, if necessary</td>
</tr>
<tr>
<td>A list of available folders appears.</td>
<td></td>
</tr>
<tr>
<td>6. Open the folder where you want to store the file.</td>
<td>Double-click to open the student data folder, if necessary</td>
</tr>
<tr>
<td>A list of available folders and files appears.</td>
<td></td>
</tr>
<tr>
<td>7. Select <strong>OK</strong>.</td>
<td>Click <strong>OK</strong></td>
</tr>
<tr>
<td>The folder list closes.</td>
<td></td>
</tr>
<tr>
<td>8. Select <strong>Create</strong>.</td>
<td>Click <strong>Create</strong></td>
</tr>
<tr>
<td>The Local Templates task pane closes, and the database opens.</td>
<td></td>
</tr>
<tr>
<td>9. Open the Navigation Pane.</td>
<td>Open the Navigation Pane, if necessary</td>
</tr>
<tr>
<td>The Navigation Pane opens.</td>
<td></td>
</tr>
</tbody>
</table>

When you open the Navigation Pane, it is a good idea to select **Show All**, in order to display all the objects in the database. You can double-click any object in the Navigation Pane to open it. You can now enter data directly into the new database, or modify it to meet your needs.

Close **CONTACTS.ACCDB**.

**CREATING A NEW DATABASE**

**Discussion**

You can create a new database in Access without using a template; however, you must then create the tables, queries, and other objects in the database.

When you create a new database, you must specify the desired file name, as well as where you want to store the database file.

After you have created the database, the Database window opens. The Ribbon command buttons allow you to open objects, modify the design of existing objects, and create new objects. The **Navigation Pane** bar in the Database window allows you to access the following object types: **Tables, Queries, Forms**, and **Reports**.
Procedures

1. Click the Blank Database button on the Getting Started task pane. 

2. Type the desired file name. 

3. Select the Save in folder icon. 

4. Select the drive where you want to store the file. 

5. Open the folder where you want to store the file. 

6. Select OK. 

7. Select Create. 

8. Open the Navigation Pane.

Step-by-Step

Create a new, blank database.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click the Blank Database button on the Getting Started task pane.</td>
<td>Click Blank Database</td>
</tr>
<tr>
<td>The Blank Database pane appear to the right.</td>
<td></td>
</tr>
<tr>
<td>2. Type the desired file name.</td>
<td>Type Company</td>
</tr>
<tr>
<td>The text appears in the File name box.</td>
<td></td>
</tr>
<tr>
<td>3. Select the Save in folder icon.</td>
<td>Click</td>
</tr>
<tr>
<td>A list of available drives appears.</td>
<td></td>
</tr>
<tr>
<td>4. Select the drive where you want to store the file.</td>
<td>Click the student data drive, if necessary</td>
</tr>
<tr>
<td>A list of available folders appears.</td>
<td></td>
</tr>
<tr>
<td>5. Open the folder where you want to store the file.</td>
<td>Double-click to open the student data folder, if necessary</td>
</tr>
<tr>
<td>A list of available folders and files appears.</td>
<td></td>
</tr>
</tbody>
</table>
Steps | Practice Data
---|---
6. Select **OK**. *The folder list closes.* | Click **OK**
7. Select **Create**. *The Getting Started task pane closes, and the database opens.* | Click **Create**
8. Open the Navigation Pane. *The Navigation Pane opens.* | Open the Navigation Pane, if necessary

## Designing Tables

### Discussion

In Access, there are five steps to designing a table. The first step is to develop a thorough understanding of the system, including all the data to be entered and all the reports, statistics, labels, and other output you want to generate. It is helpful to gather all the forms you use for input and all the reports generated from the data. This process serves two purposes. First, these forms and reports are invaluable when you begin detailing exactly what information you want stored in each table. Second, once you have collected a set of these forms, you can make sure that every item of information on your reports is either included in your database or can be derived from data in your database.

The second step is to determine how many tables you need and what information to store in each table. Once you have gained an overview of the system, you are ready to begin designing your database. The most important decision you must make before you begin creating tables is how many tables you want the database to include.

The third step is to design the tables by selecting the fields you want to include, the type of data you want to store in each field, and the size of the fields. Once you have developed an overview of your application and a list of tables, you can make a preliminary list of fields, based on the categories of information that each table will include. You can refine the list by considering the following: if the data is to be sorted or selected, it should be in a separate field; if the data is to be calculated from other fields, you do not need to store it in its own field; and, if the table is to be linked to another table, both tables should contain common fields.

The fourth step is to create the table structures by defining the name, data type, and size of the fields.

The fifth and final step is to enter sample data. This step is important because it helps you determine whether or not the table fields are the correct size and if all the necessary fields have been included. You can then modify the tables as necessary.
You can make changes to the default field sizes and type in the Access Options dialog box, which is accessible by selecting the Office button.

**CREATING A TABLE IN DATASHEET VIEW**

**Discussion**

When you create a new table, you can use either **Datasheet** or **Design** view, use table templates, import data from another data source, or link to data in another data source. **Datasheet** view displays a grid of rows and columns. Field names are entered as column headings.

![A table in Datasheet view](image)

**Procedures**

1. Display the **Tables** object list in the Navigation Pane, if necessary.
2. Select the **Create** tab on the **Ribbon**.
3. Select the **Table** button [Table]
Step-by-Step

Create a table in **Datasheet** view.

If necessary, display the **Tables** object list in the Navigation Pane.

<table>
<thead>
<tr>
<th><strong>Steps</strong></th>
<th><strong>Practice Data</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the <strong>Create</strong> tab on the <strong>Ribbon</strong>. The <strong>Create</strong> tab appears.</td>
<td>Click the <strong>Create</strong> tab</td>
</tr>
<tr>
<td>2. Select the <strong>Table</strong> button. A new table in appears in <strong>Datasheet</strong> View.</td>
<td>Click <strong>Table</strong></td>
</tr>
</tbody>
</table>

Notice that the Datasheet Tab automatically appears on the ribbon when a datasheet is displayed.

The new table appears in the **Table** object list in the Navigation Pane.

Close the table without saving.

**CREATING A TABLE IN DESIGN VIEW**

Discussion

You can also create a table in **Design** view. When you create a table in **Design** view, you have more control over the database design.

The **Design** view window is split into two panes. The upper pane displays a design grid. You can use the rows and columns in this design grid to enter the field names, data types, and field descriptions for each field in the table. The small box to the left of each field name is the row selector. A black triangle in the row selector indicates the current field.

The lower pane displays the properties of the selected field. A property is a characteristic of a field, such as the number of characters a field can contain. Access automatically assigns default field properties, which you can modify as desired.
Procedures

1. Select the **Create** tab on the **Ribbon**.

2. Select the **Table Design** button in the **Tables** group.

Step-by-Step

Create a new table in **Design** view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the <strong>Create</strong> tab on the <strong>Ribbon</strong>. <strong>The Create tab appears</strong>.</td>
<td>Click <strong>Create</strong></td>
</tr>
<tr>
<td>2. Select the <strong>Table Design</strong> button in the <strong>Tables</strong> group. <strong>A blank table appears in Design view</strong>.</td>
<td>Click <strong>Table Design</strong></td>
</tr>
</tbody>
</table>

**ADDING FIELD NAMES**

**Discussion**

Field names are entered into the **Field Name** column in the **Design** view window. Field names are labels that identify the data stored in a field. For example, the **OrderNumber** field will most likely contain order numbers.

Field names can be up to 64 characters long and can include letters, numbers, and spaces. (Field names, however, cannot begin with a space.) Field names cannot contain a period (.), an exclamation point (!), a back quote (‘), brackets ([ ]), or ASCII control characters. In addition, field names within a table must be unique.

Making field names descriptive and meaningful can help with data entry and data retrieval. However, you should avoid long and complicated field names because they can be cumbersome to remember and difficult to reference when performing database functions.
The order in which the field names appear in Design view determines the order in which the columns appear in Database view.

Do not include spaces in field names if you work with other database formats or plan to use macros with VBA (Visual Basic for Applications) code.

Procedures

1. Open or create a table in Design view.
2. Type the desired field name.
3. Press [Down].

Step-by-Step

Add field names in Design view.

If necessary, create a new table in Design view and select the first blank cell in the Field Name column.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
</table>
| 1. Type the desired field name.  
   *The text appears in the Field name column of the current row.* | Type **OrderNumber** |
| 2. Press [Down].  
   *The insertion point moves down one row, and a default data type appears in the Data Type column of the previous row.* | Press [Down] |

Practice the Concept: Type **ProductID** and **Quantity** as the next two field names; pressing [Down] after each.
ASSIGNING DATA TYPES

Discussion

The field data type tells Access what kind of values you plan to store in a field and how much storage space to set aside for the field. Although you can change a data type after a field contains data, doing so may erase some or all of the information in the field.

The following table describes the available data types:

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Text is the default data type; a text field can contain any combination of letters, numbers, punctuation marks, and spaces. The default width is 50 characters and the maximum length is 255 characters.</td>
</tr>
<tr>
<td>Memo</td>
<td>A memo field is similar to a text field, except that a memo field can contain up to 65,535 characters. You can use memo fields for notes or long descriptions in a database.</td>
</tr>
<tr>
<td>Number</td>
<td>A number field can contain only numeric characters, a comma (used as a thousands separator), a period (used as a decimal point), and a hyphen (used as a negative number sign). You should use a number field only when you want to perform calculations using the field values. For example, even though zip codes and telephone numbers consist of numeric characters, you would not use them in calculations; therefore, they should be entered in text rather than number fields.</td>
</tr>
<tr>
<td>Date/Time</td>
<td>The Date/Time data type is used for dates and/or times. Access automatically validates all entries to ensure that they are valid dates and/or times. For example, Access will not allow you to enter 2/31/99 because February does not have 31 days. Date/Time fields are useful in performing calculations on dates and times.</td>
</tr>
<tr>
<td>Currency</td>
<td>The Currency data type is similar to the Number data type and can be used in calculations. However, the values in a currency field can have a maximum of four decimal places and automatically appear with dollar signs and thousands separators (commas). You should use currency fields whenever possible because they use fixed point calculation, which is faster than the floating point calculation used in number fields.</td>
</tr>
<tr>
<td>Data Type</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>AutoNumber</strong></td>
<td>The <strong>AutoNumber</strong> data type allows Access to automatically assign a unique number (consecutively from 1) to each record in the database. You cannot manually enter a value into an AutoNumbered field or change a number Access has assigned to a record. You use this data type when you want a unique identification number for each record.</td>
</tr>
<tr>
<td><strong>Yes/No</strong></td>
<td>A <strong>Yes/No</strong> data type is used to signify one of two conditions, <strong>Yes</strong> or <strong>No</strong>. You use a yes/no field when only two possibilities (i.e., <strong>True</strong> or <strong>False</strong>) exist for a field value.</td>
</tr>
<tr>
<td><strong>OLE object</strong></td>
<td>The <strong>OLE object</strong> data type allows you to either embed an object created in another Windows application or create a link to such an object. You use an <strong>OLE object</strong> data type for graphics, spreadsheets, or sound files.</td>
</tr>
<tr>
<td><strong>Hyperlink</strong></td>
<td>A <strong>Hyperlink</strong> data type is used to store a link to anywhere you choose. The link could go to an Internet page, a Word document on an intranet, or even a form in the current database. A hyperlink field can contain a description, an address, and a sub-address [separated by number signs (#)], as well as up to 2,048 characters; only the address, however, is mandatory.</td>
</tr>
<tr>
<td><strong>Lookup Wizard</strong></td>
<td>The <strong>Lookup Wizard</strong> data type allows you to create a lookup field. A lookup field displays a list of values that are either stored in another table or created by you. A lookup field allows you to choose values from a list during data entry, thereby reducing repetitive typing and eliminating typing errors.</td>
</tr>
</tbody>
</table>

![Assigning a data type](image)
Procedures

1. Open or create a table in **Design** view.
2. Enter field names as desired.
3. Select the **Data Type** column in the field for which you want to change the data type.
4. Select the arrow ▼
5. Select the desired data type.

Step-by-Step

Assign data types to database fields.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the <strong>Data Type</strong> column in the field for which you want to change the data type. <em>The insertion point and a drop-down arrow appear in the corresponding Data Type column.</em></td>
<td>Click in the <strong>Data Type</strong> column for the <strong>Quantity</strong> field</td>
</tr>
<tr>
<td>2. Select the arrow. <em>A list of available data types appears.</em></td>
<td>Click ▼</td>
</tr>
<tr>
<td>3. Select the desired data type. <em>The data type is selected and the field properties change in the lower pane.</em></td>
<td>Click <strong>Number</strong></td>
</tr>
</tbody>
</table>

**SAVING A NEW TABLE**

Discussion

After you have designed the fields for a table, you must save the table before you can add any data. When you save a new table, you should give it a name that describes the records it stores. You can use up to 64 characters, including spaces. These characters
can include letters, numbers, and spaces. They cannot contain a period (.), an exclamation point (!), a back quote (‘), brackets ([]), or ASCII control characters.

When you save a table for the first time, Access opens the Save As dialog box, in which you enter the desired table name.

When you save a table, you are not creating a file. You are adding an object to the existing database.

**Procedures**

1. Create a table in **Design** view.
2. Enter the desired table data.
3. Select **Save**.
4. Type the desired table name.
5. Select **OK**.

**Step-by-Step**

Save a new table.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
</table>
| 1. Click the **Save** button on the Quick Access Toolbar.  
*The Save As dialog box opens with the text in the **Table Name** box selected.* | Click |
| 2. Type the desired table name.  
*The text appears in the **Table Name** box.* | Type **Line Items** |
| 3. Select **OK**.  
*The Save As dialog closes and the table is saved.* | Click **OK** |

Close the **Design** view window. Notice that the table appears in the Navigation Pane.
**ADDING A FIELD DESCRIPTION**

**Discussion**

You can use the **Description** column in the design grid to enter a description for each field. The description appears on the status bar when the field is accessed on a form. You can enter brief comments as to the purpose of the field or the data that should be stored in it.

**Procedures**

1. Open or create a table in **Design** view.
2. Enter field names as desired.
3. Select the **Description** column in the field to which you want to add a description.
4. Type the desired description.

**Step-by-Step**

Add a description to a field.

<table>
<thead>
<tr>
<th><strong>Steps</strong></th>
<th><strong>Practice Data</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the <strong>Description</strong> column in the field to which you want to</td>
<td>Click in the <strong>Description</strong> column for the <strong>OrderNumber</strong> field</td>
</tr>
<tr>
<td>add a description. <strong>The insertion point appears in the corresponding</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Description</strong> column.</td>
<td></td>
</tr>
<tr>
<td>2. Type the desired description. **The text appears in the <strong>Description</strong></td>
<td>Type <strong>Enter the order number</strong></td>
</tr>
<tr>
<td>column.</td>
<td></td>
</tr>
</tbody>
</table>

**Practice the Concept:** Type the following description for the **ProductID** field: **Enter the catalog number of the item.**
**SETTING A PRIMARY KEY**

### Discussion

Access works most efficiently if you specify a primary key for each table. The primary key is a field or group of fields that uniquely identifies each record in the table. Therefore, the value of the key field, or the combined values of a group of key fields, must not be found in more than one record. Consequently, a **LastName** field would be a poor primary field, because several records may have the same last name; it would not, therefore, be unique.

There are several advantages to setting a primary key. First, the primary key is automatically indexed, which makes information retrieval faster. Second, when you open a table, the records are automatically sorted in order by the primary key. Finally, a primary key prevents the entry of duplicate data because Access does not allow duplicates in the primary key field.

- If you have trouble identifying the primary key field, you can create an AutoNumber field and designate it as the primary key.
- You cannot choose an OLE field as the primary key.
- To create a multi-field primary key, hold the [Shift] key, click the row selectors for the desired fields, and then click the **Primary Key** button on the **Design** tab.

### Procedures

1. Open or create a table in **Design** view.
2. Enter field names as desired.
3. Select the field you want to designate as the primary key.
4. Click the **Primary Key** button in the **Tools** group on the **Design** tab on the ribbon.
Step-by-Step

Set a field as the primary key.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the field you want to designate as the primary key. The insertion point appears in the field.</td>
<td>Click <strong>OrderNumber</strong> in the Field Name column</td>
</tr>
<tr>
<td>2. Click the <strong>Primary Key</strong> button in the Tools group on the Design tab on the ribbon. A key appears in the row selector for the designated field and the field is set as the primary key.</td>
<td>Click <strong>Primary Key</strong></td>
</tr>
</tbody>
</table>

Close COMPANY.ACCDB.

** USING MULTI-VALUED FIELDS **

Discussion

In Access 2007 it is possible to create a field that holds multiple values. This can be used to store a multiple valued selection from a list of choices, but only when the list of choices is relatively small. For example, if you are tracking issues, and the same issue is reported by multiple clients, you can create a lookup list to enter that data.

When the combo box is selected, you can select or deselect check boxes to indicate your choices. The selections are then stored in the multi-valued field, and are separated by commas when displayed.

In Access 2007, you can use the Lookup Wizard to create a multi-valued field. The Lookup Wizard takes you through the steps needed to create a lookup list. It automatically sets the appropriate field properties and creates relationships where necessary.

Procedures

1. Open the desired table in **Design** view, if necessary.
2. Type the desired field name in the next available row in the Field Name column.
3. Click in the data type column next to the new field name.

4. Click the arrow and select Lookup Wizard.

5. Select the desired lookup source.

6. Enter the desired data into the column.

7. Enter the desired number of columns.

8. Select the box below the Col1 heading.

9. Enter the first desired lookup value.

10. Enter additional lookup values as desired.

11. Select Next >.

12. Type the desired label for the lookup column.

13. Select Allow Multiple Values.


15. Select Save on the Quick Access Toolbar.

16. Select Datasheet View on the Status Bar.

17. Use the lookup list to enter the desired values.

---

**Step-by-Step**

From the Student Data directory, open COMPANY2.ACCDB. Create a multi-valued field.

Open the Items table in Design view, if necessary.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Type the desired field name in the next available row in the Field Name column. <em>The new field name appears in the Field Name column.</em></td>
<td>Type Color in the Field Name column</td>
</tr>
<tr>
<td>2. Click in the data type column next to the new field name. <em>The data-type menu arrow appears.</em></td>
<td>Click the mouse pointer in the data type column</td>
</tr>
<tr>
<td>Steps</td>
<td>Practice Data</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>---------------------------------------------------</td>
</tr>
<tr>
<td>3. Click the arrow and select <strong>Lookup Wizard</strong>.</td>
<td>Click ▼ and select Lookup Wizard</td>
</tr>
<tr>
<td>The Lookup wizard appears.</td>
<td></td>
</tr>
<tr>
<td>4. Select the desired lookup source.</td>
<td>Click I will type in the values I want</td>
</tr>
<tr>
<td>The desired option is selected.</td>
<td></td>
</tr>
<tr>
<td>5. Enter the desired data into the column.</td>
<td>Click Next &gt;</td>
</tr>
<tr>
<td>The next page of the Lookup wizard appears with the Number of columns box selected.</td>
<td></td>
</tr>
<tr>
<td>6. Enter the desired number of columns.</td>
<td>Type 1, if necessary</td>
</tr>
<tr>
<td>The desired options are selected.</td>
<td></td>
</tr>
<tr>
<td>7. Select the box below the <strong>Col1</strong> heading.</td>
<td>Press [Tab]</td>
</tr>
<tr>
<td>The insertion point appears in the first column, and the specified number of columns appears.</td>
<td></td>
</tr>
<tr>
<td>8. Enter the first desired lookup value.</td>
<td>Type Green</td>
</tr>
<tr>
<td>The text appears in the first <strong>Col1</strong> box.</td>
<td></td>
</tr>
<tr>
<td>9. Enter additional lookup values as desired.</td>
<td>Follow the instructions shown below the table before continuing on to the next step</td>
</tr>
<tr>
<td>The text appears in the columns.</td>
<td></td>
</tr>
<tr>
<td>10. Select <strong>Next</strong>.</td>
<td>Click Next &gt;</td>
</tr>
<tr>
<td>The next page of the Lookup wizard appears.</td>
<td></td>
</tr>
<tr>
<td>11. Type the desired label for the lookup column.</td>
<td>Type Color, if necessary</td>
</tr>
<tr>
<td>The new label name appears in the text field.</td>
<td></td>
</tr>
<tr>
<td>12. Select <strong>Allow Multiple Values</strong>.</td>
<td>Click □ Allow Multiple Values</td>
</tr>
<tr>
<td>The Allow Multiple Values check box is selected.</td>
<td></td>
</tr>
<tr>
<td>13. Select <strong>Finish</strong>.</td>
<td>Click Finish</td>
</tr>
<tr>
<td>The Lookup Wizard disappears.</td>
<td></td>
</tr>
<tr>
<td>14. Select <strong>Save</strong>.</td>
<td>Click</td>
</tr>
<tr>
<td>The table is saved.</td>
<td></td>
</tr>
<tr>
<td>15. Select <strong>Datasheet View</strong>.</td>
<td>Click □ on the Status Bar</td>
</tr>
<tr>
<td>The table opens in Datasheet view and the new column can be seen.</td>
<td></td>
</tr>
</tbody>
</table>
Type the following values in the lookup list, pressing the [Tab] key to move to the next row as needed:

<p>| |</p>
<table>
<thead>
<tr>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue</td>
</tr>
<tr>
<td>Black</td>
</tr>
<tr>
<td>White</td>
</tr>
</tbody>
</table>

*Return to the table and continue on to the next step (step 10).*

Notice that when you click in a record in the **Color** Column, an arrow appears. When you select the arrow, a lookup list appears. When you select the check boxes next to the required values, and click **OK**, the desired values appear in the field, separated by commas.

Close **COMPANY2.ACCDB**.
EXERCISE

CREATING TABLES

Task

Create a table.

1. Use the Students Local Template to create a database. Name the database Student1 and save it to the student data folder.

2. Use the Navigation Pane to display objects by type, then select All Access Objects.

3. Open the Students table.

4. After you have viewed the table, close it. Then, close the Student database as well.

5. Create a blank database named Training and save it to the student data folder.

6. Create a new table in Design view.

7. Add the following fields and their corresponding data types to the table:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>ProjectID</td>
<td>Text</td>
</tr>
<tr>
<td>ClientID</td>
<td>Text</td>
</tr>
<tr>
<td>CourseName</td>
<td>Text</td>
</tr>
<tr>
<td>StartDate</td>
<td>Date/Time</td>
</tr>
<tr>
<td>EndDate</td>
<td>Date/Time</td>
</tr>
<tr>
<td>TrainerInitials</td>
<td>Text</td>
</tr>
<tr>
<td>Cost</td>
<td>Number</td>
</tr>
</tbody>
</table>

8. Enter the following description for the ProjectID field: Enter the ProjectID assigned by Marketing.

9. Set the ProjectID field as the primary key.

10. Save the table as Project.

11. Close the database.
LESSON 3 -
WORKING WITH TABLES

In this lesson, you will learn how to:

- Use Datasheet view
- Navigate fields in tables
- Use Field templates
- Add records
- Move through records
- Select records
- Edit records
- Save records
- Delete records
- Display a Totals row in a table
USING DATASHEET VIEW

Discussion

When you open a table, it appears in **Datasheet** view by default. **Datasheet** view is useful when you want to enter, edit, or delete records.

In **Datasheet** view, the table data is arranged in rows and columns, with the columns representing the table fields and the rows the individual records. Multiple records appear in the table. The small box at the far left of each row is the record selector; a black triangle in the record selector indicates the current record.

NAVIGATING FIELDS IN TABLES

Discussion

In **Datasheet** view, you can use the mouse or the keyboard to move through the fields and records. If there are too many fields to display on screen at the same time, the window scrolls automatically as you move to the right or left.

As you enter or edit data, you can use the [Tab] or [Enter] keys to move from field to field. You can also use the [Right] and [Left] arrow keys to navigate across fields. These keys are helpful because they allow you to keep your hands on the keyboard at all times, rather than having to switch back and forth from the keyboard to the mouse. However, the mouse is useful if you want to skip certain fields. You simply click in the field where you want to enter or edit data.

The [Up] and [Down] arrow keys allow you to move from record to record. In addition, the navigation toolbar at the bottom of the datasheet allows you to select the first, last, next, or previous record, as well as specify a particular record you want to view.

The [Page Up] and [Page Down] keys scroll to the previous or next page of records, respectively.
USING FIELD TEMPLATES

Discussion

Access 2007 has a number of predefined fields that can be used when creating a table. The Field Templates task pane displays fields listed in categories, which you can drag and drop onto a table opened in **Datasheet** view. The field template defines the field name, data type, format and a number of field properties.

Procedures

1. Open the desired table in **Datasheet** view.
2. Select the **Datasheet** tab on the **Ribbon**.
3. Select the **New Field** button in the **Fields & Columns** group.
4. Select the desired field from the field list.
5. Drag the field into the desired position on the datasheet.
6. Release the mouse button.

Step-by-Step

From the Student Data directory, open **TABLES1.ACCDB**. Use the Field Template task pane.

Open the **Customers** table in **Datasheet** view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
</table>
| 1. Select the **Datasheet** tab on the **Ribbon**.  
*The Datasheet tab appears.* | Click **Datasheet** |
| 2. Select the **New Field** button in the **Fields & Columns** group.  
*The Field Templates task pane appears.* | Click **New Field** |
### Steps

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
</table>
| 3. Select the desired field from the **Contacts** field list.  
*The desired field is selected.* | **Click E-mail Address** |
| 4. Drag the desired field into the desired position on the **Datasheet**.  
*The desired field is dragged onto the Datasheet.* | **Drag E-mail Address**  
on onto the **Datasheet**  
between the **Fax Number** and **Address** fields |
| 5. Release the mouse button.  
*The desired field appears in the Datasheet.* | **Release the mouse button** |

### ADDING RECORDS

#### Discussion

A blank row follows the last record in an existing table. This blank row, the new record row, displays an asterisk (*) in the record selector. As soon as you begin entering data into the new record row, the asterisk in the record selector changes to a pencil to indicate that the record is being entered or edited, and Access creates another new record row below it.

If there is no data in the table, only the new record row appears. It does not display an asterisk, however; rather, it displays the black triangle that indicates the current record.

When you enter data into a row, the amount of characters you can enter is limited by the size of the field. The field size, however, can actually be larger than the column width in **Datasheet** view; if the field size is larger than the column width, the text scrolls as you type.

After you have typed the desired information into a field, you can press the [**Enter**] or [**Tab**] key to save the record and move the insertion point to the next field.
Adding records in Datasheet view

You can press the [Ctrl+*] key combination to insert the data from the corresponding field of the previous record into the current field.

Procedures

1. Open the desired table in Datasheet view.
2. Select the first field in the new record row, if necessary.
3. Type the desired data.
4. Press [Enter].
5. Enter the desired record data into the remaining fields, pressing [Enter] after each entry.

Step-by-Step

Add a record to a table.

Open the Items table in Datasheet view, if necessary.
### Lesson 3 - Working with Tables

**Access 2007 - Lvl 1**

**Steps**

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the first field in the new record row, if necessary.</td>
<td>Click in the <strong>Product ID</strong> field of the first row, if necessary</td>
</tr>
<tr>
<td><em>The insertion point appears in the field.</em></td>
<td></td>
</tr>
<tr>
<td>2. Type the desired data.</td>
<td>Type <strong>10-1437</strong></td>
</tr>
<tr>
<td><em>The data appears in the field.</em></td>
<td></td>
</tr>
<tr>
<td>3. Press [Enter].</td>
<td>Press [Enter]</td>
</tr>
<tr>
<td><em>The insertion point moves to the next field.</em></td>
<td></td>
</tr>
<tr>
<td>4. Enter the desired record data into the remaining fields, pressing [Enter] after each entry.</td>
<td>Follow the instructions shown below the table to complete this step</td>
</tr>
<tr>
<td><em>The data appears in the fields.</em></td>
<td></td>
</tr>
</tbody>
</table>

Add the following records to the table, pressing [Enter] after each field:

<table>
<thead>
<tr>
<th>ProductID</th>
<th>Product Description</th>
<th>Unit Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>10-1437</td>
<td>shoes, soccer</td>
<td>65.75</td>
</tr>
<tr>
<td>10-2562</td>
<td>skates, hockey</td>
<td>98.50</td>
</tr>
<tr>
<td>10-3827</td>
<td>shoes, baseball</td>
<td>97.81</td>
</tr>
</tbody>
</table>

Close the **Datasheet** view window.

---

**MOVING THROUGH RECORDS**

### Discussion

If there are more records in a table than can be displayed in **Datasheet** view, a vertical scroll bar appears. You can use this scroll bar to view additional records.

Access also provides a navigation toolbar at the bottom of the datasheet that can be used to select the first, last, next, or previous record in the datasheet, as well as to specify a particular record you want to view.

You can also use the [Up] and [Down] arrow keys to move from record to record and the [Page Up] and [Page Down] keys to display the previous or next page of records, respectively.
Procedures

1. Open a table in **Datasheet** view.

2. To move to the last record in the table, click the **Last Record** button on the navigation toolbar.

3. To move to the first record, click the **First Record** button on the navigation toolbar.

4. To move to the next record, click the **Next Record** button on the navigation toolbar.

5. To move to the previous record, click the **Previous Record** button on the navigation toolbar.

Step-by-Step

Move through records in a table.

Open the **Items 2** table in **Datasheet** view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. To move to the last record in the table, click the <strong>Last Record</strong> button on the navigation toolbar. <em>The first field of the last record is selected.</em></td>
<td>Click ▶️</td>
</tr>
<tr>
<td>2. To move to the first record, click the <strong>First Record</strong> button on the navigation toolbar. <em>The first field of the first record is selected.</em></td>
<td>Click ▪️</td>
</tr>
<tr>
<td>3. To move to the next record, click the <strong>Next Record</strong> button on the navigation toolbar. <em>The first field of the next record is selected.</em></td>
<td>Click ▶️</td>
</tr>
<tr>
<td>4. To move to the previous record, click the <strong>Previous Record</strong> button on the navigation toolbar. <em>The first field of the previous record is selected.</em></td>
<td>Click ▪️</td>
</tr>
</tbody>
</table>
SELECTING RECORDS

Discussion

When you select any field in a record, that record becomes the active record. The current record is indicated by a change in color in the record selector. You can then edit any field in the record as desired.

Selecting a record is different than making a record active. To select a record, you must select the entire row. Selecting a record is useful when you want to delete or copy it. For example, if you want to add a record containing almost identical information as the current record, you can select the current record, copy it, paste it into a new record, and then edit it as needed.

You can also use the [Up] and [Down] arrow keys to activate the next or previous record, respectively, and the [Page Up] and [Page Down] keys to activate the first record on the corresponding datasheet page.

Procedures

1. Open a table in Datasheet view.
2. Click anywhere in the record you want to make active.
3. Point to the record selector of a record you want to select.
4. Click in the record selector of the record you want to select.

Step-by-Step

Select a record in a table.

If necessary, open the Items 2 table in Datasheet view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click anywhere in the record you want to make active. <em>The field is selected and the record selector changes color.</em></td>
<td>Click in the 10-8137 field</td>
</tr>
</tbody>
</table>
Steps | Practice Data
---|---
2. Point to the record selector of a record you want to select. *A solid, black, right-pointing arrow appears.* | Point to the left of the **11-8771** field
3. Click in the record selector of the record you want to select. *The entire record is selected.* | Click to the left of the **11-8771** field

## Editing Records

### Discussion

You can edit records at any time. You cannot edit an AutoNumber field, however, because Access automatically generates the data in it.

When you use the keyboard to access a field, the entire field is selected, and you can replace all data simply by typing new data. This is select mode. Access also allows you to edit individual characters within a field. To do this, you must switch to edit mode. In edit mode, the insertion point appears in the field. You can click in a field to access edit mode.

While you are editing a record, a pencil appears in its record selector. The following table describes various keystrokes you can use to edit records:

<table>
<thead>
<tr>
<th>Keystroke</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Up]</td>
<td>Selects the same field in the previous record.</td>
</tr>
<tr>
<td>[Down]</td>
<td>Selects the same field in the next record.</td>
</tr>
<tr>
<td>[Right]</td>
<td>In select mode, selects the next field; in edit mode, moves one character to the right.</td>
</tr>
<tr>
<td>[Left]</td>
<td>In select mode, selects the previous field; in edit mode, moves one character to the left.</td>
</tr>
<tr>
<td>[F2]</td>
<td>Toggles between select and edit modes.</td>
</tr>
<tr>
<td>[Ctrl]+Enter</td>
<td>Inserts a new line character in a field.</td>
</tr>
<tr>
<td>[Ctrl]+’</td>
<td>Inserts the data from the corresponding field in the previous record.</td>
</tr>
<tr>
<td>[Ctrl]+Alt+Spacebar</td>
<td>Replaces the data with the default data, if available.</td>
</tr>
<tr>
<td>[Ctrl]+Shift+:</td>
<td>In select mode, replaces the field data with the current time.</td>
</tr>
</tbody>
</table>
### Keystroke

<table>
<thead>
<tr>
<th>Keystroke</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Ctrl+;]</td>
<td>In select mode, replaces the field data with the current date.</td>
</tr>
</tbody>
</table>

### Procedures

1. Open a table in **Datasheet** view.
2. Click in the field you want to edit.
3. Select the text you want to edit.
4. Type the desired text.
5. Press **[Enter]**.

### Step-by-Step

Edit a table record in edit mode.

If necessary, open the **Items 2** table in **Datasheet** view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click in the field you want to edit. (\textit{The insertion point appears in the field.})</td>
<td>Click in the \textbf{65.75} field in the first row</td>
</tr>
<tr>
<td>2. Select the text you want to edit. (\textit{The characters are selected.})</td>
<td>Drag to select the number \textbf{6}, the first character in the field</td>
</tr>
<tr>
<td>3. Type the desired text. (\textit{The characters are replaced.})</td>
<td>Type \textbf{5}</td>
</tr>
<tr>
<td>4. Press [Enter]. (\textit{The changes to the record are saved.})</td>
<td>Press [Enter]</td>
</tr>
</tbody>
</table>
SAVING RECORDS

Discussion

Access automatically saves a new record or changes made to an existing record as soon as you move to the next field. You can also save a record manually. This option is useful if a record has numerous fields and you want to save the changes made to a field without leaving the field. You may also want to save a record manually to save changes made to automatically generated data.

Access saves records automatically when you close a table.

You can also use the Save button on the Quick Access Toolbar to save a record.

DELETING RECORDS

Discussion

When you no longer need a record, you can delete it. Deleting records saves disk space and keeps your tables smaller and more manageable.

Deleting a record
After you have deleted a record, you cannot undo the deletion.

Procedures

1. Open a table in **Datasheet** view.
2. Select the record you want to delete.
4. Select **Yes** to delete the record.

Step-by-Step

Delete a record from a table.

If necessary, open the **Items 2** table in **Datasheet** view.

<table>
<thead>
<tr>
<th><strong>Steps</strong></th>
<th><strong>Practice Data</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the record you want to delete. <strong>The record is selected.</strong></td>
<td>Scroll as necessary and click the record selector of the last record</td>
</tr>
<tr>
<td>2. Press <code>[Delete]</code>. <strong>The record is removed from the table, and a Microsoft Office Access warning box opens, prompting you to confirm the deletion.</strong></td>
<td>Press <code>[Delete]</code></td>
</tr>
<tr>
<td>3. Select <strong>Yes</strong> to delete the record. <strong>The Microsoft Office Access warning box closes.</strong></td>
<td>Click <strong>Yes</strong></td>
</tr>
</tbody>
</table>

Close the **Items 2** table.
DISPLAYING A TOTALS ROW IN A TABLE

Discussion

Access 2007 has a new feature that allows you to add a totals row to a **Datasheet**. This can be used to count the number of items in a column, calculate a sum, average, or find the maximum or minimum value. (These are all examples of aggregate functions).

A Totals Row in a table

Procedures

1. Open the desired table in **Datasheet** view, if necessary.
2. Select the **Home** tab on the **Ribbon**, if necessary.
3. Select the **Totals** button on the **Records** section of the **Home** tab.
4. In the totals row, select the desired field.
5. Select the arrow.
6. Select the desired aggregate function.
## Step-by-Step

Create a Totals Row in a table.

Open the **Items 2** table in datasheet view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
</table>
| 1. Select the **Home** tab on the **Ribbon**, if necessary.  
  *The Home tab appears.* | Click **Home**                       |
| 2. Select the **Totals** button in the **Records** section of the **Home** tab.  
  *The totals row appears in the datasheet.* | Click **Totals**                     |
| 3. In the totals row, select the field you want to total.  
  *The arrow appears.* | Click in the **Unit Price** field in the **Total** row |
| 4. Select the arrow.  
  *The aggregate function list appears.* | Click **down arrow**                 |
| 5. Select the desired function.  
  *Access displays the total sum.* | Click **Sum**                        |

Notice that you can clear the totals row by clicking the **Totals** button in the **Records** section of the **Home** tab again.

Close **TABLES1.ACCDB**.
EXERCISE

WORKING WITH TABLES

Task

Work with tables.

1. Open Worktabx.accdb.
2. Open the Project table in Datasheet view.
3. Add the following records to the table:

<table>
<thead>
<tr>
<th>Project ID</th>
<th>Client ID</th>
<th>Course Name</th>
<th>Start Date</th>
<th>End Date</th>
<th>Trainer Initials</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>1001</td>
<td>ABBOTT</td>
<td>PCBASICS</td>
<td>1/5/04</td>
<td>1/5/04</td>
<td>JA</td>
<td>75</td>
</tr>
<tr>
<td>1002</td>
<td>AQUA</td>
<td>WINDOWS</td>
<td>1/9/04</td>
<td>1/9/04</td>
<td>EA</td>
<td>75</td>
</tr>
<tr>
<td>1003</td>
<td>CONCORD</td>
<td>WORD</td>
<td>1/16/04</td>
<td>1/17/04</td>
<td>DF</td>
<td>200</td>
</tr>
</tbody>
</table>

4. Close the Project table.
5. Open the Project2 table in Datasheet view.
6. Move to the second record.
7. In the second record, change the start date to 1/10/04 and the end date to 1/11/04.
8. Save the record.
9. Select the fourth record.
10. Delete the fourth record.
11. Add a totals row to calculate the total cost.
12. Close the table without saving and then close the database.
LESSON 4 -
EDITING TABLES

In this lesson, you will learn how to:

- Change the row height
- Change the column width
- Change a font attribute
- Change a cell effect
- Use alternate background colors
- Select a column
- Move a column
- Hide a column
- Unhide a column
- Freeze a column
CHANGING THE ROW HEIGHT

Discussion

In Datasheet view, the default row height is 12.75 points. You can change the row height to allow long field entries to wrap. This option allows you to display more of the data in a long field entry.

Changing the height of a single row changes the height of every row in the table.

You can also select a record and right-click and select Row Height to change the row height in a table. In the Row Height dialog box, you can enter the desired row height or select the Standard Height option to reset the row height to the default 12.75 points.

You cannot use the Undo feature to undo a change in the row height. To undo a row height change, you must close the table without saving the changes.

Procedures

1. Open a table in Datasheet view.
2. Point to any horizontal line between records in the record selector.
3. Drag the line to the desired row height.

Step-by-Step

From the Student Data directory, open TABLES2.ACCDB.

Change the height of the rows in a table.

Open the Items table in Datasheet view.
1. Point to any horizontal line between records in the record selector.  
   *The mouse pointer changes into a black cross with vertical arrowheads.*
   
2. Drag the line to the desired row height.  
   *The height of all the rows changes accordingly.*

Notice that the longer text entries in the **Product Description** field now wrap to the next line.

**Practice the Concept:** Select any record, right-click and select **Row Height**. Select the **Standard Height** option and **OK**.

---

**CHANGING THE COLUMN WIDTH**

**Discussion**

In **Datasheet** view, the standard column width is 15.6667 characters. If a field contains a long entry, you can change the column width to display more of the field entry.

- You can select a column, then right-click and select **Column Width** to change the column width in a table. In the Column Width dialog box, you can enter the desired column width or select the **Standard Width** option to reset the column width to its default 15.6667 characters.

- You cannot use the **Undo** feature to undo changes in column width. To undo a column width change, you must close the table without saving the changes.

- If you double-click the column separator line to the right of any column header, the width of that column automatically adjusts to display the longest entry in the column. You can also do this by selecting the **Best Fit** option in the Column Width dialog box.
Procedures

1. Open a table in **Datasheet** view.
2. Point to the vertical line to the right of the header of the column you want to adjust.
3. Drag the line to the desired width.

Step-by-Step

Change the width of a column in a table.

If necessary, open the **Items** table in **Datasheet** view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Point to the vertical line to the right of the header of the column you want to adjust. <em>The mouse pointer changes into a black cross with horizontal arrowheads.</em></td>
<td>Point to the vertical line to the right of the <strong>Product Description</strong> header</td>
</tr>
<tr>
<td>2. Drag the line to the desired width. <em>The column width changes accordingly.</em></td>
<td>Drag the line to the right of the <strong>Unit Price</strong> header</td>
</tr>
</tbody>
</table>

**CHANGING A FONT ATTRIBUTE**

Discussion

You can change datasheet font attributes. The font attributes affect the appearance of the data and column headings. The **Font** group on the **Home** tab on the **Ribbon** contains buttons with which you can change the font type, style, and size, as well as add or remove font effects.

When editing Rich Text in a Memo field, you can use the **Mini Toolbar** to change font attributes.
Procedures

1. Open a table in **Datasheet** view.
2. Select the **Home** tab on the **Ribbon**.
3. Select the desired options using the **Font** group on the **Home** tab.

Step-by-Step

Change a font attribute.

If necessary, open the **Items** table in **Datasheet** view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the <strong>Home</strong> tab on the <strong>Ribbon</strong>. <strong>The Format menu appears.</strong></td>
<td>Click <strong>Home</strong></td>
</tr>
<tr>
<td>2. Select the desired options from the <strong>Font</strong> group on the <strong>Home</strong> tab. <strong>The font attribute changes.</strong></td>
<td>Click [B]</td>
</tr>
</tbody>
</table>

Click the **Bold** button again to return the font back to its original state.

**CHANGING A CELL EFFECT**

Discussion

You can change the appearance of cells in **Datasheet** view. For example, you can make cells raised or sunken. You can also change the look of the horizontal and vertical gridlines, and the cell background.
The Datasheet Formatting dialog box

Procedures

1. Open a table in **Datasheet** view.
2. Select launcher button in the bottom right corner of the **Font** group on the **Home** tab.
3. Select the desired option.
4. Select **OK**.

Step-by-Step

Change a cell effect.

If necessary, open the **Items** table in **Datasheet** view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the <strong>Home</strong> tab.</td>
<td>Click <strong>Home</strong></td>
</tr>
<tr>
<td><em>The Home tab appears.</em></td>
<td></td>
</tr>
</tbody>
</table>
Steps | Practice Data
--- | ---
2. Select the launcher arrow in the bottom right corner of the Font group. *The Datasheet Formatting dialog box opens.* | Click ![image](image)
3. Select the desired option. *A preview of the selected option appears in the Sample box.* | Click ![image](image) *Raised under Cell Effect*
4. Select **OK**. *The Datasheet Formatting dialog box closes, and the cell effect is applied to the table.* | Click ![image](image) **OK**

**Using Alternate Background Colors**

**Discussion**

You can use the Datasheet Formatting dialog box to set or change an alternate background color. This option shades every other row in a datasheet, report or form, with a color of your choice, which can make viewing easier.

- You can also use **Access Options** to set or change the alternate background color.
- You can use a different alternate background color for each object.

**Procedures**

1. Open the desired table.
2. Select the **Home** tab, if necessary.
3. Select the launcher button ![image](image) in the bottom right corner of the Font group.
4. Select the **Alternate Background Color** arrow.
5. Select the desired color.
6. Select

![Image]

### Step-by-Step

Change the alternate background color.

Open the **Line Items** table in **Datasheet** view, if necessary.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
</table>
| 1. Select the **Home** tab, if necessary.  
*The Home tab appears.* | Click **Home** |
| 2. Select the launcher arrow in the bottom right corner of the **Font** group.  
*The datasheet formatting dialog box appears.* | Click ![Image] |
| 3. Select the **Alternate Background Color** arrow.  
*The Color Palette appears.* | Click ![Image] |
| 4. Select the desired color.  
*The selection is shown in the sample section.* | Click **Red** |
| 5. Select **OK**  
*The Datasheet Formatting dialog box disappears, and the alternate background color on the Datasheet changes.* | Click ![Image] |

Follow the above process to change the background color back to the original color.

### SELECTING A COLUMN

#### Discussion

Before you can manipulate table columns, you must select them. You can perform a number of actions on selected columns, as well as select a single column or multiple adjacent columns.

Column headers are also called field selectors.
To select multiple adjacent columns, drag across the headers of the columns you want to select.

Right-clicking a column header selects the column and displays the column shortcut menu at the same time. The shortcut menu provides access to common column commands, such as changing column width or hiding columns.

Procedures

1. Open a table in Datasheet view.
2. Click the header of the column you want to select.

Step-by-Step

Select a column in a table.

If necessary, open the Items table in Datasheet view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click the header of the column you want to select.</td>
<td>Click the Product Description header</td>
</tr>
</tbody>
</table>

The column is selected.

Click in any field to deselect the column.

MOVING A COLUMN

Discussion

You can move one or more columns in Datasheet view. For example, you can reposition columns to view data more easily or organize the datasheet logically.

You can move a single column or multiple, adjacent columns. Before you can move a column or multiple columns, however, you must first select them.
Moving columns does not change the order of the fields in the table design.

To undo a column move, you must close the table without saving the changes. You cannot use the Undo feature to undo a column move.

When you are dragging a column to move it, a vertical divider bar appears in the destination location when the mouse pointer is correctly positioned.

Procedures

1. Open a table in Datasheet view.
2. Select the column you want to move.
3. Drag the column to the new location.

Step-by-Step

Move a column in a table.

If necessary, open the Items table in Datasheet view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the column you want to move. <em>The column is selected.</em></td>
<td>Click the Product ID header</td>
</tr>
<tr>
<td>2. Drag the column to the new location. <em>The column appears in the new location.</em></td>
<td>Drag the Product ID column to the right of the Product Description column, until a vertical divider bar appears between the columns</td>
</tr>
</tbody>
</table>

Click in any field to deselect the column.
HIDING A COLUMN

Discussion

If you do not regularly view or edit one or more table fields, you can hide their corresponding table columns. Hiding columns can make your datasheet narrower and easier to view.

You can hide a single column or multiple adjacent columns.

Procedures

1. Open a table in **Datasheet** view.
2. Select the column you want to hide.
3. Right-click the column you want to hide.
4. Select **Hide Columns**.

Step-by-Step

Hide a column in a table.

If necessary, open the **Items** table in **Datasheet** view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the column you want to hide. <em>The column is selected.</em></td>
<td>Click the <strong>Unit Price</strong> header</td>
</tr>
<tr>
<td>2. Right-click the selected column. <em>The Shortcut menu appears.</em></td>
<td>Right-click the <strong>Unit Price</strong> column</td>
</tr>
<tr>
<td>3. Select <strong>Hide Columns</strong>. <em>The column disappears from the table.</em></td>
<td>Click <strong>Hide Columns</strong></td>
</tr>
</tbody>
</table>
UNHIDING A COLUMN

Discussion

You can redisplay hidden columns. The Unhide Columns dialog box lists all the columns in the table, with a check box to the left of each column name. The check box is deselected for hidden columns. You can select the check box to redisplay a hidden column.

The Unhide Columns dialog box

You can also use the Unhide Columns dialog box to hide/unhide multiple, non-adjacent columns.

Procedures

1. Open a table in Datasheet view.
2. Select any column.
3. Right-click the selected column.
4. Select Unhide Columns.
5. Select the column you want to unhide.

Step-by-Step

Unhide a column in a table.
If necessary, open the **Items** table in **Datasheet** view and hide the **Unit Price** column.

<table>
<thead>
<tr>
<th><strong>Steps</strong></th>
<th><strong>Practice Data</strong></th>
</tr>
</thead>
</table>
| 1. Select any column.  
The column is selected. | Click the **Product Description** column header |
| 2. Right-click the selected column.  
The **Shortcut** menu appears. | Right-click the **Product Description** column |
| 2. Select **Unhide Columns**.  
The **Unhide Columns** dialog box opens. | Click **Unhide Columns...** |
| 3. Select the column you want to unhide.  
The column check box is selected, and the column appears in the table. | Click **Unit Price** |
| 4. Select **Close**.  
The **Unhide Columns** dialog box closes. | Click **Close** |

Close and save the **Items** table.

**FREEZING A COLUMN**

![Discussion](image)

If you have a table with multiple fields, all of the columns may not display on screen at the same time. You can scroll to the right to view additional columns; however, you may not be able to see the columns at the far left, which may display necessary information, such as the record identification.

You can freeze columns in **Datasheet** view. Freezing one or more columns allows you to see the information in the frozen columns no matter how many columns you scroll to the right.

- A solid, dark line appears to the right of the last frozen column.

- To unfreeze columns, select **Unfreeze All Columns** from the **Shortcut** menu.
Procedures

1. Open a table in **Datasheet** view.
2. Select the column you want to freeze.
3. Right-click the selected column.
4. Select the **Freeze Columns** command.

Step-by-Step

Freeze a column in a table.

Open the **Orders** table in **Datasheet** view. Scroll to the right to view the **Catalog** column. Notice that the left columns scroll out of view. Scroll back to view the **Order Number** column.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the column you want to freeze. <em>The column is selected.</em></td>
<td>Click the <strong>Order Number</strong> header</td>
</tr>
<tr>
<td>2. Right-click the selected column. <em>The Shortcut menu appears.</em></td>
<td>Right-click the <strong>Order Number</strong> column</td>
</tr>
<tr>
<td>3. Select the <strong>Freeze Columns</strong> command. <em>The selected column is frozen.</em></td>
<td>Click <strong>Freeze Columns</strong></td>
</tr>
</tbody>
</table>

Click anywhere in the table to deselect the column. Scroll to the right. Notice that the **Order Number** column remains on screen. Follow the above steps and select the **Unfreeze All Columns** command to unfreeze the column.

Close the **Orders** table without saving the changes.
Close **TABLES2.ACCDB**.
EXERCISE

EDITING TABLES

Task

Edit a table.

1. Open Edittabx.accdb.
2. Open the Client table in Datasheet view.
3. Increase the row height by approximately 25%.
4. Change the font to Arial Narrow and the font size to 12.
5. Widen the Name and Address columns so that all the data in them appears.
6. Change the cell effect to Sunken.
7. Move the Client ID column to the right of the Name column.
8. Hide the Client ID column.
9. Unhide the Client ID column.
10. If necessary, resize the Datasheet window so that the columns at the far right do not appear.
11. Freeze the Name column, then scroll to view the Phone No column.
12. Unfreeze all columns.
13. Change the alternate background color to green.
14. Close the table without saving the changes.
15. Close the database.
LESSON 5 -
FINDING AND FILTERING DATA

In this lesson, you will learn how to:

- Sort records
- Find specific records
- Find records using wildcards
- Use Replace
- Use Filter By Selection
- Apply/Remove a filter
- Use Filter Excluding Selection
- Use the Search Box
- Use Quick Filter
- Use AutoFilter
SORTING RECORDS

Discussion

When you display a table in Datasheet view, Access displays the records in order by their primary key. You may want to edit or print records in a different order (e.g., by last name, zip code, or amount due).

You can sort records in either ascending or descending order. Ascending order sorts numerically from 0 to 9 and then alphabetically from A to Z. Descending order sorts numerically from 9 to 0 and then alphabetically from Z to A. The Home tab provides buttons for both ascending and descending sorts.

Procedures

1. Open a table in Datasheet view.
2. Select the field by which you want to sort.
3. Click the Sort Ascending button or the Sort Descending button in the Sort & Filter group on the Home tab on the Ribbon.
4. To remove the sort, select the Clear All Sorts button.

Step-by-Step

From the Student Data directory, open FILTER1.ACCDB. Sort records in a table.

Open the Customers table in Datasheet view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the field by which you want to sort. The insertion point appears in the column.</td>
<td>Click in the Store Name column</td>
</tr>
</tbody>
</table>
### Finding Specific Records

#### Discussion

The **Find** feature allows you to locate records quickly. You can search for records that contain a unique value in a certain field, or you can find all records that have a common value in a field. Access scans the selected field, beginning with the current record, and highlights the first instance of the search text it finds. You can repeat the search to find additional records containing the same data.

In the Find and Replace dialog box, you can select options to control how Access searches for matching records. You can use the **Look In** list to search the current column or the entire table. The options on the **Match** list allow you to specify whether to match any part of the field, the whole field, or only the start of the field.

The Find and Replace dialog box remains open during a search. If needed, you can move the dialog box out of the way to view the search as it progresses.

![Find and Replace dialog box](image.png)

*The Find and Replace dialog box*
The Find and Replace dialog box retains the settings of the most recent search. Pressing the [Shift+F4] key combination performs the same search again.

Procedures

1. Open a table in **Datasheet** view.
2. Select the field you want to search.
3. Click the **Find** button on the **Home** tab on the **Ribbon**.
4. Type the text you want to find in the **Find What** box.
5. Select the **Match** list.
6. Select the desired option.
7. Select **Find Next** to begin the search.
8. Select **Find Next** to find the next matching record.
9. When all records have been searched, select **OK**.
10. Select **Cancel** to close the Find and Replace dialog box.

Step-by-Step

Find specific records in a table.

If necessary, open the **Customers** table in **Datasheet** view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the field you want to search. &lt;br&gt; <em>The insertion point appears in the column.</em></td>
<td>Scroll as necessary and click in the &lt;br&gt; <strong>State/Province</strong> column</td>
</tr>
</tbody>
</table>
### Steps

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>2. Click the <strong>Find</strong> button on the <strong>Home</strong> tab on the <strong>Ribbon</strong>.</td>
<td><img src="image" alt="Find" /></td>
</tr>
<tr>
<td><em>The Find and Replace dialog box opens with the insertion point in the Find What box.</em></td>
<td></td>
</tr>
<tr>
<td>3. Type the text you want to find in the <strong>Find What</strong> box.</td>
<td><strong>Type</strong> <em>ny</em></td>
</tr>
<tr>
<td><em>The text appears in the Find What box.</em></td>
<td></td>
</tr>
<tr>
<td>4. Select the <strong>Match</strong> list.</td>
<td><img src="image" alt="Match" /></td>
</tr>
<tr>
<td><em>A list of available options appears.</em></td>
<td></td>
</tr>
<tr>
<td>5. Select the desired option.</td>
<td><img src="image" alt="Whole Field" /></td>
</tr>
<tr>
<td><em>The option is selected.</em></td>
<td></td>
</tr>
<tr>
<td>6. Select <strong>Find Next</strong> to begin the search.</td>
<td><img src="image" alt="Find Next" /></td>
</tr>
<tr>
<td><em>The data in the first matching record is selected.</em></td>
<td></td>
</tr>
<tr>
<td>7. Select <strong>Find Next</strong> to find the next matching record.</td>
<td><img src="image" alt="Find Next" /> twice</td>
</tr>
<tr>
<td><em>The data in the next matching record is selected, or a Microsoft Office Access message box opens to notify you that all records have been searched.</em></td>
<td></td>
</tr>
<tr>
<td>8. When all records have been searched, select <strong>OK</strong>.</td>
<td><img src="image" alt="OK" /></td>
</tr>
<tr>
<td><em>The Microsoft Office Access message box closes.</em></td>
<td></td>
</tr>
<tr>
<td>9. Select <strong>Cancel</strong> to close the Find and Replace dialog box.</td>
<td><img src="image" alt="Cancel" /></td>
</tr>
<tr>
<td><em>The Find and Replace dialog box closes.</em></td>
<td></td>
</tr>
</tbody>
</table>

**Practice the Concept:** Find all records in the state of PA. Then, close the Find and Replace dialog box.

### Finding Records Using Wildcards

#### Discussion

You can use wildcards in a find. Wildcards are characters that represent other characters. They allow you to find records, even if you are not sure how the entry
appears in the field. Wildcards also allow you to find records that share a common entry within a field, but not necessarily the entire field entry. For example, you may want to search for the area code at the beginning of a telephone number field.

You can use the following wildcards in a find:

<table>
<thead>
<tr>
<th>Wildcard</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*</td>
<td>Represents any number of characters. It can be used anywhere in the search text. For example, <strong>North</strong> will find all entries beginning with the word <strong>North</strong>; <strong>Sports</strong> will find all entries ending with the word <strong>Sports</strong>; and <strong>Sports</strong> will find all entries containing the word <strong>Sports</strong>.</td>
</tr>
<tr>
<td>?</td>
<td>Represents only one character; for example, <strong>Sm?th</strong> will find <strong>Smith</strong>, <strong>Smyth</strong>, etc.</td>
</tr>
<tr>
<td>[ ]</td>
<td>Finds any character enclosed in the set; for example, <strong>b[ai]t</strong> will find <strong>bat</strong> and <strong>bit</strong>, but not <strong>bet</strong> and <strong>but</strong>.</td>
</tr>
<tr>
<td>!</td>
<td>Finds any character except the ones enclosed in the set; for example, <strong>b[^ai]t</strong> will find <strong>bet</strong> and <strong>but</strong>, but not <strong>bat</strong> or <strong>bit</strong>.</td>
</tr>
<tr>
<td>-</td>
<td>Finds any character in a range in a set; for example, <strong>b[w-u]t</strong> finds <strong>but</strong>, <strong>bvt</strong>, and <strong>bwt</strong>.</td>
</tr>
<tr>
<td>#</td>
<td>Represents only one digit; for example, <strong>1980#</strong> finds <strong>19801</strong>, <strong>19802</strong>, <strong>19803</strong>, etc.</td>
</tr>
</tbody>
</table>

**Procedures**

1. Open a table in **Datasheet** view.
2. Select the field you want to search.
3. Click the **Find** button on the **Home** tab on the **Ribbon**.
4. Type the text you want to find in the **Find What** box.
5. Select the **Match** list.
6. Select the desired option.
7. Select **Find Next** to begin the search.
8. Select **Find Next** to find the next matching record.
9. When all records have been searched, select **OK**.
10. Select **Cancel** to close the Find and Replace dialog box.

### Step-by-Step

Find records in a table using wildcards.

If necessary, open the **Customers** table in **Datasheet** view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
</table>
| 1. Select the field you want to search.  
*The insertion point appears in the column.* | Scroll as necessary and click in the **Store Name** column |
| 2. Click the **Find** button on the **Home** tab on the **Ribbon**.  
*The Find and Replace dialog box opens with the text in the **Find What** box selected.* | Click **Find** |
| 3. Type the text you want to find in the **Find What** box.  
*The text appears in the **Find What** box.* | Type *athlete* |
| 4. Select the **Match** list.  
*A list of available options appears.* | Click **Match** |
| 5. Select the desired option.  
*The option is selected.* | Click **Any Part of Field** |
| 6. Select **Find Next** to begin the search.  
*The field in the first matching record is selected.* | Click **Find Next** four times |
| 7. Select **Find Next** to find the next matching record.  
*The field in the next matching record is selected, or a Microsoft Office Access message box opens to notify you that all records have been searched.* | Click **Find Next** |
| 8. When all records have been searched, select **OK**.  
*The Microsoft Office Access message box closes.* | Click **OK** |
Steps | Practice Data
--- | ---
9. Select **Cancel** to close the Find and Replace dialog box.  
*The Find and Replace dialog box closes.* | Click **Cancel**

**USING REPLACE**

**Discussion**

The **Replace** feature allows you to quickly locate and replace data in a field. This feature is especially useful if the same information must be changed in several records. Access scans the selected field, beginning with the current record, and selects the first instance of the search text it finds. You can replace the text or search for the next instance of the search text. You can also replace all the instances of the search text at once.

In the Find and Replace dialog box, you can control how Access searches for matching records. The **Look In** list enables you to search either the current column or the entire table. The options on the **Match** list allow you to specify whether to match any part of the field, the whole field, or only the start of the field.

The Find and Replace dialog box remains open during a search. You can move it as needed to view the datasheet records.

![Tip](Tip) Selecting the **Replace All** button in the Find and Replace dialog box replaces all data that matches the search text. Make sure that you want to replace all data before you use the **Replace All** button because you may not be able to retrieve the data once it has been replaced.

**Procedures**

1. Open a table in **Datasheet** view.
2. Select the field you want to search.
3. Select the **Replace** button in the **Find** group on the **Home** tab on the **Ribbon**.
4. Type the text you want to find in the **Find What** box.
5. Select the **Replace With** box.
6. Type the desired replacement text.
7. Select **Find Next** to begin the search.
8. Select **Replace**.
9. Select **Replace All**.
10. Select **Yes** to replace all remaining matches.
11. Select **Cancel** to close the Find and Replace dialog box.

**Step-by-Step**

Use the Replace feature to replace record data in a table.

If necessary, open the **Customers** table in **Datasheet** view.

<table>
<thead>
<tr>
<th><strong>Steps</strong></th>
<th><strong>Practice Data</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the field you want to search. <em>The insertion point appears in the column.</em></td>
<td>Scroll as necessary and click in the <strong>Postal Code</strong> column</td>
</tr>
<tr>
<td>2. Select the <strong>Replace button in the Find</strong> group on the <strong>Home</strong> tab on the <strong>Ribbon</strong>. <em>The Find and Replace dialog box opens.</em></td>
<td>Click</td>
</tr>
<tr>
<td>3. Type the text you want to find in the <strong>Find What</strong> box. <em>The text appears in the <strong>Find What</strong> box.</em></td>
<td>Type <strong>23211</strong></td>
</tr>
<tr>
<td>4. Select the <strong>Replace With</strong> box. <em>The insertion point moves to the <strong>Replace With</strong> box.</em></td>
<td>Press <strong>[Tab]</strong></td>
</tr>
<tr>
<td>5. Type the desired replacement text. <em>The text appears in the <strong>Replace With</strong> box.</em></td>
<td>Type <strong>23209</strong></td>
</tr>
<tr>
<td>6. Select <strong>Find Next</strong> to begin the search. <em>The data in the first matching record is selected.</em></td>
<td>Click <strong>Find Next</strong></td>
</tr>
</tbody>
</table>
### Using Filter By Selection

**Discussion**

You can filter data in Access. Filtering data allows you to view only those records with which you want to work by hiding the records you do not want to see. For example, you can filter data in a customers table so that only the records of those customers located in a specific region appear.

A quick and easy way to filter data in Access is to use the **Filter By Selection** feature, in which only those records that match the data in the selected field are displayed.

A filter remains in effect until you remove it.
When a filter is in effect, the (Filtered) indicator appears on the status bar.

Procedures

1. Open a table in Datasheet view.
2. Select any field that contains the data by which you want to filter.
3. Click the Selection button on the Sort & Filter group on the Home tab.

Step-by-Step

Use the Filter By Selection feature.

If necessary, open the Customers table in Datasheet view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select any field that contains the data by which you want to filter. <em>The insertion point appears in the field.</em></td>
<td>Scroll as necessary to the Region column and click in any Southeast field</td>
</tr>
</tbody>
</table>
### Applying/Removing a Filter

#### Discussion

If a filter is in effect, the **Toggle Filter** button becomes active. You can use this button to remove a filter/sort or to re-apply the previous filter.

#### Procedures

1. Open a table in **Datasheet** view.

2. Click the **Toggle Filter** button in the **Sort & Filter** group on the **Home** tab, as applicable.

#### Step-by-Step

Apply and remove a filter.

If necessary, open the **Customers** table in **Datasheet** view and filter the table by the **Southeast** region.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click the <strong>Toggle Filter</strong> button in the <strong>Sort &amp; Filter</strong> group on the <strong>Home</strong> tab, as applicable. <em>The filter is applied or removed accordingly.</em></td>
<td>Click <img src="image" alt="Toggle Filter" /></td>
</tr>
</tbody>
</table>

---
**Practice the Concept:** Click the **Apply Filter** button again to reapply the previous filter. Then, remove the filter again to display all the records.

---

## USING FILTER EXCLUDING SELECTION

### Discussion

The **Filter Excluding Selection** feature is similar to the **Filter by Selection** feature except that it displays all records that do not match the filter criteria. For example, if most of the customers in a customers table are located in the state of New York, you can use the **Filter Excluding Selection** feature to display only those records in which the customers are not located in New York.

### Procedures

1. Open a table in **Datasheet** view.
2. Select the field that contains the data you want to exclude.
3. Select the **Home** tab.
4. Select the **Selection** button in the **Sort & Filter** group.
5. Select the desired filter options.

### Step-by-Step

Use the **Filter Excluding Selection** feature.

If necessary, open the **Customers** table in **Datasheet** view and display all records.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the field that contains the data you want to exclude. <em>The insertion point appears in the field.</em></td>
<td>Scroll as necessary to the <strong>Country</strong> column and click in any <strong>U.S.A.</strong> text.</td>
</tr>
<tr>
<td>2. Select the <strong>Home</strong> tab. <em>The <strong>Home</strong> tab appears.</em></td>
<td>Click <strong>Home</strong></td>
</tr>
<tr>
<td>3. Select the <strong>Selection</strong> button in the <strong>Sort &amp; Filter</strong> group. <em>The <strong>Filter</strong> submenu appears.</em></td>
<td>Click ✅<strong>Selection</strong></td>
</tr>
</tbody>
</table>
**Steps**

4. Select the desired filter option.
   *The records are filtered to exclude the selected data.*

**Practice Data**

Click **Does Not Equal** “U.S.A.”

Remove the filter.

---

**USING THE SEARCH BOX**

### Discussion

The Search Box feature allows you to find specific records in a **Datasheet** quickly. The Search Box is located at the bottom of the **Datasheet**, above the status bar and to the right of the record navigation VCR buttons.

### Procedures

1. Open the desired table in **Datasheet** view, if necessary.
2. Click in the Search Box.
3. Type the text you want to find in the Search Box.
4. Press **[Enter]**, if necessary
Step-by-Step

Use the Search Box to search for a specific record.

Open the Customers table, if necessary.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click in the Search Box</td>
<td>Click in the Search Box</td>
</tr>
<tr>
<td><em>The insertion point appears in the search box.</em></td>
<td></td>
</tr>
<tr>
<td>2. Type the text you want to find in the Search Box.</td>
<td>Type athlete</td>
</tr>
<tr>
<td><em>The text appears in the Search box and Access highlights the first instance of the text in the Datasheet.</em></td>
<td></td>
</tr>
<tr>
<td>3. Press [Enter].</td>
<td>Press [Enter]</td>
</tr>
<tr>
<td><em>Access highlights the second instance of the text in the Datasheet.</em></td>
<td></td>
</tr>
</tbody>
</table>

Notice if you continue to hit the enter key, Access continues to highlight further instances of the specified text in the Datasheet.

**USING QUICK FILTER**

Discussion

Another quick and easy way to filter data in Access is to use Quick Filters. These are menu commands that limit information based on the data that you select. Quick Filter options change automatically, based on the data type selected.
Procedures

1. Open the desired table in **Datasheet** view.
2. Select the desired column.
3. Select the arrow on the right of the desired field header.
4. Select the desired filter options.
5. Select the desired Quick Filter.
6. Specify the desired filter options.
7. Select the **Toggle Filter** button to remove the filter.

Step-by-Step

Use Quick Filters.

Open the **Line Items** table.
### Steps

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the desired column.</td>
<td>Click <strong>Quantity</strong></td>
</tr>
<tr>
<td><em>The desired column is selected.</em></td>
<td></td>
</tr>
<tr>
<td>2. Select the arrow on the right of the desired field header.</td>
<td>Click <strong>in the field header</strong></td>
</tr>
<tr>
<td><em>The Filter menu appears.</em></td>
<td></td>
</tr>
<tr>
<td>3. Select the desired filter options.</td>
<td>Select <strong>Number Filters</strong></td>
</tr>
<tr>
<td><em>The desired option is selected and further filter options appear based on the data type selected.</em></td>
<td></td>
</tr>
<tr>
<td>4. Select the desired Quick Filter.</td>
<td>Select <strong>Less Than</strong></td>
</tr>
<tr>
<td><em>The Custom Filter dialog box appears.</em></td>
<td></td>
</tr>
<tr>
<td>5. Specify the desired filter options.</td>
<td>Type <strong>5</strong></td>
</tr>
<tr>
<td><em>The text appears in the text field.</em></td>
<td></td>
</tr>
<tr>
<td>6. Select OK.</td>
<td>Click <strong>OK</strong></td>
</tr>
<tr>
<td><em>The filter is applied to the table.</em></td>
<td></td>
</tr>
<tr>
<td>7. Select the <strong>Toggle Filter</strong> button to remove the filter.</td>
<td>Click <strong>Toggle Filter</strong></td>
</tr>
<tr>
<td><em>The filter is removed.</em></td>
<td></td>
</tr>
</tbody>
</table>

### Using AutoFilter

#### Discussion

You can filter data in Access. Filtering data allows you to view specific records only, hiding all records that do not meet the filter criteria. For example, you can filter data in a Customers table so that only the records of those customers located in a specific region appear.

A quick and easy way to filter data in Access is to use the new AutoFilter feature. AutoFilter allows you to select among the unique values in a column, or sort values by using language context menu options such as **Sort Smallest to Largest**.

- When a filter is in effect, the *(Filtered)* indicator appears at the bottom of the datasheet to the left of the Search Box.
- A filter remains in effect until you remove it.
Procedures

1. Open the desired table in **Datasheet** view.
2. Select the desired column.
3. Select the **Home** tab, if necessary.
4. Select the **Filter** button \(\text{Filter}^{\text{Filter}}\) in the **Sort & Filter** group.
5. Select \(\checkmark\) (Select All) to clear the filter option check boxes.
6. Select the desired filter options.
7. Select \(\text{OK}\) \(\text{OK}^{\text{OK}}\)
8. Select the **Toggle Filter** button \(\text{Toggle Filter}^{\text{Toggle Filter}}\) to remove the filter.

Step-by-Step

Use AutoFilter.

Open the **Customers** table, if necessary.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the desired column. (\text{The desired column is selected.})</td>
<td>Click <strong>Sales Rep</strong></td>
</tr>
<tr>
<td>2. Select the <strong>Home</strong> tab, if necessary. (\text{The Home tab is selected.})</td>
<td>Click <strong>Home</strong></td>
</tr>
<tr>
<td>3. Select the <strong>Filter</strong> button in the <strong>Sort &amp; Filter</strong> group. (\text{The Filter menu appears.})</td>
<td>Click <strong>Filter</strong></td>
</tr>
<tr>
<td>4. Clear the filter option check boxes. (\text{The filter option check boxes are cleared.})</td>
<td>Click (\checkmark) (Select All) to clear all check boxes</td>
</tr>
<tr>
<td>5. Select the desired filter options. (\text{The desired options are selected.})</td>
<td>Click (\Box) <strong>FLW</strong></td>
</tr>
<tr>
<td>6. Select <strong>OK</strong>. (\text{The desired filter is applied to the table.})</td>
<td>Click <strong>OK</strong></td>
</tr>
</tbody>
</table>
Steps | Practice Data
--- | ---
7. Select the **Toggle Filter** button to remove the filter.  
*The filter is removed.* | Click ![Toggle Filter](image)

Close **FILTER1.ACCDB**.
EXERCISE

FINDING AND FILTERING DATA

Task

Find and filter data.

1. Open Filterex.accdb.
2. Open the Client table in Datasheet view.
3. Sort the records in descending order by the Zip field.
4. Sort the records in ascending order by the Client ID field.
5. Find all the records in the state of TX.
6. Use a wildcard to find all records with a telephone number that starts with 713.
7. Use the Replace feature to find the 206-707-7070 telephone number and replace it with 206-707-8954.
8. Close and save the Client table.
9. Open the Payment table in Datasheet view.
10. Use the Filter By Selection feature to find all records with VISA as the type of payment. Then, remove the filter.
11. Use the Filter Excluding Selection feature to find all records with a balance due that is not $0.00. Then, remove the filter.
12. Use the AutoFilter to filter the table to show only the projects run by the trainer with the initials RW.
13. Remove the filter using the Toggle Filter button.
14. Use the QuickFilter number filter to find all Amounts Paid between £50 and £125.
15. Remove the filter.
16. Close the database.
LESSON 6 - PRINTING DATA

In this lesson, you will learn how to:

- Print table data
- Change the page setup
- Use print preview
- Print selected records
PRINTING TABLE DATA

Discussion

You can print table data from the Office menu. When you use the Print button, Access uses the default printer settings.

If there are too many fields to fit on one page, Access prints as many fields as possible on the first page and then prints additional pages for the next set of fields, etc., until all the fields have been printed. If you have a large table with multiple fields, the printout could result in many pages of disjointed information. Consequently, the Print button is best utilized for printing smaller, more compact tables.

If a filter is applied, only the displayed records will print.

Procedures

1. Open a table in Datasheet view.

2. Select the Office button.

3. Select the Print button.

4. Select OK.

Step-by-Step

From the Student Data directory, open PRINT1.ACCDB.
Print the data in a table.

Open the Customers table in Datasheet view.
<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
</table>
| 1. Select the **Office** button.  
     *The Office menu appears.* | Click |
| 2. Click the **Print** button on the **Table Datasheet** toolbar.  
     *Access prints all data in the table.* | Click |
| 3. Select **OK**.  
     *The document prints.* | Click |

**CHANGING THE PAGE SETUP**

**Discussion**

You can control how a table is printed by changing the page setup options. You can adjust the margins, as well as change the page orientation so that more data can fit on fewer pages.

On the **Margins** page in the Page Setup dialog box, you can change the size of the margins and choose whether or not to print column headings.

*The Page Setup dialog box*

- Print settings are saved for forms and reports, but not for tables.
Procedures

1. Open a table in Datasheet view.

2. Select the Office button.

3. Select the Print button.

4. Select the Setup button.

5. Select the desired options.

6. Select OK.

7. Select OK.

Step-by-Step

Change the page setup.

If necessary, open the Customers table in Datasheet view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the Office button. The Office menu appears.</td>
<td>Click</td>
</tr>
<tr>
<td>2. Select the Print button. The Print dialog box opens.</td>
<td>Click</td>
</tr>
<tr>
<td>3. Select the Setup button. The Page Setup dialog box appears.</td>
<td>Click</td>
</tr>
<tr>
<td>4. Select the desired options. The options are selected, and a preview of the changes appears in the Sample box</td>
<td>Follow the instructions shown below the table before continuing on to the next step</td>
</tr>
</tbody>
</table>
Enter 20 as the measurement for all the margins: top, bottom, left, and right.

*Return to the table and continue on to the next step (step 5).*

### Using Print Preview

#### Discussion

Before printing, you can preview a table to see how the data appears on each page. The Print Preview feature displays the pages as they will appear when printed, including all aspects of the layout. You can use the Print Preview feature to preview the appearance of your printed pages before printing them; thereby allowing you to make additional changes.

The default view in print preview displays the full page, making the print difficult to read; however, you can increase the magnification of the page by zooming print preview. This option makes the text easier to read. When the mouse pointer is positioned over the page, it changes into a magnifying glass. When you click the page with the magnifying glass, the magnification increases so that you can read the area of the page you clicked. When you click the page again, the magnification returns to full page view.

If your table contains multiple pages, you can view several pages at one time. The page images are reduced as necessary to fit in the print preview window. The pages displayed initially depend upon the location of the insertion point when you access the Print Preview feature.
You can also use the **Page** buttons at the bottom of the print preview window to move between pages.

Clicking the **Page Setup** button on the **Print Preview** tab opens the Page Setup dialog box.

**Procedures**

1. Open a table in **Datasheet** view.
2. Select the **Office** button.
3. Select the arrow to the right of the **Print** button.
4. Select **Print Preview**.
5. Click the area of the page you want to magnify.
6. Click anywhere in the page to return to Full Page view.
7. Click anywhere in the tab area away from the page.

8. Press [Page Down] or [Page Up] to display the next or previous page of the printout, respectively.

9. To view more than one page at a time, select the desired options from the Zoom group on the Print Preview tab.

10. Select the desired page layout.

11. Select the Close Print Preview button.

Step-by-Step

Use print preview to preview a table before printing.

If necessary, open the Customers table in Datasheet view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the Office button.</td>
<td>Click</td>
</tr>
<tr>
<td><em>The Office menu appears.</em></td>
<td></td>
</tr>
<tr>
<td>2. Select the arrow to the right of the Print button.</td>
<td>Click</td>
</tr>
<tr>
<td><em>The print options appear to the right.</em></td>
<td></td>
</tr>
<tr>
<td>3. Select Print Preview.</td>
<td>Click</td>
</tr>
<tr>
<td><em>Print preview opens.</em></td>
<td></td>
</tr>
<tr>
<td>4. Click the area of the page you want to magnify.</td>
<td>Click in the middle of the page</td>
</tr>
<tr>
<td><em>The page is magnified.</em></td>
<td></td>
</tr>
<tr>
<td>5. Click anywhere in the page to return to Full Page view.</td>
<td>Click anywhere in the page</td>
</tr>
<tr>
<td><em>The entire page appears in print preview.</em></td>
<td></td>
</tr>
<tr>
<td>6. Click anywhere in the tab area away from the page.</td>
<td>Click anywhere in the tab area away from the page</td>
</tr>
<tr>
<td><em>The cursor resumes its normal arrow style.</em></td>
<td></td>
</tr>
</tbody>
</table>
Lesson 6 - Printing Data

Steps | Practice Data
--- | ---
7. Press [Page Down] or [Page Up] to display the next or previous page of the printout, respectively. *The next or previous page appears accordingly.* | Press [Page Down]
8. To view more than one page at a time, select the desired options from the **Zoom** group on the **Print Preview** tab. *Print preview displays the desired number of pages.* | ![Two Pages](image)
9. Select the desired page layout. *The pages appear in the selected page layout.* | ![Landscape](image)
10. Select the **Close Print Preview** button. *Print preview closes.* | ![Close Print Preview](image)

**PRINTING SELECTED RECORDS**

**Discussion**

You can print selected, adjacent records. You can print selected records by first selecting the records in the table and then selecting the **Selected Records(s)** option in the Print dialog box.

- You can also select other options in the Print dialog box, such as the number of copies you want to print.
- You can select multiple, adjacent records by selecting the first record you want to print, holding the [Shift] key, and clicking the last record you want to print.
Procedures

1. Open a table in **Datasheet** view.
2. Select the records you want to print.
3. Select the **Office** button.
4. Select the **Print** button.
5. Select the **Selected Record(s)** option under **Print Range**.
6. Select **OK**.

Step-by-Step

Print selected records in a table.

If necessary, open the **Customers** table in **Datasheet** view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the records you want to print. <em>The records are selected.</em></td>
<td>Drag in the record selector, from the first record to the sixth record</td>
</tr>
<tr>
<td>2. Select the <strong>Office</strong> button. <em>The Office menu appears.</em></td>
<td>Click</td>
</tr>
<tr>
<td>3. Select the <strong>Print</strong> button. <em>The Print dialog box opens.</em></td>
<td>Click</td>
</tr>
<tr>
<td>4. Select the <strong>Selected Record(s)</strong> option under <strong>Print Range</strong>. <em>The Selected Record(s) option is selected.</em></td>
<td>Click <strong>Selected Record(s)</strong></td>
</tr>
<tr>
<td>5. Select <strong>OK</strong>. <em>The Print dialog box closes, and Access prints the selected records.</em></td>
<td>Click <strong>OK</strong></td>
</tr>
</tbody>
</table>

Close **PRINT1.ACCDB**.
EXERCISE

PRINTING DATA

Task

Print data.

1. Open Printex.accdb.
2. Open the Trainer table in Datasheet view.
3. Use the Print button to print the table data.
4. Change the left and right margins to .75" and the orientation to landscape.
5. Preview the printout and then close print preview.
6. Print only the first five records.
7. Close the table.
8. Close the database.
LESSON 7 - CREATING RELATIONSHIPS

In this lesson, you will learn how to:

- Use related tables
- Create a relationship between tables
- Set referential integrity
- View subdatasheets
- Delete a join line
USING RELATED TABLES

Discussion

Tables can be joined, or related, in order to access and coordinate information in all the fields of the related tables. Joining tables is a useful way to avoid entering duplicate information in various, related tables. In addition, it allows you to create reports, forms, and queries from the related data tables and save them in the database file. Relating tables allows you to create smaller, more efficient tables that can be referenced when you need access to the data.

When you relate tables, the table from which you select a field to join is the primary table, and the second table containing the field you want to associate is the related table. The tables must have at least one common field that contains the same type of data. This common field is called the join field. The join fields in both tables must have the same or equivalent data types and, if they are Number fields, they must have the same field size. In addition, the join field in the primary table must be the primary key in order to avoid duplicate entries.

For example, the following table consists of customer names and address fields, along with a unique identification number for each customer, which serves as the primary key in the table. You can create this number or allow Access to create it for you.

<table>
<thead>
<tr>
<th>ID #</th>
<th>Names</th>
<th>Address</th>
<th>City</th>
<th>State</th>
<th>Zip</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Smith</td>
<td>11692 J St. NW</td>
<td>Washington</td>
<td>DC</td>
<td>20013</td>
</tr>
<tr>
<td>2</td>
<td>Conrad</td>
<td>16 Allegheny Center</td>
<td>Pittsburgh</td>
<td>PA</td>
<td>16489</td>
</tr>
<tr>
<td>3</td>
<td>Kane</td>
<td>1012 Broadway</td>
<td>Lexington</td>
<td>KY</td>
<td>40567</td>
</tr>
<tr>
<td>4</td>
<td>Apple</td>
<td>516 Beacon Ave.</td>
<td>Seattle</td>
<td>WA</td>
<td>98051</td>
</tr>
<tr>
<td>5</td>
<td>Billow</td>
<td>9249 Cavalcade St.</td>
<td>Houston</td>
<td>TX</td>
<td>77002</td>
</tr>
</tbody>
</table>

You could then create a separate table consisting only of orders placed by customers. This table would also contain the field for the unique customer identification number, but not the customers’ names and addresses.

<table>
<thead>
<tr>
<th>ID #</th>
<th>Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Office Work Center</td>
</tr>
<tr>
<td>2</td>
<td>All-In-One Corner Desk and Hutch</td>
</tr>
<tr>
<td>3</td>
<td>Open-Front Steel Bookcase</td>
</tr>
<tr>
<td>4</td>
<td>2-Drawer Letter File</td>
</tr>
<tr>
<td>5</td>
<td>Executive Leather Chair, Black</td>
</tr>
</tbody>
</table>
By relating the two tables through the common customer identification number field, the customers’ name and address does not have to be entered for every order. All that has to be entered is the customer identification number, along with the orders.

Access includes three types of relationships: one-to-many, one-to-one and many-to-many. A one-to-many relationship occurs when one record from the primary table matches many records from the related table (e.g., one customer record matches many order records). A one-to-one relationship occurs when one record from the primary table matches one record from the related table. Access determines the relationship type automatically when you create the relationship. A many-to-many relationship occurs when a number of records from the primary table match a number of records in the related table (e.g. when dealing with Products and Orders, each record in the Orders table may match many records in the Products table and vice versa).

CREATING A RELATIONSHIP BETWEEN TABLES

Discussion

The Relationships window displays a graphic representation of database relationships and allows you to create relationships between tables. You drag field lists in the Relationships window to reposition them as needed. In addition, any field name that represents a primary key is has a key symbol next to it.

You can add tables to the Relationships window for additional joins. For example, if the Relationships window displays only two related tables and you need to access information from a third table, you can easily add the required table to the Relationships window and then create the join.

The Edit Relationships dialog box

The Show Table dialog box opens automatically if no tables have been added to the Relationships window.
You can select multiple tables in the Show Table dialog box by holding the [Ctrl] key as you click each table. Selecting **Add** adds all the selected tables to the Relationships window.

**Procedures**

1. Click the **Relationships** button on the **Database Tools** tab.

2. Click the **Show Table** button on the **Design** tab, if necessary.

3. Select the first table you want to relate.

4. Select **Add**.

5. Select the second table you want to relate.

6. Select **Add**.

7. Select **Close**.

8. Drag the desired field from the first field list to the matching field in the second field list.

9. Select **Create**.

10. Select **Close** on the **Design** tab.

11. Select **Yes**.

**Step-by-Step**

From the Student Data directory, open **RELATE1.ACCDB**. Create a relationship between two tables.
## Steps

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click the <strong>Database Tools</strong> tab. Click the <strong>Relationships</strong> button. The Relationships window opens.</td>
<td><img src="image" alt="Relationships" /></td>
</tr>
<tr>
<td>2. Click the <strong>Show Table</strong> button on the <strong>Design</strong> tab, if necessary. The Show Table dialog box opens.</td>
<td><img src="image" alt="Show Table" /></td>
</tr>
<tr>
<td>3. Select the first table you want to relate. The table name is selected.</td>
<td><img src="image" alt="Select Table" /> Click Customers, if necessary</td>
</tr>
<tr>
<td>4. Select <strong>Add</strong>. The corresponding field list appears in the Relationships window.</td>
<td><img src="image" alt="Add" /></td>
</tr>
<tr>
<td>5. Select the second table you want to relate. The table name is selected.</td>
<td><img src="image" alt="Select Table" /> Click Orders</td>
</tr>
<tr>
<td>6. Select <strong>Add</strong>. The corresponding field list appears in the Relationships window.</td>
<td><img src="image" alt="Add" /></td>
</tr>
<tr>
<td>7. Select <strong>Close</strong>. The Show Table dialog box closes.</td>
<td><img src="image" alt="Close" /></td>
</tr>
<tr>
<td>8. Drag the desired field from the first field list to the matching field in the second field list. The Edit Relationships dialog box opens when you release the mouse button with the related fields as well as the type of relationship displayed.</td>
<td><img src="image" alt="Drag Field" /> Drag the <strong>Customer Number</strong> field from the <strong>Customers</strong> table to the <strong>Customer ID</strong> field in the <strong>Orders</strong> table</td>
</tr>
<tr>
<td>9. Select <strong>Create</strong>. The Edit Relationships dialog box closes, and a join line appears between the related fields.</td>
<td><img src="image" alt="Create" /></td>
</tr>
<tr>
<td>10. Close the Relationships window. A Microsoft Office Access warning box opens, asking if you want to save the changes to the layout.</td>
<td><img src="image" alt="Close" /> on the <strong>Design</strong> tab</td>
</tr>
<tr>
<td>11. Select <strong>Yes</strong>. The Microsoft Office Access warning box and the Relationships window close, and the tables are related.</td>
<td><img src="image" alt="Yes" /></td>
</tr>
</tbody>
</table>
Practice the Concept: Add the Line Items table to the Relationships window. Drag the Line Items table to the right of the Orders field list, if desired. Then, join the Order Number field in the Orders table to the Order Number field in the Line Items table.

Close the Relationships window and save the changes.

SETTING REFERENTIAL INTEGRITY

Discussion

When you create a relationship between two tables, you can set referential integrity. Referential integrity is a built-in set of rules Access uses to make sure that the relationship is valid. Referential integrity can also prevent accidental deletion or editing of data. In order to use referential integrity, the following conditions must be true: the related field in one table must be its primary key, the related fields in both tables must have the same data type, and both tables must belong to the same database.

When you set referential integrity, you must observe the following three rules; First, you cannot enter data in the join field in the "many" table that does not have a match in the join field in the "one" table. Second, you cannot delete records from the "one" table if there are matching records in the "many" table. Third, you cannot edit primary key values if related records exist.

If you want to perform any of the changes listed above, however, and still maintain referential integrity, you can select the Cascade Update Related Fields and Cascade Delete Related Records options in the Edit Relationships dialog box. If either or both of these options are selected, Access automatically makes the necessary changes to related tables to maintain referential integrity. It is recommended that these two options be selected only after careful consideration, since the changes cannot be undone.

When referential integrity is enforced, Access displays symbols above the join line to indicate the type of relationship, one-to-one or one-to-many. The number 1 above a join line indicates “one”, and the mathematical symbol for infinity (which resembles a horizontal 8) indicates “many”.

Double-clicking the middle segment of any join line opens the Edit Relationships window with the selected join displayed. Double-clicking the beginning or ending segment of any join line opens the Edit Relationships window, but with no join selected. You can then use the Table/Query list to select the desired join.
Procedures

1. Open the desired table.

2. Select the Relationships button on the Datasheet tab.

3. Double-click the middle segment of the desired join line.

4. Select the Enforce Referential Integrity option.

5. Select the Cascade Update Related Fields option, if desired.

6. Select the Cascade Delete Related Records option, if desired.

7. Select \(\text{OK}\).

Step-by-Step

Set referential integrity for the relationship between two tables.

Open the Customers table, if necessary.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the Relationships button on the Datasheet tab. The Relationships window opens.</td>
<td>Click Relationships</td>
</tr>
<tr>
<td>2. Double-click the middle segment of the desired join line. The Edit Relationships dialog box opens with the selected join displayed.</td>
<td>Double-click the middle segment of the join line between the Customer Number and Customer ID fields</td>
</tr>
<tr>
<td>2. Select the Enforce Referential Integrity option. The Enforce Referential Integrity option is selected.</td>
<td>Click Enforce Referential Integrity</td>
</tr>
<tr>
<td>3. Select OK. The Edit Relationships dialog box closes, and referential integrity is applied to the join.</td>
<td>Click OK</td>
</tr>
</tbody>
</table>
Practice the Concept: Set referential integrity for the join between the Order Number fields. Then, close the Relationships window.

### Viewing Subdatasheets

**Discussion**

Subdatasheets are datasheets nested in the primary table and display the data in joined tables. When you join tables in a one-to-many relationship, Access creates subdatasheets in the table containing the primary key.

When tables are joined, Access inserts a column containing plus signs to the left of the first field in the primary table. Clicking the plus sign expands a subdatasheet with the data in the related table displayed. If the table contains additional joins, you can expand subdatasheets to display each related table. Access can display up to eight levels of subdatasheets.

In addition to viewing data, you can edit data right in the subdatasheet; the edited data is saved back to the table in which it is stored.

`Displaying subdatasheets`

Access can also create subdatasheets for one-to-one relationships.
Procedures

1. Open the primary table in **Datasheet** view.
2. To display a subdatasheet, click the plus sign next to the record you want to expand.
3. Display additional subdatasheets, if available.
4. Click the minus sign next to any subdatasheet you want to collapse.

Step-by-Step

View subdatasheets.

Open the **Customers** table in **Datasheet** view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. To display a subdatasheet, click the plus sign next to the record you want to expand. <em>The subdatasheet appears.</em></td>
<td>Click 🟢 1014</td>
</tr>
<tr>
<td>2. Display additional subdatasheets, if available. <em>Additional subdatasheets appear.</em></td>
<td>Click 🟢 1711 in the subdatasheet</td>
</tr>
<tr>
<td>3. Click the minus sign next to any subdatasheet you want to collapse. <em>The subdatasheet disappears.</em></td>
<td>Click 🟢 1711 in the subdatasheet</td>
</tr>
</tbody>
</table>

**Practice the Concept:** Change the sales representative for the 1711 order to **NTB**. Then, collapse the 1014 record in the **Customers** table to collapse the subdatasheet.

Close the **Customers** table and open the **Orders** table in **Datasheet** view. Scroll down as necessary to view order number 1711. Notice that the sales representative for order number 1711 is now **NTB**. Close the **Orders** table.
DELETING A JOIN LINE

Discussion

Deleting a join line removes the relationship between two tables. You may want to delete a join line if you no longer need to relate the tables or you want to create a different relationship.

You must select a join line before you can delete it.

- **Note:** You must click the middle segment of a join line in order to select it; clicking the beginning or ending segment does not select the join line.

- **Note:** You can also delete a join line by right-clicking its middle segment and selecting the Delete command.

- **Note:** You can remove an unrelated field list from the Relationships window by selecting it and pressing the [Delete] key.

Procedures

1. Select the Relationships button on the Database Tools tab.
2. Click the middle segment of the join line you want to delete.
3. Press [Delete].
4. Select **Yes**.

Step-by-Step

Delete a join line.
**Steps** | **Practice Data**
---|---
1. Select the **Relationships** button on the **Database Tools** tab.  
*The Relationships window opens.*

<table>
<thead>
<tr>
<th>Click</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relationships</td>
</tr>
</tbody>
</table>

2. Click the middle segment of the join line you want to delete.  
*The join line is bolded.*

| Click the middle segment of the join line between the **Customers** and **Orders** field lists |

3. Press [Delete].  
*A Microsoft Office Access warning box opens, prompting you to confirm the deletion.*

| Press [Delete] |

4. Select **Yes**.  
*The Microsoft Office Access warning box closes, and the join line is deleted.*

<table>
<thead>
<tr>
<th>Click</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
</tr>
</tbody>
</table>

**Practice the Concept:** Delete the join line between the **Orders** and **Line Items** field lists. Then, remove all field lists from the Relationships window by selecting them and pressing [Delete], since none of them are related.

Close the Relationships window and save the changes.  
Close **RELATE1.ACCDB**.
EXERCISE

CREATING RELATIONSHIPS

Task

Create relationships.

1. Open `Relate1x.accdb`.
2. Open the Relationships window.
3. Add the `Client` and `Project` tables to the Relationships window.
4. Create a relationship between the `Client ID` field in the `Client` table and the `Client ID` field in the `Project` table; set referential integrity for the relationship.
5. Add the `Trainer` table to the Relationships window.
6. Create a relationship between the `Trainer Initials` field in the `Project` table and the `Initials` field in the `Trainer` table; set referential integrity for the relationship.
7. Close the Relationships window and save the changes.
8. Open the Client table in Datasheet view and view the subdatasheet for the `CONCORD` client. Then, collapse the subdatasheet and close the `Client` table.
9. Open the Relationships window. Delete the relationship line between the `Project` and `Trainer` tables and remove the `Trainer` field list, since it is no longer related to any tables. Then, close the Relationships window and save the changes.
LESSON 8 -
USING SIMPLE QUERIES

In this lesson, you will learn how to:

- Use queries and recordsets
- Use the Simple Query Wizard
- Create a query in Design view
- Open a query
- Add a table to a query
- Join tables in a query
- Run a query
USING QUERIES AND RECORDSETS

Discussion

A query is a means of extracting information from tables. You can use queries to analyze the data in a table or to extract data for a form or report. Queries are commonly used to display data in related tables and enable you to control not only which records to display, but also which fields. For example, you may want to give a sales representatives a list of the contacts and telephone numbers for a particular region; you can create a query to extract just the contact names and telephone numbers within the specified region.

A query does not contain data; rather, it is a set of instructions. Access uses these instructions to select and display the desired records in a table. As a result, whenever new data is added to the queried table, the query is automatically updated; if the new records meet the conditions of the query, they will be included when the query runs.

When you open or run a query, a recordset appears. A recordset contains all the fields and records that meet the conditions of the query. Although the recordset is not a table, it can be used to edit or add new records in the queried tables.

USING THE SIMPLE QUERY WIZARD

Discussion

The Simple Query Wizard guides you through the steps for creating a basic select query. When you use the Simple Query Wizard, you select the table you want to use and the fields you want the query to display. Then, you name the query and choose whether to display the results of the query (recordset) or go to Design view to work with the query design.
Procedures

1. Display the Create tab on the Ribbon.

2. Select the Query Wizard button on the Create tab.


4. Select OK

5. Select the arrow next to the Tables/Queries list.

6. Select the table or query you want to query.

7. Select the first field you want to add to the query from the Available Fields list box.

8. Select the arrow to the right of the Available Fields list box.

9. Add other fields to the Selected Fields list box, as desired.

10. Select Next >
11. Type the desired query name.

12. Select Finish.

**Step-by-Step**

From the Student Data directory, open `QUERY1.ACCDB`. Use the Simple Query Wizard to display selected fields in a table.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the <strong>Create</strong> tab on the <strong>Ribbon</strong>. The <strong>Create</strong> tab appears.</td>
<td>Click Create</td>
</tr>
<tr>
<td>2. Select the <strong>Query Wizard</strong> button in the <strong>Other</strong> group of the <strong>Create Ribbon</strong>. The <strong>New Query</strong> dialog box opens.</td>
<td>![Query Wizard]</td>
</tr>
<tr>
<td>3. Select <strong>Simple Query Wizard</strong>. <strong>Simple Query Wizard</strong> is selected.</td>
<td>Click <strong>Simple Query Wizard</strong></td>
</tr>
<tr>
<td>4. Select <strong>OK</strong>. The <strong>New Query</strong> dialog box closes, and the <strong>Simple Query Wizard</strong> opens.</td>
<td>Click <strong>OK</strong></td>
</tr>
<tr>
<td>5. Select the arrow in the <strong>Tables/Queries</strong> list. A list of available tables and queries appears.</td>
<td>Click</td>
</tr>
<tr>
<td>6. Select the table or query you want to query. <em>All available fields in the selected table or query appear in the <strong>Available Fields</strong> list box.</em></td>
<td>Click <strong>Table: Customers</strong></td>
</tr>
<tr>
<td>7. Select the first field you want to add to the query from the <strong>Available Fields</strong> list box. <em>The field is selected.</em></td>
<td>Click <strong>Store Name</strong></td>
</tr>
<tr>
<td>8. Select the arrow to the right of the <strong>Available Fields</strong> list box. <em>The field moves to the <strong>Selected Fields</strong> list box.</em></td>
<td>Click &gt;</td>
</tr>
</tbody>
</table>
Steps | Practice Data
--- | ---
9. Add other fields to the **Selected Fields** list box, as desired. The fields move to the **Selected Fields** list box. | Follow the instructions below the table before continuing on to the next step
10. Select Next >. The next page of the Simple Query Wizard appears with the text in the **What title do you want for your query?** box selected. | Click ![Next >](image)
11. Type the desired query name. The name appears in the **What title do you want for your query?** box. | Type **Contacts and Phone Numbers**
12. Select Finish. The Simple Query Wizard closes, the query runs, and the recordset appears in **Datasheet** view. | Click ![Finish](image)

Add the **Customer Number**, **Contact Name**, and **Phone Number** fields to the query.

*Return to the table and continue on to the next step (step 10).*

Close the query. Notice that the **Contacts and Phone Numbers** query now appears in the **Queries** object list.

---

**CREATING A QUERY IN DESIGN VIEW**

**Discussion**

You can create a query in **Design** view. This option gives you the most flexibility in designing a query. It allows you to add criteria for selecting records, as well as sort the recordset.

When you create a query in **Design** view, the design grid is used to set up the query. The field lists of all tables to be used in the query appear in the top pane. The design grid appears in the bottom pane. You drag the fields you want to use in the query to the design grid and then add the desired criteria and sorts.

You can also add a field to a query by clicking in any blank column in the **Field** row, clicking the drop-down arrow, and then selecting the field you want to add; or by dragging the field to the design grid.
You can add all the fields to the design grid by dragging the asterisk (*) at the top of the field list to the Field row in any column.

Procedures

1. Select the Create tab on the Ribbon.

2. Click the Query Design button on the Create tab.

3. Add the table you want to query.

4. Select Close

5. Add the desired fields to the query.

6. Click the Save button on the Quick Access Toolbar.

7. Type the desired query name.

8. Select OK

Step-by-Step

Create a query in Design view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the Create tab on the Ribbon toolbar. The Create tab appears.</td>
<td>Click Create</td>
</tr>
<tr>
<td>2. Click the Query Design button from the Other group. A new query opens in Design view, with the Show Table dialog box open.</td>
<td>Click</td>
</tr>
<tr>
<td>3. Add the table you want to query. The table field list appears in the top pane of Design view.</td>
<td>Double-click Customers</td>
</tr>
</tbody>
</table>
Steps | Practice Data
--- | ---
4. Select Close. The Show Table dialog box closes. | Click Close
5. Add the first field to the query. The field appears in the design grid. | Double-click **Customer Number** in the field list
6. Add other fields to the query as desired. The fields appear in the design grid. | Follow the instructions shown below the table before continuing on to the next step
7. Click the **Save** button on the **Quick Access Toolbar**. The Save As dialog box opens with the text in the **Query Name** box selected. | Click
8. Type the desired query name. The name appears in the **Query Name** box. | Type **Customer Query**
9. Select OK. The Save As dialog box closes, and the query is saved. | Click OK

Add the **Store Name**, **Sales Rep**, **Region**, and **Credit Limit** fields to the query.

*Return to the table and continue on to the next step (step 7).*

Close the query. Notice that the **Customer Query** query now appears in the **Queries** object list.

### OPENING A QUERY

#### Discussion

When you open a query, Access runs the query and displays its recordset in **Datasheet** view. If you have added records since the last time you ran the query, the new records will appear as long as they meet the query criteria.

#### Procedures

1. Select **All Access Objects** in the Navigation Pane.
2. Double-click the name of the query you want to run.
Step-by-Step

Open a query in **Datasheet** view.

If necessary, display **All Access Objects** in the Navigation Pane. If the **Customer Query** query does not exist, use the **Customer Query 2** query.

<table>
<thead>
<tr>
<th><strong>Steps</strong></th>
<th><strong>Practice Data</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Double-click the name of the query you want to run. The query runs, and its recordset appears in <strong>Datasheet</strong> view.</td>
<td>Double-click <strong>Customer Query</strong></td>
</tr>
</tbody>
</table>

Close the recordset.

---

**ADDING A TABLE TO A QUERY**

**Discussion**

You can use more than one table in a query. The tables must be joined, however, in order for the query to produce accurate results. If the tables are not yet joined, you can create a join in the top pane of **Design** view.

The field lists of all tables added to a query appear in the top pane of **Design** view. If the tables are already related, join lines appear as well.

Once you have added a table to a query, you can then add fields from its field list to the design grid. The **Table** row in the design grid indicates the table in which a field is stored.

When you create a new query in **Design** view, the Show Table dialog box opens automatically so that you can add the desired tables. However, when you modify an existing query in **Design** view, you must manually open the Show Table dialog box.

**Procedures**

1. Select **All Access Objects** in the Navigation Pane.
2. Open the query you want to edit.
3. Select the **Design view** button on the **Ribbon**.

4. Click the **Show Table** button on **Design** tab on the **Ribbon**.

5. Double-click the table you want to add to the query.

6. Select [Close]

---

**Step-by-Step**

Add a table to a query.

If necessary, display **All Access Objects** in the Navigation Pane. If the **Customer Query** query does not exist, use the **Customer Query 2** query.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open the query you want to edit.</td>
<td>Double-click <strong>Customer Query</strong>, if necessary</td>
</tr>
<tr>
<td><em>The query is selected.</em></td>
<td></td>
</tr>
<tr>
<td>2. Select the <strong>Design view</strong> button on the <strong>Ribbon</strong>.</td>
<td>Click</td>
</tr>
<tr>
<td><em>The query opens in <strong>Design view</strong>.</em></td>
<td>Click [Show Table]</td>
</tr>
<tr>
<td>3. Click the <strong>Show Table</strong> button on the <strong>Design</strong> tab.</td>
<td>Double-click <strong>Orders</strong></td>
</tr>
<tr>
<td><em>The Show Table dialog box opens.</em></td>
<td>Double-click [Close]</td>
</tr>
<tr>
<td>4. Double-click the table you want to add to the query.</td>
<td><em>The table field list is added to the query.</em></td>
</tr>
<tr>
<td>5. Select <strong>Close</strong>.</td>
<td><em>The Show Table dialog box closes.</em></td>
</tr>
</tbody>
</table>

Add the **Order Number** and **Order Date** fields from the **Orders** field list to the query. You may have to scroll the design grid to display additional columns in the **Field** row. Save and Close the Query.
JOINING TABLES IN A QUERY

Discussion

If you have multiple tables in a query, the tables must be joined in order for the query to produce accurate and meaningful results. Otherwise, Access will not know which records are associated with which, so every possible combination of records would appear in the recordset. For example, if one table has 20 records and the other has 5, then the recordset will contain 100 records and the results are virtually meaningless.

If table relationships have already been defined, the join lines appear automatically in Design view. In addition, Access will automatically create a join if there are fields with the same name in multiple tables. If Access cannot define the relationships between query tables, you must create them.

The join type defined in the relationship is particularly important in queries. The default type is an inner join, in which records are only included in the recordset if there is matching data in the join fields of both tables. You can also create an outer join, in which all the records from the “one” table appear, even if there is no matching data in the “many” table.

Joining tables in a query

Joins that you define in a query do not appear in the Relationships window.

You can remove a join line from a query by selecting it and then pressing the [Delete] key. You must remove referential integrity before deleting a join.
Procedures

1. Open the desired query in **Design** view.
2. Add a new table to the query, if necessary.
3. Drag the desired join field from one field list to the matching field in a second field list.
4. Double-click the middle segment of the join line.
5. Select the desired join type.
6. Select OK.

Step-by-Step
Join tables in a query.

If necessary, open the **Customer Query** query in **Design** view. If the **Customer Query** query does not exist, use the **Customer Query 3** query.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Drag the desired join field from one field list to the matching field in a second field list. <em>A join line appears between the joined fields when you release the mouse button.</em></td>
<td>Scroll as necessary, and drag the <strong>Customer Number</strong> field in the <strong>Customers</strong> table to the <strong>Customer ID</strong> field in the <strong>Orders</strong> table.</td>
</tr>
<tr>
<td>2. Double-click the middle segment of the join line. <em>The Join Properties dialog box opens.</em></td>
<td>Double-click the middle segment of the join line.</td>
</tr>
<tr>
<td>3. Select the desired join type. <em>The join type is selected.</em></td>
<td>Click 2</td>
</tr>
<tr>
<td>4. Select <strong>OK.</strong> <em>The Join Properties dialog box closes.</em></td>
<td>Click OK</td>
</tr>
</tbody>
</table>

Save and Close the Query.
RUNNING A QUERY

Discussion

You can run a query and display its recordset directly from Design view. This option is useful for testing the query design to see if its recordset contains the desired information.

Running a query does not save the query design. If you close the recordset after running a query, you are prompted to save the changes.

Procedures

1. Open a query in Design view.

2. Click the Run button on the Design tab.

Step-by-Step

Run a query to test its design.

If necessary, open the Customer Query query in Design view. If the Customer Query query does not exist, use the Customer Query 4 query.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click the Run button on the Query Design toolbar. The query runs and its recordset appears in Datasheet view.</td>
<td>Click Run</td>
</tr>
</tbody>
</table>

Click the View button on the Ribbon to switch back to Design view.

Close the query and save the changes, if necessary.
Close QUERY1.ACCDB.
EXERCISE

USING SIMPLE QUERIES

Task

Use simple queries.

1. Open **Query1x.accdb**.
2. Use the Simple Query Wizard to create a query.
3. Select the Client table and add the Client ID, Name, and Phone No fields.
4. Name the query Client Names and view its recordset. Then, close the Client Names query.
5. Create a query in Design view.
6. Add the Client table to the query. Then add the Client ID and Name fields to the design grid.
7. Save the query as Client Query and then close it.
8. Open the Client Query query to view its recordset. Then, view the Client Query in Design view.
9. Add the Project table to the Client Query query; notice that a join line appears automatically.
10. Change the join type so that the query displays all the records from the Client table and only the matching ones from the Project table.
11. Add the Project ID, Course Name, Start Date, and Cost fields from the Project field list to the query.
12. Run the query from Design view.
13. Close the Client Query query and save the changes.
LESSON 9 - MODIFYING QUERY RESULTS

In this lesson, you will learn how to:

- Sort a query
- Add criteria to a query
- Hide a field in a query
- Display a Totals Row in a query
- Add a record using a query
- Print a query
SORTING A QUERY

Discussion

When you run a query, the records in the recordset appear in the same order in which they appear in the design grid. You can either sort the recordset or assign a sort order in the query design. You can sort a recordset just as you would sort a table; however, you would have to perform the sort every time you run the query. If you assign a sort order in the query design, Access will sort the recordset automatically each time you run the query.

You can sort on more than one field. For example, you can sort by region and then by states within each region. To sort on more than one field, the first sort field must be to the left of the second sort field in the query design grid, since Access sorts from left to right.

![Adding a sort order to the design grid](image)

Procedures

1. Open a query in Design view.
2. Select the Sort row for the field by which you want to sort.
3. Select the Sort list.
4. Select the desired sort option.
**Step-by-Step**

From the Student Data directory, open QUER Y2.ACCDB.
Sort a query.

Display All Access Objects in the Navigation Pane and open the Customer Query query in Design view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the Sort row in the field by which you want to sort.</td>
<td>Click in the Sort row under Store Name</td>
</tr>
<tr>
<td>The insertion point and a drop-down arrow appear in the Sort field.</td>
<td></td>
</tr>
<tr>
<td>2. Select the Sort list. A list of available sort options appears.</td>
<td>Click Sort</td>
</tr>
<tr>
<td>3. Select the desired sort option. The sort option appears in the Sort row in the design grid.</td>
<td>Click Ascending</td>
</tr>
</tbody>
</table>

Run the query. Notice that the recordset is sorted in ascending order by the Store Name field. Close the recordset and save the changes.

**Practice the Concept:** Open the Customers table in Datasheet view. Click the New Record button on the Table Datasheet toolbar and create a new record by adding data only in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Number</td>
<td>1025</td>
</tr>
<tr>
<td>Store Name</td>
<td>Acme Sports</td>
</tr>
<tr>
<td>Region</td>
<td>Northeast</td>
</tr>
<tr>
<td>Sales Rep</td>
<td>SJS</td>
</tr>
<tr>
<td>Credit Limit</td>
<td>2500</td>
</tr>
<tr>
<td>Contact Date</td>
<td>3/17</td>
</tr>
</tbody>
</table>

Close the Customers table and run the Customer Query query. Notice that the new record appears in the recordset and is sorted in the correct order. Notice also that there is a blank field under the Order Number field. Although there is no order for this customer, the outer join between the related tables allows the record to appear.

Switch to Design view. Double-click the middle segment of the join line, change the join type to an inner join by selecting the 1 option, and select OK. Run the query again; notice that the Acme Sports record does not appear when the tables are joined with an inner join.
Close the recordset and save the changes.

**Adding Criteria to a Query**

### Discussion

You can use the **Criteria** row in the design grid to restrict the number of records a query returns.

To select records that match a single value, you can enter the value you want to match in the **Criteria** row of the applicable field. Access automatically inserts quotation marks (" ") around alphanumeric entries and number symbols (#) around date entries; nothing appears around numeric entries. When you run the query, only those records with values that match the criteria appear in the recordset.

![Adding criteria to a query](image)

---

**Procedures**

1. Open a query in **Design** view.
2. Select the **Criteria** row for the field you want to match.

---

---
3. Type the value you want to match.
4. Press [Enter].

**Step-by-Step**

Add criteria to a query to select specific records.

If necessary, display All Access Objects in the Navigation Pane.

Open the Customer Query 5 query in Design view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the Criteria row for the field you want to match. <em>The insertion point appears in the Criteria field.</em></td>
<td>Click in the Criteria row under Region</td>
</tr>
<tr>
<td>2. Type the value you want to match. <em>The text appears in the Criteria row in the design grid.</em></td>
<td>Type Southeast</td>
</tr>
<tr>
<td>3. Press [Enter]. <em>The criterion is entered and Access inserts the appropriate characters or symbols around it.</em></td>
<td>Press [Enter]</td>
</tr>
</tbody>
</table>

Run the query. Notice that only records in the Southeast region appear in the recordset.

**Practice the Concept:** Switch to Design view. Delete the “Southeast” criteria under the Region field and select the Criteria row under the Order Date field. Enter the criteria 5/5/03. Press [Enter]. Notice that Access inserts number symbols around the date value. Run the query and scroll as necessary to view the Order Date column. Notice that only records with a 5/5/03 date appear in the recordset.

Switch to Design view and delete the criteria in the Order Date field. Click in the Criteria row under the Credit Limit field. Type 5000 and press [Enter]. Notice that Access does not insert any symbols around a numeric value. Run the query. Notice that only records with a 5000 credit limit appear in the recordset.

Close the recordset and save the changes.
HIDING A FIELD IN A QUERY

Discussion

You can select records that meet specified field criteria without displaying the field in the recordset. This option is useful when all the records meet the same specified criteria and, as a result, the field does not need to appear.

For example, you may create a query to display customers in the Southeast region. The Region field must be added to the query with a criterion of Southeast; since all the data in the Region field would be the same (Southeast), the Region field does not need to appear in the recordset. In this case, you can hide the Region field.

The design grid provides a Show row for each field. If the Show option is selected, the field will appear in the recordset; if it is deselected, the field will not appear in the recordset. The Show option is selected by default.

Procedures

1. Open a query in Design view.
2. Deselect the Show option in the field you want to hide.

Step-by-Step

Hide a query field.

If necessary, display All Access Objects in the Navigation Pane.

Open the Customer Query 6 query in Design view.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Deselect the Show option in the field you want to hide. <em>The Show option is deselected.</em></td>
<td>Scroll as necessary and click ☑ in the Show row under Credit Limit to deselect it</td>
</tr>
</tbody>
</table>

Run the query. Notice that the Credit Limit field does not appear in the recordset. Close the query and save the changes.
Discussion

You can now perform calculations in a query using aggregate functions, such as displaying a totals row. Access queries support the aggregate functions shown in the following table:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sum</td>
<td>Calculates the total of the values in a field.</td>
</tr>
<tr>
<td>Avg</td>
<td>Calculates the average of the values in a field.</td>
</tr>
<tr>
<td>Count</td>
<td>Calculates the number of values in a field, not counting Null (blank) values.</td>
</tr>
<tr>
<td>Min</td>
<td>Calculates the lowest value in a field.</td>
</tr>
<tr>
<td>Max</td>
<td>Calculates the highest value in a field.</td>
</tr>
<tr>
<td>StDev</td>
<td>Calculates the standard deviation of the values in a field.</td>
</tr>
<tr>
<td>Var</td>
<td>Calculates the variance of the values in a field.</td>
</tr>
</tbody>
</table>

A Totals Row in a query

Procedures

1. Open the desired query in Datasheet view.
2. Select the **Home** tab on the **Ribbon**, if necessary.

3. Select the **Totals** button in the **Records** group.

4. In the totals row, select the field you want to total.

5. Select the arrow.

6. Select the desired function.

---

**Step-by-Step**

Display a totals row in a query.

Open the **Customer Query** in **Datasheet** view.

<table>
<thead>
<tr>
<th><strong>Steps</strong></th>
<th><strong>Practice Data</strong></th>
</tr>
</thead>
</table>
| 1. Select the **Home** tab on the **Ribbon**, if necessary.  
*The Home tab appears.* | Click **Home** |
| 2. Select the **Totals** button in the **Records** group.  
*The Show Tables dialog box appears.* | Click **ΣTotals** |
| 3. In the totals row, select the field you want to total.  
*The arrow appears.* | Click in the **Order Number** field |
| 4. Select the arrow.  
*The aggregate function list appears.* | Click **▼** |
| 5. Select the desired function.  
*Access displays the desired aggregate function result.* | Click **Count** |

Notice if you click the **Totals** button again, the Totals Row is removed from the query.

---

**ADDING A RECORD USING A QUERY**

**Discussion**

You can use a query to update records in related tables. When you enter data into a query recordset, Access automatically completes the recordset data, as applicable, and
enters the data into the related tables as well. For example, if you run a query using the related Orders and Customers tables and you enter a new order into the recordset, Access automatically completes the customer information in the recordset and enters the data into the Orders table as well.

You can always edit information in queries based on a single table. In queries based on related tables, Access must be able to determine the relationship type in order for you to be able to edit information. In queries based on a one-to-one relationship, you can always edit the data. In queries based on a one-to-many relationship, you may not always be able to edit the data. For instance, this can happen if the join field from the “many” table is not included in the query. For example, you cannot add a new customer order to a query recordset based on the related Customers and Orders tables unless the join field (Customer ID) in the Orders table is included in the query.

You can use help to get more information about using a query to update data in tables having a one-to-many relationship.

Procedures

1. Open a query in Datasheet view.
2. Click the New Record button on the Query Datasheet toolbar.
3. Type the desired data into the first field.
4. Select the next field.
5. Enter data into each of the remaining fields, as desired.
6. Press [Enter].

Step-by-Step

Add a record to related tables using a query.

Display All Access Objects in the Navigation Pane. Open the Items table in Datasheet view; notice that product 12-1687 has a product description of ball, soccer and a unit price of 16.43. Close the Items table.

Open the Line Item query in Datasheet view.
**Steps** | **Practice Data**
---|---
1. Click the **New Record** button on the **QueryDatasheet** toolbar. 
*The insertion point appears in a blank row at the end of the datasheet.* | Click ![image]

2. Type the desired data into the first field. 
*The data appears in the field.* | **Type 1820**

3. Select the next field. 
*The insertion point moves to the next field.* | Press **[Enter]**

4. Enter data into each of the remaining fields, as desired. 
*The data appears in the applicable fields.* | Follow the instructions shown below the table

Type **12-1687** into the **Product ID** field and **10** into the **Quantity** field, pressing **[Enter]** after each entry.

Close the query. Open the **Line Items** table in **Datasheet** view and scroll as necessary to order number **1820** to verify that the data was entered. Then, close the **Line Items** table.

---

**PRINTING A QUERY**

**Discussion**

You can print a query recordset. You can run the query and then print the recordset, or you can save time by printing the recordset directly from the Navigation Pane. If you print the recordset from the Database window, Access runs the query and sends the results directly to the printer, rather than to the screen.

**Procedures**

1. Display **All Access Objects** in the Navigation Pane.

2. Select the query you want to print.

3. Select the **Office** button ![image]
4. Select the Print button.

5. Select OK.

**Step-by-Step**

Print a query from the Navigation pane.

Display All Access Objects in the Navigation Pane, if necessary.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the query you want to print. The query is selected.</td>
<td>Click <strong>Customer Query 7</strong></td>
</tr>
<tr>
<td>2. Select the Office button. The Office menu appears.</td>
<td>Click</td>
</tr>
<tr>
<td>3. Select the Print button. The Print dialog box appears.</td>
<td>Click</td>
</tr>
<tr>
<td>4. Select OK. Access runs the query and prints the recordset.</td>
<td>Click OK</td>
</tr>
</tbody>
</table>

Close **QUERY2.ACCDB**.
EXERCISE

MODIFYING QUERY RESULTS

Task

Modify query results.

1. Open **Query2x.accdb**.

2. Open the **Project** table in **Datasheet** view. Scroll to the last record; notice that it has a **Project ID** of **1024**, for a **Client ID** of **WENDT**. Close the **Project** table.

3. Open the **Client Query** query in **Design** view.

4. Sort the query in ascending order by the **Project ID** field. Then, run the query.

5. Add a new record to the recordset, using the following data:

<table>
<thead>
<tr>
<th>Field</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client ID</td>
<td>ABEL</td>
</tr>
<tr>
<td>Project ID</td>
<td>1025</td>
</tr>
<tr>
<td>Course Name</td>
<td>INTMA22</td>
</tr>
<tr>
<td>Start Date</td>
<td>6/19</td>
</tr>
<tr>
<td>End Date</td>
<td>6/19</td>
</tr>
<tr>
<td>Cost</td>
<td>100</td>
</tr>
<tr>
<td>Trainer Initials</td>
<td>EK</td>
</tr>
</tbody>
</table>

6. Close the query and save the changes.

7. Open the **Project** table in **Datasheet** view. Scroll to the last record; notice the new **ABEL** record. Then, close the **Project** table.

8. Open the **Client Query** query in **Datasheet** view.

9. Add a totals row to the **Cost** field show to show the average. Save and Close the Query. Then, run the query.

10. Hide the **Cost** field and run the query again. Then, close the **Client Query** query without saving the changes.

11. Print the **Client Query** recordset from the Database window.

In this lesson, you will learn how to:

- Analyze a table
- Use relationships in splits
- Use the Table Analyzer Wizard
- Use the Performance Analyzer
ANALYZING A TABLE

Discussion

When you create or analyze a table, you should look at its structure to determine the efficiency of its design. If the same information appears in multiple records, the table can probably be split into two related tables. Splitting a table is more efficient because the tables are then smaller and, as a result, easier to manage. In addition, information will only need to be entered one time. Smaller tables also reduce the chance of making data entry errors.

If you feel that a table may need to be split, you can use the Table Analyzer Wizard to analyze it for you and suggest which fields should be in each table. The Table Analyzer Wizard can also create the correct table relationships.

USING RELATIONSHIPS IN SPLITS

Discussion

When the Table Analyzer Wizard splits a table, it creates the necessary relationships in the resulting tables. These relationships allow data from all the tables to be used in queries, forms, and reports.

Access provides three types of relationships: one-to-one, one-to-many and many-to-many. When a table is split, a one-to-many relationship is usually created. This relationship allows one record in the first table to be related to many records in the other related tables, eliminating data duplication.

USING THE TABLE ANALYZER WIZARD

Discussion

The Table Analyzer Wizard looks at a table to determine if it contains duplicated information. If the Table Analyzer Wizard determines that a table has a lot of duplicated data, it splits the table, creating new tables and leaving the original table intact.

The Table Analyzer Wizard has seven pages. The first two pages are informational, with the first page describing the problem of duplicate data in the table and the second describing the solution. You can choose not to display these pages.
You then select the table you want to analyze. On subsequent pages, you indicate whether you want the wizard to decide how to split the table or whether you want to do it yourself. If you allow the wizard to split the table, the recommended tables and the relationships between them appear. You can then move fields between tables or even drag fields to create new tables. Each piece of information should be stored in only one location, and each table should contain only data that refers to a single subject.

Once the fields have been put into the correct tables, you can set the primary keys. In order to be related properly, each table must have a primary key, and the primary key must be a field that uniquely identifies each record. Therefore, a primary key field cannot contain duplicate data. Access will generate unique fields, if necessary.

On the last page, you can allow the Table Analyzer Wizard to create a query. The query will be given the same name as the old table and the old table will be renamed. As a result, any reports, forms, or queries that refer to the old table can still be used.

The Table Analyzer Wizard

Procedures

1. Click the Analyze Table button on the Database Tools tab.
2. Select
3. Select
4. Select the table you want to analyze.
5. Select Next >

6. Select whether or not you want to allow the Table Analyzer Wizard to decide which fields are put in each table.

7. Select Next >

8. Double-click the title bar of the first table.

9. Type the desired table name.

10. Select OK

11. Double-click the title bar of the second table.

12. Type the desired table name.

13. Select OK

14. Select Next >

15. Select the field you want to set as a primary key.

16. Click the Set Unique Identifier button at the top of the Table Analyzer Wizard window.

17. Select Next >

18. Select whether or not you want the Table Analyzer Wizard to create a query for you.

19. Select Finish

20. Close the Microsoft Access Help window, if necessary.

---

**Step-by-Step**

From the Student Data directory, open ANALYZE.ACCDB. Use the Table Analyzer Wizard.

If necessary, display All Access Objects in the Navigation Pane.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click the Analyze Table button on the Database Tools tab. The Table Analyzer Wizard opens.</td>
<td>Click Analyze Table</td>
</tr>
<tr>
<td>Steps</td>
<td>Practice Data</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td>2. Select Next &gt;. The next page of the Table Analyzer Wizard appears.</td>
<td>Click Next &gt;</td>
</tr>
<tr>
<td>3. Select Next &gt;. The next page of the Table Analyzer Wizard appears.</td>
<td>Click Next &gt;</td>
</tr>
<tr>
<td>4. Select the table you want to analyze. The table name is selected.</td>
<td>Click Order Items</td>
</tr>
<tr>
<td>5. Select Next &gt;. The next page of the Table Analyzer Wizard appears.</td>
<td>Click Next &gt;</td>
</tr>
<tr>
<td>6. Select whether or not you want to allow the Table Analyzer Wizard to decide which fields are put in each table. The option is selected.</td>
<td>Click Yes, let the wizard decide., if necessary</td>
</tr>
<tr>
<td>7. Select Next &gt;. The next page of the Table Analyzer Wizard appears.</td>
<td>Click Next &gt;</td>
</tr>
<tr>
<td>8. Double-click the title bar of the first table. A Table Analyzer Wizard dialog box opens with the text in the Table Name box selected.</td>
<td>Double-click the Table1 title bar</td>
</tr>
<tr>
<td>9. Type the desired table name. The name appears in the Table Name box.</td>
<td>Type Line Items</td>
</tr>
<tr>
<td>10. Select OK. The Table Analyzer Wizard dialog box closes, and the new name appears in the table title bar.</td>
<td>Click OK</td>
</tr>
<tr>
<td>11. Double-click the title bar of the second table. A Table Analyzer Wizard dialog box opens with the text in the Table Name box selected.</td>
<td>Double-click the Table2 title bar</td>
</tr>
<tr>
<td>12. Type the desired table name. The name appears in the Table Name box.</td>
<td>Type Items</td>
</tr>
</tbody>
</table>
Steps | Practice Data
--- | ---
13. Select **OK**.  
*The Table Analyzer Wizard dialog box closes, and the new name appears in the table title bar.* | Click **OK**

15. Select **Next >**.  
*The next page of the Table Analyzer Wizard appears.* | Click **Next >**

16. Select the field you want to set as a primary key.  
*The field is selected.* | Click **Product ID** in the **Items** table, if necessary

17. Click the **Set Unique Identifier** button at the top of the Table Analyzer Wizard window.  
*A key symbol appears to the left of the selected field.* | Click **Set Unique Identifier**

18. Select **Next >**.  
*The next page of the Table Analyzer Wizard appears.* | Click **Next >**

19. Select whether or not you want the Table Analyzer Wizard to create a query for you.  
*The option is selected.* | Click **Yes, create the query.**

20. Select **Finish**.  
*The Table Analyzer Wizard closes, the new tables and query are created, the old table is renamed, and a Microsoft Office Access Help window opens.* | Click **Finish**

21. Close the Microsoft Office Access Help window, if necessary.  
*The Microsoft Office Access Help window closes.* | Click **X** on the Microsoft Office Access Help window title bar

Close all open objects.

**USING THE PERFORMANCE ANALYZER**

**Discussion**

The Performance Analyzer analyzes the efficiency of your database in order to optimize its performance.
The Performance Analyzer window contains a page for each available object type in Access, as well as a **Current Database** page and an **All Object Types** page. The **Current Database** page allows you to analyze features that are not objects, such as relationships. You can analyze a single object or multiple objects on different pages. If you are analyzing different types of objects, the **All Object Types** page allows you to view all database objects in one location.

The results of the performance analysis appear in the **Analysis Results** box. The results are categorized as a **Recommendation**, a **Suggestion**, or an **Idea**. The **Analysis Notes** box provides additional information about the selected result. You can use the **Optimize** button to have Access perform the action suggested in a **Recommendation** or **Suggestion**; you must manually perform the action for an **Idea**.

![Performance Analyzer results]

After you have selected the **Optimize** button, the Performance Analyzer marks the action as **Fixed**.

You can use the **Select All** button to select all the results in the **Analysis Results** box.

### Procedures

1. Click the **Analyze Performance** button on the **Database Tools** tab.
2. Select the tab containing the objects you want to analyze.
3. Select the objects you want to optimize.
4. Select **OK**
5. To view an explanation, click any result in the **Analysis Results** box.

Step-by-Step

Use the Performance Analyzer to analyze the efficiency of a database.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click the <strong>Analyze Performance</strong> button on the <strong>Database Tools</strong> tab. The Performance Analyzer opens.</td>
<td>Click <img src="image" alt="Analyze Performance" /></td>
</tr>
<tr>
<td>2. Select the tab containing the objects you want to analyze. The corresponding object types page appears.</td>
<td>Click the <strong>All Object Types</strong> tab</td>
</tr>
<tr>
<td>3. Select the object you want to optimize. The object is selected.</td>
<td>Click <strong>Customers</strong></td>
</tr>
<tr>
<td>4. Select additional objects as desired. The objects are selected.</td>
<td>Click <strong>Orders</strong></td>
</tr>
<tr>
<td>5. Select <strong>OK</strong>. The Performance Analyzer displays its recommendations in the <strong>Analysis Results</strong> box.</td>
<td>Click <strong>OK</strong></td>
</tr>
<tr>
<td>6. To view an explanation, click any result in the <strong>Analysis Results</strong> box. An explanation of the selected recommendation appears in the <strong>Analysis Notes</strong> box.</td>
<td>Click <strong>Table ‘Orders’</strong>:</td>
</tr>
<tr>
<td>7. Select <strong>Close</strong>. The Performance Analyzer closes.</td>
<td>Click Close</td>
</tr>
</tbody>
</table>

Display Tables in the Navigation Pane, if necessary, and open the Customers table in Design view. Change the data type for the Customer Number field to Long Integer and close and save the Customers table. Open the Orders table in Design view. Change the data type for the Customer ID field to Long Integer. Then, close and save the Orders table.

**Practice the Concept:** Open the Performance Analyzer, select all objects on the Tables page, and run the Performance Analyzer. Notice that the Performance Analyzer now has no suggestions for the selected objects. Select **OK** to close the Performance Analyzer message box. Close ANALYZE.ACCDB.
EXERCISE

ANALYZING TABLES

Task

Analyze tables.

1. Open Analyzex.accdb.

2. Open the Table Analyzer Wizard. Select Next as needed and then select the Project List table. Select Next.

3. Allow the wizard to decide how to split the table.

4. Rename Table1 to Project and Table2 to Client.

5. Drag the State field from the Project field list below the City field in the Client field list.

6. Set the Client ID field as the primary key in the Client table.

7. Have the Table Analyzer Wizard create a query.

8. Select Finish.

9. Close the Microsoft Office Access Help window. View the tables and then close them and restore the Database window.

10. Analyze the performance of the Client and Payment tables. (Notice that the analysis result does not fit the data; changing the Zip field to a long integer field would not allow for zip codes with leading zeroes, such as 08054.)

11. Close the Performance Analyzer.

LESSON 11 - CREATING BASIC FORMS

In this lesson, you will learn how to:

- Use forms
- Use the Form button
- Add a record using a form
- Use the Calendar for Date Picking
- Use the Form Wizard
- View records in a form
- Print records in a form
- Base a form on a query
USING FORMS

Discussion

Forms, like datasheets, can be used for viewing and editing data. However, they can also be used to present data in a more attractive format. Forms are usually designed to display all the fields for a single record within the form window, eliminating the need to scroll. You can also display data from related tables in one form.

Access provides six basic types of forms: columnar, tabular, datasheet, justified, PivotTable, and PivotChart. In a columnar form, the field names are listed on the left side of the form and the field values appear in a column on the right. If space permits, there can be more than one column.

In a tabular form, the field names are listed across the top of the form and the values appear in the corresponding columns beneath them. A datasheet form appears similar to Datasheet view. Both the tabular and datasheet forms display data in a table layout.

In a justified form, the field names and values appear in alternate rows, evenly spaced across the page. Field values appear under the corresponding field names.

A PivotTable form allows you to quickly create a form by dragging fields as desired in PivotTable view. Similar to a PivotTable form, a PivotChart form allows you to create a chart or graph by dragging fields as desired in PivotChart view.

USING THE FORM BUTTON

Discussion

The fastest way to create a form is to use the Form button on the Create tab. The Form button automatically creates a simple form from the selected table or query, without needing any input. However, you must select a table or query before AutoForm can create the form. All fields in the table or query will appear on the form, and the title of the form is the name of the table or query.

The form is not saved automatically. When you close the form for the first time, Access prompts you to save it.

The Form button creates a form using the defaults for the selected form type. After the form has been created its formatting can be modified in Design view.
Procedures

1. Select the table on which you want to base your form.

2. Select the Form button on the Create tab.

Step-by-Step

From the Student Data directory, open FORMS1.ACCDB. Use the Form button to create a form.

If necessary, display All Access Objects in the Navigation Pane.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the table or query in the Navigation Pane on which you want to base your form. The object is selected.</td>
<td>Click the Orders table.</td>
</tr>
<tr>
<td>2. Select the Form button on the Create tab. The new form opens in Form view.</td>
<td>Click Form.</td>
</tr>
</tbody>
</table>

View the form. Then, close the form, saving it as Orders.

ADDDING A RECORD USING A FORM

Discussion

Forms are frequently used to add records to one or more tables. It can be easier to work in a well-designed form than in the underlying table because forms are usually designed to display all the fields for a single record within the form window, eliminating the need to scroll.

You can use the [Enter] key to move between fields as you enter data. If you want to skip one or more fields, you can press the [Tab] key until the insertion point appears in the desired field, or you can click in the field in which you want to enter data. When you press the [Enter] key after entering data in the last field in a record, Access automatically saves the record and displays a blank form for entering another record.
You can use the [Shift+Tab] key combination to move to the previous field.

You can also use the New Record button on the Form View toolbar to add a record to a form.

Procedures

1. Display All Access Objects in the Navigation Pane.
2. Open the desired form in Form view.
3. Click the New Record button at the bottom of the form window.
4. Type the desired data into the first field of the new record.
5. Press [Enter].
6. Enter additional data into the remaining fields as desired.

Step-by-Step

Add a record using a form.

Open the Orders form in Form view. If the Orders form does not exist, use the Orders 2 form.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click the New Record button at the bottom of the form window.</td>
<td>Click [image]</td>
</tr>
<tr>
<td>The insertion point appears in the first field of the new record.</td>
<td></td>
</tr>
<tr>
<td>2. Type the desired data into the first field of the new record.</td>
<td>Type 2000</td>
</tr>
<tr>
<td>The data appears in the field.</td>
<td></td>
</tr>
<tr>
<td>3. Press [Enter].</td>
<td>Press [Enter]</td>
</tr>
<tr>
<td>The insertion point moves to the next field.</td>
<td></td>
</tr>
</tbody>
</table>
Enter the following data in the corresponding fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Field Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer ID</td>
<td>5995</td>
</tr>
<tr>
<td>Sales Rep</td>
<td>FLW</td>
</tr>
<tr>
<td>Order Date</td>
<td>(today’s date)</td>
</tr>
<tr>
<td>Shipping Date</td>
<td>(three days from today)</td>
</tr>
<tr>
<td>Shipping Method</td>
<td>UPS</td>
</tr>
<tr>
<td>Shipping Cost</td>
<td>12</td>
</tr>
<tr>
<td>Terms</td>
<td>FOB</td>
</tr>
<tr>
<td>Full Name</td>
<td>Frances Wallace</td>
</tr>
</tbody>
</table>

Close the form. To confirm that the information was entered into the form’s corresponding table, open the **Orders** table in **Datasheet** view and scroll to the last record to view the new entry. Then, close the **Orders** table.

**USING THE CALENDAR FOR DATE PICKING**

**Discussion**

In Access 2007, fields and controls that employ the Date/Time data type have new support - a built-in interactive calendar for choosing dates. This new function simplifies the date-picking process.
The Property Sheet

Procedures

1. Open the desired form.
2. Press [F4] to open the Property Sheet, if necessary.
3. Select the desired control from the dropdown list at the top of the Property Sheet.
4. Select the Format tab on the Property Sheet, if necessary.
5. In the Show Date Picker field, select For Dates, if necessary.

Step-by-Step

Use the calendar for date picking in a form.

Open the Orders 2 form in Design view.
<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>2. Select the desired date field from the Selection Type dropdown list at the top of the Property Sheet. <em>The date field is selected.</em></td>
<td>Click ▼ and select Order Date</td>
</tr>
<tr>
<td>3. Select the Format tab on the Property Sheet, if necessary. <em>The Format tab appears.</em></td>
<td>Click Format</td>
</tr>
<tr>
<td>4. In the Show Date Picker field, select For dates, if necessary. <em>The For dates option is selected.</em></td>
<td>Select For dates in the Show Date Picker field, if necessary</td>
</tr>
<tr>
<td>5. Select Save. <em>The form is saved.</em></td>
<td>Click ▼</td>
</tr>
</tbody>
</table>

Notice when you edit data in the Order Date field in Form View, the calendar will appear to the right of the field. You can then click on the calendar and select the desired date.

**USING THE FORM WIZARD**

**Discussion**

You can use the Form Wizard to quickly and easily create a form. The Form Wizard guides you through the process. First, you must choose the table or query on which you want to base the form, and then you can select the fields you want to include. Next, you select the desired type of form layout: columnar, tabular, datasheet, justified, PivotTable, or PivotChart. You can then select a style from a variety of predefined styles provided by Access. Finally, you must name the form.
The Form wizard

If you base a form on multiple tables, the tables must all be related. In addition, the Form Wizard will prompt you to select how you want to group the fields on the form.

Procedures

1. Select the Create tab.
2. Select the More Forms button in the Forms group.
3. Select Form Wizard.
4. Select the Tables/Queries list.
5. Select the table or query on which you want to base the form.
6. Add the desired fields to the Selected Fields list box, or add all the fields.
7. Select.
8. Select the desired form layout.
9. Select.
10. Select the desired form style.
11. Select 

12. Type the desired form name.

13. Select

---

### Step-by-Step

Create a Form with the Form Wizard.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
</table>
| 1. Select the **Create** tab.  
*The Create tab appears.* | Click **Create** |
| 2. Select the **More Forms** button in the **Forms** group.  
*The More Forms list appears.* | Click **More Forms** |
| 3. Select **Form Wizard**.  
*The Form Wizard opens.* | Click **Form Wizard** |
| 4. Select the **Tables/Queries** list.  
*A list of tables and queries appears.* | Click **Tables/Queries** |
| 5. Select the table or query on which you want to base the form.  
*The table or query is selected, and the fields in the selected table or query appear in the Available Fields list box.* | Click **Table: Customers**, if necessary |
| 6. Add the desired fields to the **Selected Fields** list box, or add all the fields.  
*The fields appear in the Selected Fields list box.* | Click **Customer Number**, then click **>** |
| 7. Enter additional fields as desired.  
*The text appears in the columns.* | Follow the instructions shown below the table before continuing on to the next step |
| 8. Select **Next >**.  
*The next page of the Form Wizard opens.* | Click **Next >** |
| 9. Select the desired form layout.  
*A preview of the layout appears in the Form Wizard.* | Click **Columnar**, if necessary |
Steps & Practice Data

10. Select Next >.
   The next page of the Form Wizard opens.

11. Select the desired form style.
    A preview of the style appears in the Form Wizard.

12. Select Next >.
    The next page of the Form Wizard opens, and the text in the What title do you want for your form? box is selected.

13. Type the desired form name.
    The name appears in the What title do you want for your form? box.

    The Form Wizard closes, and the new form opens.

Select the following fields in the Available Fields list: Store Name, Contact Name, Phone Number, Fax Number, and Address.

Return to the table and continue on to the next step (step 8).

Notice the new form is now listed under the Forms section on the Navigation Pane.

Viewing Records in a Form

Discussion

Navigating records in a form is similar to navigating records in Datasheet view. You can use the navigation buttons at the bottom of the window to display records in a form.

Procedures

1. Display All Access Objects in the Navigation Pane.
2. Open a form in Form view.
3. Click the Last Record button at the bottom of the form window.
4. Click the **First Record** button at the bottom of the form window.

5. Click the **Next Record** button at the bottom of the form window.

6. Click the **Previous Record** button at the bottom of the form window.

---

**Step-by-Step**

View records in a form.

If necessary, open the **Customer Data Entry** form in **Form** view. If the **Customer Data Entry** form does not exist, use the **Customer Data Entry 2** form.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click the <strong>Last Record</strong> button at the bottom of the form window. <em>The last record appears.</em></td>
<td>Click</td>
</tr>
<tr>
<td>2. Click the <strong>First Record</strong> button at the bottom of the form window. <em>The first record appears.</em></td>
<td>Click</td>
</tr>
<tr>
<td>3. Click the <strong>Next Record</strong> button at the bottom of the form window. <em>The next record appears.</em></td>
<td>Click</td>
</tr>
<tr>
<td>4. Click the <strong>Previous Record</strong> button at the bottom of the form window. <em>The previous record appears.</em></td>
<td>Click</td>
</tr>
</tbody>
</table>

---

**PRINTING RECORDS IN A FORM**

**Discussion**

You can print an open form. When you use the Print dialog box, you can print all records, only specified pages, or all selected records, thereby saving time and paper.
Procedures

1. Display All Access Objects in the Navigation Pane.
2. Open a form in Form view.
3. Select the Office button.
4. Select the Print button.
5. Select the desired options.
6. Select OK.

Step-by-Step

Print records in a form.

If necessary, open the Customer Data Entry form in Form view. If the Customer Data Entry form does not exist, use the Customer Data Entry 2 form.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
</table>
| 1. Select the Office button.  
The Office menu appears. | Click |
| 2. Select the Print button.  
The Print dialog box opens. | Click |
| 3. Select the desired options.  
The option is selected. | Click Selected Record(s) |
| 4. Select OK.  
The Print dialog box closes, and Access prints the records. | Click OK |

Close the form.
BASING A FORM ON A QUERY

Discussion

Forms can extract information from a query as well as from a table.

If the query recordset cannot be updated, you will not be able to edit the form or add records to it. Nevertheless, a form can be used to present query data in a more attractive manner.

Procedures

1. Display All Access Objects in the Navigation Pane.

2. Select the More Forms button on the Create tab on the Ribbon.

3. Select Form Wizard.

4. Select the Tables/Queries list.

5. Select the query on which you want to base the form.

6. Add the desired fields to the Selected Fields list box, or add all the fields.

7. Select Next >

8. Select the desired form layout.

9. Select Next >

10. Select the desired form style.

11. Select Next >

12. Type the desired form name.

13. Select Finish
### Step-by-Step

Base a form on a query.

If necessary, display **All Access Objects** in the Navigation Pane.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the <strong>Create</strong> tab on the Ribbon.&lt;br&gt;<em>The Create tab appears.</em></td>
<td>Click <strong>Create</strong></td>
</tr>
<tr>
<td>2. Select the <strong>More Forms</strong> button in the <strong>Forms</strong> group.&lt;br&gt;<em>The More Forms list appears.</em></td>
<td><img src="image" alt="More Forms" /></td>
</tr>
<tr>
<td>3. Select <strong>Form Wizard</strong>.&lt;br&gt;<em>The Form Wizard opens.</em></td>
<td><img src="image" alt="Form Wizard" /></td>
</tr>
<tr>
<td>4. Select the <strong>Tables/Queries</strong> list.&lt;br&gt;<em>A list of available tables and queries appears.</em></td>
<td>Click <strong>Tables/Queries</strong></td>
</tr>
<tr>
<td>5. Select the query on which you want to base the form.&lt;br&gt;<em>The query is selected, and the fields in it appear in the Available Fields list box.</em></td>
<td>Click <strong>Query: Order Items</strong></td>
</tr>
<tr>
<td>6. Add the desired fields to the <strong>Selected Fields</strong> list box, or add all the fields.&lt;br&gt;<em>The fields appear in the Selected Fields list box.</em></td>
<td><img src="image" alt="Add Fields" /></td>
</tr>
<tr>
<td>7. Select <strong>Next &gt;</strong>.&lt;br&gt;<em>The next page of the Form Wizard appears.</em></td>
<td><img src="image" alt="Next Button" /></td>
</tr>
<tr>
<td>8. Select the desired form layout.&lt;br&gt;<em>A preview of the layout appears in the Form Wizard.</em></td>
<td><img src="image" alt="Tabular Layout" /></td>
</tr>
<tr>
<td>9. Select <strong>Next &gt;</strong>.&lt;br&gt;<em>The next page of the Form Wizard appears.</em></td>
<td><img src="image" alt="Next Button" /></td>
</tr>
<tr>
<td>10. Select the desired form style.&lt;br&gt;<em>A preview of the style appears in the Form Wizard.</em></td>
<td><img src="image" alt="Aspect" /></td>
</tr>
<tr>
<td>Steps</td>
<td>Practice Data</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>11. Select Next &gt;. The next page of the Form Wizard appears, and the text in the What title do you want for your form? box is selected.</td>
<td>Click <img src="image" alt="Next &gt;" /></td>
</tr>
<tr>
<td>12. Type the desired form name. The name appears in the What title do you want for your form? box.</td>
<td>Type <em>Order Items</em>, if necessary</td>
</tr>
<tr>
<td>13. Select Finish. The Form Wizard closes, and the new form opens.</td>
<td>Click <img src="image" alt="Finish" /></td>
</tr>
</tbody>
</table>

Close the form.
Close **FORMS1.ACCDB**.
EXERCISE

CREATING BASIC FORMS

Task

Create and print basic forms.

1. Open \textbf{Forms1x.accdb}.
2. Use the Form Wizard to create a new form using the \textbf{Client} table.
3. Add all the fields to the form.
4. Select the \textbf{Columnar} layout and the \textbf{Paper} style.
5. Name the form \textbf{Client Data Entry} and have the Form Wizard open the form to view or enter information.
6. Print record 9, \textbf{HEMCO}.
7. Add a new record, with the following data:

<table>
<thead>
<tr>
<th>Field</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client ID</td>
<td>NELSON</td>
</tr>
<tr>
<td>Name</td>
<td>Nelson Enterprises</td>
</tr>
<tr>
<td>Address</td>
<td>490 S. Maple St.</td>
</tr>
<tr>
<td>City</td>
<td>Boston</td>
</tr>
<tr>
<td>State</td>
<td>MA</td>
</tr>
<tr>
<td>Zip</td>
<td>02188</td>
</tr>
<tr>
<td>Phone Number</td>
<td>617-888-9261</td>
</tr>
</tbody>
</table>

8. Close the form and open the \textbf{Client} table in \textbf{Datasheet} view to view the new record. Then, close the \textbf{Client} table.
9. Use the Form Wizard to create a new form based on the \textbf{Project Payments} query.
10. Add all the fields to the form.
11. Select the \textbf{Tabular} layout and the \textbf{Technic} style.
12. Accept the default name, \textbf{Project Payments}, and have the Form Wizard open the form to view or enter information.
13. Close the form.
14. Create form based on the **Trainer** table using the **Form** button.

15. Close the form, saving it with the default name, **Trainer**.

LESSON 12 - CREATING BASIC REPORTS

In this lesson, you will learn how to:

- Use reports
- Use the Report button
- Use print preview - reports
- Print pages of a report
- Use the Report Wizard
- Change views in a report
- Group and summarize report data
- Base a report on a query
USING REPORTS

Discussion

Although you can print records from a table or form, a report provides more precise control over the final output. Reports can include page headers and footers, calculated totals and subtotals, and even graphics. In addition, reports can be used for invoices, orders, presentations, and mailing labels.

There are two basic types of reports: columnar and tabular. In a columnar report, the field names are listed on the left side of the page, and the field values are listed on the right. If space on the page permits, there can be more than one column. In a tabular report, the field names are listed across the top of the report, and the field values appear in the corresponding columns.

Reports can include data from a single table or related tables. Reports can also be based on queries.

You cannot edit data in a report.

USING THE REPORT BUTTON

Discussion

You can use the Report button to create a report quickly. AutoReport automatically creates a simple columnar or tabular report from the selected table or the query without displaying any dialog boxes or needing any input. You must, however, first select the table or query. All fields in the table or query will appear in the report, and the report title will be the same as the table or query name.

When using the Report button to create a report, Access does not automatically save it; the first time you close the report, Access prompts you to save it.

The Report button creates the report using the most recently used report settings. You can switch to Design view to change the formatting of an existing report.
Procedures

1. Select the table on which you want to base your report.

2. Select the Report button on the Create tab.

Step-by-Step

From the Student Data directory, open REPORT1.ACCDB. Use the Report button to create a report.

If necessary, display All Access Objects in the Navigation Pane.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the table or query in the Navigation Pane on which you want to base your report. The object is selected.</td>
<td>Click the Orders table</td>
</tr>
</tbody>
</table>

View the report. Then, close the form, saving it as Order Information.

USING PRINT PREVIEW - REPORTS

Discussion

When you open a report, it appears in print preview. Print preview allows you to see how the printed report will look before you print it.

Print preview provides options for viewing the report. You can zoom out to see more of the report or zoom in to see a portion of the report in more detail. The Zoom button on the Print Preview tab allows you to choose from several magnification options, from as small as 10% to as large as 500% or 1000%.

You can display a report in One Page, Two Pages, or More Pages view. The buttons at the bottom of the window allow you to navigate pages, and the scroll bars allow you to view different areas of a page.
You can also use the **Zoom** on the **Status Bar** to switch the magnification between 10% and 1000%.

### Procedures

1. Display **All Access Objects** in the Navigation Pane.
2. Open the report you want to preview.
3. Select the **Office** button 📚.
4. Select the arrow up to the right of the **Print** button 📄.
5. Select **Print Preview** 📅.
6. Click the area of the report page you want to magnify to 100%.
7. Click anywhere in the report page to change the magnification back to fit the window.
8. Click the **Two Pages** button on the **Print Preview** tab to display two pages of the report.

9. Click the **Next Page** button at the bottom of the report window to display the next page of the report.

10. Click the **Last Page** button at the bottom of the report window to display the last page of the report.

11. Click the **Previous Page** button at the bottom of the report window to display the previous page of the report.

12. Click the **First Page** button at the bottom of the report window to display the first page of the report.

---

### Step-by-Step

Use print preview to view a report.

If necessary, display the **Reports** object list. If the **Order Information** report does not exist, use the **Order Information 2** report.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the report you want to preview. <em>The report is selected.</em></td>
<td>Click <strong>Order Information</strong>, if necessary</td>
</tr>
<tr>
<td>2. Select the arrow to the right of the <strong>Print</strong> button on the <strong>Office</strong> menu. <em>The print options appear to the right.</em></td>
<td>Click</td>
</tr>
<tr>
<td>3. Select <strong>Print Preview</strong>. <em>Print preview opens.</em></td>
<td>Click</td>
</tr>
<tr>
<td>4. Click the area of the report page you want to magnify to 100%. <em>The report area is magnified to 100%.</em></td>
<td>Click the initials for the first sales representative, at the top of the page</td>
</tr>
<tr>
<td>5. Click anywhere in the report page to change the magnification back to fit the window. <em>The entire page appears in print preview.</em></td>
<td>Click anywhere in the page</td>
</tr>
</tbody>
</table>
### Steps

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.</td>
<td>Click the <strong>Two Pages</strong> button on the <strong>Print Preview</strong> tab to display two pages of the report. &lt;br&gt;Two pages appear in print preview.</td>
</tr>
<tr>
<td>7.</td>
<td>Click the <strong>Next Page</strong> button at the bottom of the report window to display the next page of the report. &lt;br&gt;The next page of the report appears.</td>
</tr>
<tr>
<td>8.</td>
<td>Click the <strong>Last Page</strong> button at the bottom of the report window to display the last page of the report. &lt;br&gt;The last page of the report appears.</td>
</tr>
<tr>
<td>9.</td>
<td>Click the <strong>Previous Page</strong> button at the bottom of the report window to display the previous page of the report. &lt;br&gt;The previous page of the report appears.</td>
</tr>
<tr>
<td>10.</td>
<td>Click the <strong>First Page</strong> button at the bottom of the report window to display the first page of the report. &lt;br&gt;The first page of the report appears.</td>
</tr>
</tbody>
</table>

**Practice Data:**

- Click **Two Pages**
- Click **Next Page**
- Click **Last Page**
- Click **Previous Page**
- Click **First Page**

**Practice the Concept:** Use the **Zoom** on the **Status Bar** to change the magnification to 250%. Scroll through the report to view the text.

Close print preview.

---

### PRINTING PAGES OF A REPORT

#### Discussion

You can print specific pages of a report. This option is useful if the report contains numerous pages, and you only need information from one or more particular pages. The Print dialog box allows you to specify the pages you want to print.

To print an entire report, select it and click the **Print** button on the **Office** menu.
Procedures

1. Select the report you want to print.

2. Select the Office button.

3. Select the Print button.

4. Select the Pages option.

5. Type the number of the first page you want to print.

6. Select the To box.

7. Type the number of the last page you want to print.

8. Select OK.

Step-by-Step

Print pages of a report.

If necessary, display the All Access Objects in the Navigation Pane. If the Order Information report does not exist, use the Order Information 2 report.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the report you want to print. The report name is selected.</td>
<td>Click Order Information, if necessary</td>
</tr>
<tr>
<td>2. Select the Office button. The Office menu appears.</td>
<td>Click</td>
</tr>
<tr>
<td>3. Select the Print button. The Print dialog box opens.</td>
<td>Click</td>
</tr>
<tr>
<td>4. Select the Pages option. The Pages option is selected, and the insertion point appears in the From box.</td>
<td>Click Pages</td>
</tr>
<tr>
<td>5. Type the number of the first page you want to print. The number appears in the From box.</td>
<td>Type 2</td>
</tr>
</tbody>
</table>
### Using the Report Wizard

**Discussion**

You can use the Report Wizard to quickly and easily create a report. The basic steps needed to create a report using the Report Wizard are as follows:

1. Select the table(s) you want to use.
2. Select the fields you want to include.
3. Group the data.
4. Add grouping levels.
5. Sort the data.
6. Select a layout.
7. Select a style.
8. Name the report.

When you have finished creating a report, the Report Wizard displays it in print preview. Print preview allows you to view the report before you print it.
If you base a report on only one table, the Report Wizard does not ask you to specify a table on which to group the data.

If you include fields from unrelated tables in the report, Access closes the Report Wizard and opens the Relationships window so that you can create the necessary relationship.

Procedures

1. Display All Access Objects in the Navigation Pane.

2. Select the Report Wizard button on the Create tab on the Ribbon.

3. Select the Tables/Queries list.

4. Select the table or query on which you want to base the report.

5. Add the desired fields to the Selected Fields list box.

6. To add another table to the report, select the Tables/Queries list.

7. Select the desired table or query.

8. Add the desired fields to the Selected Fields list box.

9. Select
10. Select the desired option in the **How do you want to view your data?** list box.

11. Select

12. Select the desired grouping level in the **Do you want to add any grouping levels?** list box.

13. Select

14. To sort the records, select the 1 list.

15. Select the field by which you want to sort.

16. Select

17. Select the desired report layout.

18. Select the desired report orientation.

19. Select

20. Select the desired report style.

21. Select

22. Type the desired report name.

23. Select

---

### Step-by-Step

Use the Report Wizard to create a report.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the <strong>Create</strong> tab on the <strong>Ribbon</strong>. The <strong>Create</strong> tab appears.</td>
<td>Click <strong>Create</strong></td>
</tr>
</tbody>
</table>
| 3. Select the **Tables/Queries** list. A list of available tables and queries appears. | Click **Tables/Queries**
### Steps

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
</table>
| 4. | Select the table or query on which you want to base the report.  
   *The table or query is selected, and the fields in it appear in the Available Fields list.* | Click **Table: Orders**
| 5. | Add the desired field to the **Selected Fields** list box.  
   *The field appears in the Selected Fields list box.* | Double-click **Order Number**
| 6. | Add additional fields as desired.  
   *The fields appear in the Selected Fields list box.* | Double-click **Order Date**
| 7. | To add another table to the report, select the **Tables/Queries** list.  
   *A list of available tables and queries appears.* | Click **Tables/Queries**
| 8. | Select the desired table or query.  
   *The table or query is selected, and the fields in it appear in the Available Fields list box.* | Click **Table: Customers**
| 9. | Add the desired fields to the **Selected Fields** list box.  
   *The fields appear in the Selected Fields list box.* | Follow the instructions shown below the table before continuing on to the next step
| 10. | Select **Next >**.  
   *The next page of the Report Wizard appears.* | Click **Next >**
| 11. | Select the desired option in the **How do you want to view your data?** list box.  
   *A preview of the option appears in the Report Wizard.* | Click by **Orders**, if necessary
| 12. | Select **Next >**.  
   *The next page of the Report Wizard appears.* | Click **Next >**
| 13. | Select the desired grouping level in the **Do you want to add any grouping levels?** list box.  
   *A preview of the grouping level appears in the Report Wizard.* | Double-click **Sales Rep**
<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>14. Select Next &gt;.&lt;br&gt;The next page of the Report Wizard appears.</td>
<td>Click Next &gt;</td>
</tr>
<tr>
<td>15. To sort the records, select the list.&lt;br&gt;A list of available report fields appears.</td>
<td>Click 1</td>
</tr>
<tr>
<td>16. Select the field by which you want to sort.&lt;br&gt;The field is selected.</td>
<td>Click Order Number</td>
</tr>
<tr>
<td>17. Select Next &gt;.&lt;br&gt;The next page of the Report Wizard appears.</td>
<td>Click Next &gt;</td>
</tr>
<tr>
<td>18. Select the desired report layout.&lt;br&gt;A preview of the layout option appears in the Report Wizard.</td>
<td>Click Stepped, if necessary</td>
</tr>
<tr>
<td>19. Select the desired report orientation.&lt;br&gt;The orientation option is selected.</td>
<td>Click Landscape</td>
</tr>
<tr>
<td>20. Select Next &gt;.&lt;br&gt;The next page of the Report Wizard appears.</td>
<td>Click Next &gt;</td>
</tr>
<tr>
<td>21. Select the desired report style.&lt;br&gt;A preview of the report style appears in the Report Wizard.</td>
<td>Click Flow</td>
</tr>
<tr>
<td>22. Select Next &gt;.&lt;br&gt;The next page of the Report Wizard appears with the text in the What title do you want for your report? box selected.</td>
<td>Click Next &gt;</td>
</tr>
<tr>
<td>23. Type the desired report name.&lt;br&gt;The text appears in the What title do you want for your report? box.</td>
<td>Type Order Info</td>
</tr>
<tr>
<td>24. Select Finish.&lt;br&gt;The Report Wizard closes, and the report appears in print preview.</td>
<td>Click Finish</td>
</tr>
</tbody>
</table>

From the Customers table, add the Customer Number, Store Name, Contact Name, Phone Number, and Sales Rep fields.

Return to the table and continue on to the next step (step 10).

Close print preview. Notice that the new report appears in the Navigation Pane.
CHANGING VIEWS IN A REPORT

Discussion

After you create a report, you can view it in a selection of different views: Report View, Print Preview, Layout View, or Design View. When a report is open, you can switch between these views by clicking the View button in the Views section of the Home tab on the Ribbon. The following table explains the different views:

<table>
<thead>
<tr>
<th>View</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report View</td>
<td>This view displays the report as you (or the Report Wizard) designed it.</td>
</tr>
<tr>
<td>Print Preview</td>
<td>This view allows you to view the print layout of your report.</td>
</tr>
<tr>
<td>Layout View</td>
<td>This view looks like Print Preview, but allows you to make changes to your report.</td>
</tr>
<tr>
<td>Design View</td>
<td>Displays the report in the Design View window, where you can change form elements, move them around and add or delete them, if necessary.</td>
</tr>
</tbody>
</table>

A report in Layout view

Procedures

1. Open the desired report.
2. Select the desired view on the Status Bar.

**Step-by-Step**

Change the report view.

Open the Orders Information 2 report, if necessary.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
</table>
| 1. Select the Design View button on the Status Bar.  
*The report changes to Design view.* | Click ![Design View](image) |

**Practice the concept:** Follow the above steps and select the Layout View button on the Status Bar.

Close the report.

**GROUPING AND SUMMARIZING REPORT DATA**

**Discussion**

The Report Wizard provides options for grouping and summarizing report data. You can organize your report by selecting the fields into which you want to group data. If you create more than one group, you can prioritize the groups into levels.

In addition to grouping data by a field, you can add grouping intervals. Grouping intervals vary, depending upon the selected field. For instance, a date field can be grouped by month, quarter, year, etc.; a numeric field can be grouped by numeric intervals of 10s, 50s, 100s, etc.; and a text field can be grouped by its first letter, second letter, etc.

If you have included a field with numeric data in your report, you can add summary calculations. Summary calculations include **Sum**, **Avg** (average), **Min** (minimum), and **Max** (maximum). If you select the **Sum** calculation, you can include a calculated percentage of the total for each group. You can also display just the summary calculations in the report or both the field data (details) and the summary calculations.

If you are grouping on multiple fields, you can use the up and down **Priority** buttons to change the order of the groups in the Report Wizard.
You can add a new field to a specific location in a report by first selecting the field in the **Selected Fields** list box below which you want to insert the new field.

You must use **Design** view to add grouping levels and summaries to an existing report.

---

### Procedures

1. Select the **Create** tab on the **Ribbon**.

2. Select the **Report Wizard** button.

3. Select the **Tables/Queries** list.

4. Select the table or query on which you want to base the report.

5. Add the fields you want to include in the report to the **Selected Fields** list box.

6. Select.

7. Select the desired grouping option from the **How do you want to view your data?** list box.

8. Select.

9. Select the desired grouping level from the **Do you want to add any grouping levels?** list box, if applicable.

10. Select.

11. Select the **Grouping intervals** list.

12. Select the desired interval.

13. Select.

14. Select.

15. If you have included a **Number** data type field, select.

16. Select the desired summary options.

17. Select.
18. When you have finished selecting options from the Report Wizard, select Finish.

**Step-by-Step**

Group and summarize report data.

If necessary, display All Access Objects in the Navigation Pane.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the Create tab on the Ribbon. The New Report dialog box opens.</td>
<td>Click Create</td>
</tr>
<tr>
<td>3. Select the Tables/Queries list. A list of available tables and queries appears.</td>
<td>Click Tables/Queries</td>
</tr>
<tr>
<td>4. Select the table or query on which you want to base the report. The table or query is selected, and the fields in it appear in the Available Fields list box.</td>
<td>Click Table: Orders</td>
</tr>
<tr>
<td>5. Add the fields you want to include in the report to the Selected Fields list box. The fields appear in the Selected Fields list box.</td>
<td>Follow the instructions shown below the table before continuing on to the next step</td>
</tr>
<tr>
<td>7. Select the desired grouping option from the How do you want to view your data? list box. A preview of the grouping option appears in the Report Wizard.</td>
<td>Click by Customers</td>
</tr>
<tr>
<td>8. Select Next &gt;. The next page of the Report Wizard appears.</td>
<td>Click Next &gt;</td>
</tr>
</tbody>
</table>
### Steps

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>9. Select the desired grouping level from the Do you want to add any grouping levels? list box, if applicable. A preview of the grouping level appears in the Report Wizard.</td>
<td>Double-click Order Date</td>
</tr>
<tr>
<td>10. Select the <strong>Grouping Options</strong> button. The Grouping Intervals dialog box opens.</td>
<td>Click Grouping Options …</td>
</tr>
<tr>
<td>11. Select the <strong>Grouping intervals</strong> list. A list of available intervals appears.</td>
<td>Click Grouping intervals</td>
</tr>
<tr>
<td>12. Select the desired interval. The interval appears in the Grouping intervals box.</td>
<td>Click Quarter</td>
</tr>
<tr>
<td>13. Select <strong>OK</strong>. The Grouping Intervals dialog box closes, and the interval appears in the group heading.</td>
<td>Click OK</td>
</tr>
<tr>
<td>15. If you have included a <strong>Number</strong> data type field, select the <strong>Summary Options</strong> button. The Summary Options dialog box opens.</td>
<td>Click Summary Options …</td>
</tr>
<tr>
<td>16. Select the desired summary options. The summary options are selected.</td>
<td>Click Sum</td>
</tr>
<tr>
<td>17. Select <strong>OK</strong>. The Summary Options dialog box closes.</td>
<td>Click OK</td>
</tr>
<tr>
<td>18. When you have finished selecting options from the Report Wizard, select <strong>Finish</strong>. The Report Wizard closes, and the report appears in print preview.</td>
<td>Click Finish</td>
</tr>
</tbody>
</table>

Add the **Order Number**, **Order Date** and **Shipping Cost** fields. Select the **Order Number** field in the **Selected Fields** list box, select the **Customers** table from the **Tables/Queries** list, and add the **Store Name** field below the **Order Number** field.

Return to the table and continue on to the next step (step 6).
Close print preview. Notice that the new **Customers** report appears in the Navigation Pane.

**BASING A REPORT ON A QUERY**

**Discussion**

You can use a query as the basis for a report. The query recordset appears as the report data. The report is updated each time it is opened or printed to reflect changes made to queried data.

**Procedures**

1. Display **All Access Objects** in the Navigation Pane.
2. Select the **Create** tab on the **Ribbon**.
3. Select the **Report Wizard** button.
4. Select the **Tables/Queries** list.
5. Select the query on which you want to base the report.
6. Add the desired fields to the **Selected Fields** list box, or add all fields.
7. Select **Next >**.
8. Select the desired grouping option from the **How do you want to view your data?** list box.
9. Select **Next >**.
10. Select the desired grouping level from the **Do you want to add any grouping levels?** list box, if applicable.
11. Select **Next >**.
12. Select the **1 field list**.
13. Select the first field by which you want to sort.
14. Select additional sort fields, if desired.
15. Select **Next >**.
16. Select the desired report layout.
17. Select the desired report orientation.

18. Select Next >

19. Select the desired report style.

20. Select Next >

21. Type the desired report name in the What title do you want for your report? box.

22. Select Finish

---

**Step-by-Step**

Base a report on a query using the Report Wizard.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the <strong>Create</strong> tab on the Ribbon. The <strong>Create</strong> tab appears.</td>
<td>Click <strong>Create</strong></td>
</tr>
<tr>
<td>3. Select the <strong>Tables/Queries</strong> list. A list of tables and queries appears.</td>
<td>Click <strong>Tables/Queries</strong></td>
</tr>
<tr>
<td>4. Select the query on which you want to base the report. The query is selected, and the fields in it appear in the <strong>Available Fields</strong> list box.</td>
<td>Click <strong>Query: Order Items</strong></td>
</tr>
<tr>
<td>5. Add the desired fields to the <strong>Selected Fields</strong> list box, or add all fields. The fields appear in the <strong>Selected Fields</strong> list box.</td>
<td>Click <img src="%3E%3E" alt="&gt;&gt;" /></td>
</tr>
<tr>
<td>6. Select Next &gt;. The next page of the Report Wizard appears.</td>
<td>Click ![Next &gt;](Next &gt;)</td>
</tr>
</tbody>
</table>
### Lesson 12 - Creating Basic Reports

#### Access 2007 - Lvl 1

**Steps**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
<th>Practice Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.</td>
<td>Select the desired grouping option from the <strong>How do you want to view your data?</strong> list box. A preview of the grouping option appears in the Report Wizard.</td>
<td>Click by Line Items, if necessary</td>
</tr>
<tr>
<td>8.</td>
<td>Select <strong>Next &gt;</strong>. The next page of the Report Wizard appears.</td>
<td>Click <strong>Next &gt;</strong></td>
</tr>
<tr>
<td>9.</td>
<td>Select the desired grouping level from the <strong>Do you want to add any grouping levels?</strong> list box, if applicable. A preview of the grouping level appears in the Report Wizard.</td>
<td>Double-click Order Number</td>
</tr>
<tr>
<td>10.</td>
<td>Select <strong>Next &gt;</strong>. The next page of the Report Wizard appears.</td>
<td>Click <strong>Next &gt;</strong></td>
</tr>
<tr>
<td>11.</td>
<td>Select the 1 field list. A list of available report fields appears.</td>
<td>Click 1</td>
</tr>
<tr>
<td>12.</td>
<td>Select the first field by which you want to sort. The sort field is selected.</td>
<td>Click Product ID</td>
</tr>
<tr>
<td>13.</td>
<td>Select <strong>Next &gt;</strong>. The next page of the Report Wizard appears.</td>
<td>Click <strong>Next &gt;</strong></td>
</tr>
<tr>
<td>15.</td>
<td>Select the desired report orientation. The orientation option is selected.</td>
<td>Click <strong>Portrait</strong>, if necessary</td>
</tr>
<tr>
<td>16.</td>
<td>Select <strong>Next &gt;</strong>. The next page of the Report Wizard appears.</td>
<td>Click <strong>Next &gt;</strong></td>
</tr>
<tr>
<td>17.</td>
<td>Select the desired report style. A preview of the style appears in the Report Wizard.</td>
<td>Click Concourse</td>
</tr>
</tbody>
</table>
### Steps

<table>
<thead>
<tr>
<th>Steps</th>
<th>Practice Data</th>
</tr>
</thead>
</table>
| **18. Select Next >.**  
*The next page of the Report Wizard appears with the text in the What title do you want for your report? box selected.* | **Click** [Next >] |
| **19. Type the desired report name in the What title do you want for your report? box.**  
*The name appears in the What title do you want for your report? box.* | **Type** *Order Items* |
| **20. Select Finish.**  
*The Report Wizard closes, and the report appears in print preview.* | **Click** [Finish] |

Close print preview. Notice that the new report appears in the Navigation Pane. Close **REPORT1.ACCDB**.
EXERCISE

CREATING BASIC REPORTS

Task

Create and print basic reports.

1. Open Report1x.accdb.
2. Use the Report Wizard to create a new report.
3. Select the Project table and add the Project ID, Course Name, and Cost fields to the report.
4. Select the Client table and add the Client ID and Name fields to the report.
5. Group the data by Client and then add the Project ID grouping level.
6. Sort the report by Course Name and calculate costs using the Sum function. Show both detail and summary calculations.
7. Select the Outline layout, the Portrait orientation, and the Apex style.
8. Name the report Projects by Client and display it in print preview.
9. Zoom to 100% to display the report in more detail.
10. Print page 3. Then, close print preview.
11. Use Report Wizard to create a report from the Project Payments query.
12. Add all the fields to the report, remove the Client ID grouping, group the report by Project ID, and sort it by Client ID.
13. Select the Stepped layout, the Landscape orientation, and the Metro style.
14. Accept the default name of Project Payments and preview the report. Then, close print preview.
15. Use the Report button to create report based on the Trainer table.
16. Preview the report. Then, close print preview, saving the report as Trainer.
17. Close the database file.
INDEX

Access
  exiting, 23, 24
  getting help with, 2
  starting, 3
Access Options
  using, 20, 21
Calendar for date picking, 163, 164
Cell effects
  changing, 69, 70
Column width
  changing, 67, 68
Columns
  freezing, 77, 78
  hiding, 75
  moving, 73, 74
  selecting, 72, 73
  unhiding, 76
Contextual command tabs, 10
Data
  replacing, 88, 89
Data types
  assigning, 37, 39
  AutoNumber, 38
  Currency, 37
  Date/Time, 37
  Hyperlink, 38
  Lookup Wizard, 38
  Memo, 37
  Number, 37
  OLE object, 38
  Text, 37
  Yes/No, 38
Database
  closing, 22, 23
  open existing, 7, 8
Database objects
  object type, 13
  opening, 15, 16
Database template, 28, 29
Databases, 2
  creating new, 30, 31
  relational, 2
Datasheet view
  opening a query, 129, 130
  using, 50
Design view
creating a query, 127, 128
creating tables, 35
using, 34
Field descriptions
adding, 41
Field names
adding, 35, 36
Field templates, 51
Fields
hiding in a query, 142
multi-valued, 43, 44
navigating, 50
Filter By Selection, 90, 91
Filter Excluding Selection, 93
Filtering
AutoFilter, 97, 98
quick filters, 95, 96
Filters
applying, 92
Filter By Selection, 90, 91
Filter Excluding Selection, 93
removing, 92
Find
finding specific records, 83, 84
using wildcards, 85, 86, 87
Font attributes
changing, 68, 69
Form Wizard, 165
Forms
adding a record, 161, 162
basing on a query, 171, 172
columnar, 160
creating, 165
creating with the form button, 160, 161
datasheet, 160
Form Wizard, 165, 166, 167
justified, 160
PivotChart, 160
PivotTable, 160
printing records, 170
tabular, 160
viewing records, 168, 169
Interface
using, 4
Join lines
deleting, 120
Mini Toolbar
using, 11, 12
Navigation Pane, 13, 14, 15
Office Button
using, 5, 6
Page setup
  changing, 103, 104
Performance Analyzer, 154, 155, 156
Primary keys
  setting, 42, 43
Print preview, 105, 106, 107, 179, 180, 181
Printing
  changing the page setup, 103, 104
  print preview, 105, 106, 107
  queries, 146, 147
  records in a form, 169, 170
  recordsets, 146, 147
  report pages, 182, 183
  selected records, 108, 109
  table data, 102
Queries, 124
  adding a table, 130, 131
  adding criteria, 140, 141
  adding records, 144, 145
  basing reports on, 194, 195
  creating in Design view, 127, 128
  hiding a field, 142
  joining tables, 132, 133
  opening, 129, 130
  printing, 146, 147
  running, 134
  Simple Query Wizard, 124, 125, 126
  sorting, 138, 139
  totals row, 143, 144
Quick Access toolbar, 11
Records, 2
  adding, 52, 53
  adding using a query, 144, 145
  deleting, 59, 60
  editing, 57, 58
  finding specific, 83, 84
  moving through, 54, 55
  printing selected, 108, 109
  replacing data, 88, 89
  saving, 59
  selecting, 56
  sorting, 82
  viewing in forms, 168, 169
Recordsets, 124
  printing, 146
Referential integrity
  setting, 116, 117
Relationships
  creating between tables, 113, 114
  deleting join lines, 120
  join types, 132
many-to-many, 113, 150
one-to-many, 113, 150
one-to-one, 113, 150
setting referential integrity, 116, 117
using related tables, 112
window, 113
Replace, 88, 89
Report Wizard, 184, 185, 186
Reports
  basing on a query, 194, 195
  changing views, 189, 190
columnar, 178
creating, 178, 184, 185, 186
creating with the Report button, 178, 179
group and summarize data, 190, 191, 192
printing pages, 182, 183
tabular, 178
viewing, 179, 180, 181
Ribbon
  using, 9, 10
Row height
  changing, 66
Search Box
  using, 94, 95
Simple Query Wizard, 124, 125, 126
Status bar, 19, 20
Subdatasheets
  viewing, 118, 119
Tabbed documents
  closing, 18, 19
closing all, 19
  using, 16, 17
Table Analyzer Wizard, 150, 151, 152
Tables, 2
  adding field descriptions, 41
  adding field names, 35, 36
  adding records, 52, 53
  adding to a query, 130, 131
  alternate background color, 71, 72
  analyzing, 150, 151, 152, 154, 155, 156
  assigning data types, 37, 39
  changing cell effects, 69, 70
  changing font attributes, 68, 69
  changing the column width, 67, 68
  changing the row height, 66
datasheet view, 33, 34
deleting join lines, 120
deleting records, 59, 60
design view, 34, 35
designing, 32
editing records, 57, 58
freezing columns, 77, 78
hiding columns, 75
joining, 113
joining in a query, 132, 133
moving columns, 73, 74
moving through records, 54, 55
navigating, 54, 55
navigating fields, 50
printing, 102
related, 112
relating, 2
saving new, 39, 40
saving records, 59
selecting columns, 72, 73
selecting records, 56
setting a primary key, 42, 43
splitting, 150
totals row, 61, 62
unhiding columns, 76
using Datasheet view, 50
using Design view, 34
viewing subdatasheets, 118
Wildcards
using, 85, 86, 87